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This document describes the R&S®SGS100A, stock no. 1416.0505.02 and its options.
● R&S®SGS100A-B1

● R&S®SGS100A-B26

● R&S®SGS100A-B106/106V

● R&S®SGS100A-B112/112V

● R&S®SGS100A-K90

The firmware of the instrument makes use of the operating system LINUX® and other valuable open source software packages. The
most important of them together with their corresponding open source license and the verbatim license texts are provided on the user
documentation CD-ROM (included in delivery).
The OpenSSL Project for use in the OpenSSL Toolkit (http://www.openssl.org/) includes cryptographic software written by Eric Young
(eay@cryptsoft.com) and software written by Tim Hudson (tjh@cryptsoft.com). LINUX® is a trademark of Linus Torvalds.
Rohde & Schwarz would like to thank the open source community for their valuable contribution to embedded computing.

© 2012 Rohde & Schwarz GmbH & Co. KG
Muehldorfstr. 15, 81671 Munich, Germany
Phone: +49 89 41 29 - 0
Fax: +49 89 41 29 12 164
E-mail: info@rohde-schwarz.com
Internet: http://www.rohde-schwarz.com
Printed in Germany – Subject to change – Data without tolerance limits is not binding.
R&S® is a registered trademark of Rohde & Schwarz GmbH & Co. KG.
Trade names are trademarks of the owners.

The following abbreviations are used throughout this manual: R&S®SGS100A is abbreviated as R&S SGS, R&S®SGMA-GUI is abbre-
viated as R&S SGMA-GUI, R&S®FSV is abbreviated as R&S FSV, R&S®AFQ100B is abbreviated as R&S AFQ100B, R&S®SMU200A
is abbreviated as R&S SMU.

http://www.openssl.org/
mailto:info@rohde-schwarz.com
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Basic Safety Instructions 
Always read through and comply with the following safety instructions! 

All plants and locations of the Rohde & Schwarz group of companies make every effort to keep the safety 
standards of our products up to date and to offer our customers the highest possible degree of safety. Our 
products and the auxiliary equipment they require are designed, built and tested in accordance with the 
safety standards that apply in each case. Compliance with these standards is continuously monitored by 
our quality assurance system. The product described here has been designed, built and tested in 
accordance with the attached EC Certificate of Conformity and has left the manufacturer’s plant in a 
condition fully complying with safety standards. To maintain this condition and to ensure safe operation, 
you must observe all instructions and warnings provided in this manual. If you have any questions 
regarding these safety instructions, the Rohde & Schwarz group of companies will be happy to answer 
them. 

Furthermore, it is your responsibility to use the product in an appropriate manner. This product is designed 
for use solely in industrial and laboratory environments or, if expressly permitted, also in the field and must 
not be used in any way that may cause personal injury or property damage. You are responsible if the 
product is used for any purpose other than its designated purpose or in disregard of the manufacturer's 
instructions. The manufacturer shall assume no responsibility for such use of the product.  

The product is used for its designated purpose if it is used in accordance with its product documentation 
and within its performance limits (see data sheet, documentation, the following safety instructions). Using 
the product requires technical skills and, in some cases, a basic knowledge of English. It is therefore 
essential that only skilled and specialized staff or thoroughly trained personnel with the required skills be 
allowed to use the product. If personal safety gear is required for using Rohde & Schwarz products, this 
will be indicated at the appropriate place in the product documentation. Keep the basic safety instructions 
and the product documentation in a safe place and pass them on to the subsequent users. 

Observing the safety instructions will help prevent personal injury or damage of any kind caused by 
dangerous situations. Therefore, carefully read through and adhere to the following safety instructions 
before and when using the product. It is also absolutely essential to observe the additional safety 
instructions on personal safety, for example, that appear in relevant parts of the product documentation. In 
these safety instructions, the word "product" refers to all merchandise sold and distributed by the Rohde & 
Schwarz group of companies, including instruments, systems and all accessories. For product-specific 
information, see the data sheet and the product documentation. 

Symbols and safety labels 

Symbol Meaning Symbol Meaning 

Notice, general danger location 

Observe product documentation 

ON/OFF supply voltage 

Caution when handling heavy equipment Standby indication 

Danger of electric shock Direct current (DC) 
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Symbol Meaning Symbol Meaning 

Warning! Hot surface Alternating current (AC) 

Protective conductor terminal Direct/alternating current (DC/AC) 

Ground Device fully protected by double (reinforced) 
insulation 

Ground terminal EU labeling for batteries and accumulators 

For additional information, see section "Waste 
disposal/Environmental protection", item 1. 

Be careful when handling electrostatic sensitive 
devices 

EU labeling for separate collection of electrical 
and electronic devices 

For additonal information, see section "Waste 
disposal/Environmental protection", item 2. 

Warning! Laser radiation 

For additional information, see section 
"Operation", item 7. 

 

Signal words and their meaning 

The following signal words are used in the product documentation in order to warn the reader about risks 
and dangers. 

Indicates an imminently hazardous situation which, if not avoided, will result 
in death or serious injury. 

Indicates a potentially hazardous situation which, if not avoided, could result 
in death or serious injury. 

Indicates a potentially hazardous situation which, if not avoided, could result 
in minor or moderate injury. 

Indicates the possibility of incorrect operation which can result in damage to 
the product.  
In the product documentation, the word ATTENTION is used synonymously.  

 
These signal words are in accordance with the standard definition for civil applications in the European 
Economic Area. Definitions that deviate from the standard definition may also exist in other economic 
areas or military applications. It is therefore essential to make sure that the signal words described here 
are always used only in connection with the related product documentation and the related product. The 
use of signal words in connection with unrelated products or documentation can result in misinterpretation 
and in personal injury or material damage. 
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Operating states and operating positions 

The product may be operated only under the operating conditions and in the positions specified by the 
manufacturer, without the product's ventilation being obstructed. If the manufacturer's specifications are 
not observed, this can result in electric shock, fire and/or serious personal injury or death. Applicable local 
or national safety regulations and rules for the prevention of accidents must be observed in all work 
performed.  

1. Unless otherwise specified, the following requirements apply to Rohde & Schwarz products:  
predefined operating position is always with the housing floor facing down, IP protection 2X, use only 
indoors, max. operating altitude 2000 m above sea level, max. transport altitude 4500 m above sea 
level. A tolerance of ±10 % shall apply to the nominal voltage and ±5 % to the nominal frequency, 
overvoltage category 2, pollution severity 2. 

2. Do not place the product on surfaces, vehicles, cabinets or tables that for reasons of weight or stability 
are unsuitable for this purpose. Always follow the manufacturer's installation instructions when 
installing the product and fastening it to objects or structures (e.g. walls and shelves). An installation 
that is not carried out as described in the product documentation could result in personal injury or 
even death. 

3. Do not place the product on heat-generating devices such as radiators or fan heaters. The ambient 
temperature must not exceed the maximum temperature specified in the product documentation or in 
the data sheet. Product overheating can cause electric shock, fire and/or serious personal injury or 
even death. 

Electrical safety 

If the information on electrical safety is not observed either at all or to the extent necessary, electric shock, 
fire and/or serious personal injury or death may occur.  

1. Prior to switching on the product, always ensure that the nominal voltage setting on the product 
matches the nominal voltage of the AC supply network. If a different voltage is to be set, the power 
fuse of the product may have to be changed accordingly.  

2. In the case of products of safety class I with movable power cord and connector, operation is 
permitted only on sockets with a protective conductor contact and protective conductor. 

3. Intentionally breaking the protective conductor either in the feed line or in the product itself is not 
permitted. Doing so can result in the danger of an electric shock from the product. If extension cords 
or connector strips are implemented, they must be checked on a regular basis to ensure that they are 
safe to use. 

4. If there is no power switch for disconnecting the product from the AC supply network, or if the power 
switch is not suitable for this purpose, use the plug of the connecting cable to disconnect the product 
from the AC supply network. In such cases, always ensure that the power plug is easily reachable and 
accessible at all times. For example, if the power plug is the disconnecting device, the length of the 
connecting cable must not exceed 3 m. Functional or electronic switches are not suitable for providing 
disconnection from the AC supply network. If products without power switches are integrated into 
racks or systems, the disconnecting device must be provided at the system level. 

5. Never use the product if the power cable is damaged. Check the power cables on a regular basis to 
ensure that they are in proper operating condition. By taking appropriate safety measures and 
carefully laying the power cable, ensure that the cable cannot be damaged and that no one can be 
hurt by, for example, tripping over the cable or suffering an electric shock.  
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6. The product may be operated only from TN/TT supply networks fuse-protected with max. 16 A (higher 
fuse only after consulting with the Rohde & Schwarz group of companies). 

7. Do not insert the plug into sockets that are dusty or dirty. Insert the plug firmly and all the way into the 
socket provided for this purpose. Otherwise, sparks that result in fire and/or injuries may occur.  

8. Do not overload any sockets, extension cords or connector strips; doing so can cause fire or electric 
shocks. 

9. For measurements in circuits with voltages Vrms > 30 V, suitable measures (e.g. appropriate 
measuring equipment, fuse protection, current limiting, electrical separation, insulation) should be 
taken to avoid any hazards. 

10. Ensure that the connections with information technology equipment, e.g. PCs or other industrial 
computers, comply with the IEC60950-1/EN60950-1 or IEC61010-1/EN 61010-1 standards that apply 
in each case. 

11. Unless expressly permitted, never remove the cover or any part of the housing while the product is in 
operation. Doing so will expose circuits and components and can lead to injuries, fire or damage to the 
product. 

12. If a product is to be permanently installed, the connection between the protective conductor terminal 
on site and the product's protective conductor must be made first before any other connection is 
made. The product may be installed and connected only by a licensed electrician. 

13. For permanently installed equipment without built-in fuses, circuit breakers or similar protective 
devices, the supply circuit must be fuse-protected in such a way that anyone who has access to the 
product, as well as the product itself, is adequately protected from injury or damage. 

14. Use suitable overvoltage protection to ensure that no overvoltage (such as that caused by a bolt of 
lightning) can reach the product. Otherwise, the person operating the product will be exposed to the 
danger of an electric shock. 

15. Any object that is not designed to be placed in the openings of the housing must not be used for this 
purpose. Doing so can cause short circuits inside the product and/or electric shocks, fire or injuries. 

16. Unless specified otherwise, products are not liquid-proof (see also section "Operating states and 
operating positions", item 1). Therefore, the equipment must be protected against penetration by 
liquids. If the necessary precautions are not taken, the user may suffer electric shock or the product 
itself may be damaged, which can also lead to personal injury. 

17. Never use the product under conditions in which condensation has formed or can form in or on the 
product, e.g. if the product has been moved from a cold to a warm environment. Penetration by water 
increases the risk of electric shock. 

18. Prior to cleaning the product, disconnect it completely from the power supply (e.g. AC supply network 
or battery). Use a soft, non-linting cloth to clean the product. Never use chemical cleaning agents such 
as alcohol, acetone or diluents for cellulose lacquers. 

Operation 

1. Operating the products requires special training and intense concentration. Make sure that persons 
who use the products are physically, mentally and emotionally fit enough to do so; otherwise, injuries 
or material damage may occur. It is the responsibility of the employer/operator to select suitable 
personnel for operating the products. 
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2. Before you move or transport the product, read and observe the section titled "Transport". 

3. As with all industrially manufactured goods, the use of substances that induce an allergic reaction 
(allergens) such as nickel cannot be generally excluded. If you develop an allergic reaction (such as a 
skin rash, frequent sneezing, red eyes or respiratory difficulties) when using a Rohde & Schwarz 
product, consult a physician immediately to determine the cause and to prevent health problems or 
stress.  

4. Before you start processing the product mechanically and/or thermally, or before you take it apart, be 
sure to read and pay special attention to the section titled "Waste disposal/Environmental protection", 
item 1. 

5. Depending on the function, certain products such as RF radio equipment can produce an elevated 
level of electromagnetic radiation. Considering that unborn babies require increased protection, 
pregnant women must be protected by appropriate measures. Persons with pacemakers may also be 
exposed to risks from electromagnetic radiation. The employer/operator must evaluate workplaces 
where there is a special risk of exposure to radiation and, if necessary, take measures to avert the 
potential danger. 

6. Should a fire occur, the product may release hazardous substances (gases, fluids, etc.) that can 
cause health problems. Therefore, suitable measures must be taken, e.g. protective masks and 
protective clothing must be worn. 

7. Laser products are given warning labels that are standardized according to their laser class. Lasers 
can cause biological harm due to the properties of their radiation and due to their extremely 
concentrated electromagnetic power. If a laser product (e.g. a CD/DVD drive) is integrated into a 
Rohde & Schwarz product, absolutely no other settings or functions may be used as described in the 
product documentation. The objective is to prevent personal injury (e.g. due to laser beams). 

8. EMC classes (in line with CISPR 11) 
Class A: Equipment suitable for use in all environments except residential environments and 
environments that are directly connected to a low-voltage supply network that supplies residential 
buildings. 
Class B: Equipment suitable for use in residential environments and environments that are directly 
connected to a low-voltage supply network that supplies residential buildings. 

Repair and service 

1. The product may be opened only by authorized, specially trained personnel. Before any work is 
performed on the product or before the product is opened, it must be disconnected from the AC supply 
network. Otherwise, personnel will be exposed to the risk of an electric shock.  

2. Adjustments, replacement of parts, maintenance and repair may be performed only by electrical 
experts authorized by Rohde & Schwarz. Only original parts may be used for replacing parts relevant 
to safety (e.g. power switches, power transformers, fuses). A safety test must always be performed 
after parts relevant to safety have been replaced (visual inspection, protective conductor test, 
insulation resistance measurement, leakage current measurement, functional test). This helps ensure 
the continued safety of the product.  
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Batteries and rechargeable batteries/cells 

If the information regarding batteries and rechargeable batteries/cells is not observed either at all or to the 
extent necessary, product users may be exposed to the risk of explosions, fire and/or serious personal 
injury, and, in some cases, death. Batteries and rechargeable batteries with alkaline electrolytes (e.g. 
lithium cells) must be handled in accordance with the EN 62133 standard. 

1. Cells must not be taken apart or crushed.  

2. Cells or batteries must not be exposed to heat or fire. Storage in direct sunlight must be avoided. 
Keep cells and batteries clean and dry. Clean soiled connectors using a dry, clean cloth. 

3. Cells or batteries must not be short-circuited. Cells or batteries must not be stored in a box or in a 
drawer where they can short-circuit each other, or where they can be short-circuited by other 
conductive materials. Cells and batteries must not be removed from their original packaging until they 
are ready to be used. 

4. Cells and batteries must not be exposed to any mechanical shocks that are stronger than permitted. 

5. If a cell develops a leak, the fluid must not be allowed to come into contact with the skin or eyes. If 
contact occurs, wash the affected area with plenty of water and seek medical aid. 

6. Improperly replacing or charging cells or batteries that contain alkaline electrolytes (e.g. lithium cells) 
can cause explosions. Replace cells or batteries only with the matching Rohde & Schwarz type (see 
parts list) in order to ensure the safety of the product.  

7. Cells and batteries must be recycled and kept separate from residual waste. Rechargeable batteries 
and normal batteries that contain lead, mercury or cadmium are hazardous waste. Observe the 
national regulations regarding waste disposal and recycling.  

Transport 

1. The product may be very heavy. Therefore, the product must be handled with care. In some cases, 
the user may require a suitable means of lifting or moving the product (e.g. with a lift-truck) to avoid 
back or other physical injuries.  

2. Handles on the products are designed exclusively to enable personnel to transport the product. It is 
therefore not permissible to use handles to fasten the product to or on transport equipment such as 
cranes, fork lifts, wagons, etc. The user is responsible for securely fastening the products to or on the 
means of transport or lifting. Observe the safety regulations of the manufacturer of the means of 
transport or lifting. Noncompliance can result in personal injury or material damage. 

3. If you use the product in a vehicle, it is the sole responsibility of the driver to drive the vehicle safely 
and properly. The manufacturer assumes no responsibility for accidents or collisions. Never use the 
product in a moving vehicle if doing so could distract the driver of the vehicle. Adequately secure the 
product in the vehicle to prevent injuries or other damage in the event of an accident.  

Waste disposal/Environmental protection 

1. Specially marked equipment has a battery or accumulator that must not be disposed of with unsorted 
municipal waste, but must be collected separately. It may only be disposed of at a suitable collection 
point or via a Rohde & Schwarz customer service center. 
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2. Waste electrical and electronic equipment must not be disposed of with unsorted municipal waste, but 
must be collected separately. 
Rohde & Schwarz GmbH & Co. KG has developed a disposal concept and takes full responsibility for 
take-back obligations and disposal obligations for manufacturers within the EU. Contact your 
Rohde & Schwarz customer service center for environmentally responsible disposal of the product. 

3. If products or their components are mechanically and/or thermally processed in a manner that goes 
beyond their intended use, hazardous substances (heavy-metal dust such as lead, beryllium, nickel) 
may be released. For this reason, the product may only be disassembled by specially trained 
personnel. Improper disassembly may be hazardous to your health. National waste disposal 
regulations must be observed.  

4. If handling the product releases hazardous substances or fuels that must be disposed of in a special 
way, e.g. coolants or engine oils that must be replenished regularly, the safety instructions of the 
manufacturer of the hazardous substances or fuels and the applicable regional waste disposal 
regulations must be observed. Also observe the relevant safety instructions in the product 
documentation. The improper disposal of hazardous substances or fuels can cause health problems 
and lead to environmental damage. 

For additional information about environmental protection, visit the Rohde & Schwarz website. 

Instrucciones de seguridad elementales 
¡Es imprescindible leer y cumplir las siguientes instrucciones e informaciones de seguridad! 

El principio del grupo de empresas Rohde & Schwarz consiste en tener nuestros productos siempre al día 
con los estándares de seguridad y de ofrecer a nuestros clientes el máximo grado de seguridad. Nuestros 
productos y todos los equipos adicionales son siempre fabricados y examinados según las normas de 
seguridad vigentes. Nuestro sistema de garantía de calidad controla constantemente que sean cumplidas 
estas normas. El presente producto ha sido fabricado y examinado según el certificado de conformidad 
adjunto de la UE y ha salido de nuestra planta en estado impecable según los estándares técnicos de 
seguridad. Para poder preservar este estado y garantizar un funcionamiento libre de peligros, el usuario 
deberá atenerse a todas las indicaciones, informaciones de seguridad y notas de alerta. El grupo de 
empresas Rohde & Schwarz está siempre a su disposición en caso de que tengan preguntas referentes a 
estas informaciones de seguridad. 

Además queda en la responsabilidad del usuario utilizar el producto en la forma debida. Este producto 
está destinado exclusivamente al uso en la industria y el laboratorio o, si ha sido expresamente 
autorizado, para aplicaciones de campo y de ninguna manera deberá ser utilizado de modo que alguna 
persona/cosa pueda sufrir daño. El uso del producto fuera de sus fines definidos o sin tener en cuenta las 
instrucciones del fabricante queda en la responsabilidad del usuario. El fabricante no se hace en ninguna 
forma responsable de consecuencias a causa del mal uso del producto.  
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Se parte del uso correcto del producto para los fines definidos si el producto es utilizado conforme a las 
indicaciones de la correspondiente documentación del producto y dentro del margen de rendimiento 
definido (ver hoja de datos, documentación, informaciones de seguridad que siguen). El uso del producto 
hace necesarios conocimientos técnicos y ciertos conocimientos del idioma inglés. Por eso se debe tener 
en cuenta que el producto solo pueda ser operado por personal especializado o personas instruidas en 
profundidad con las capacidades correspondientes. Si fuera necesaria indumentaria de seguridad para el 
uso de productos de Rohde & Schwarz, encontraría la información debida en la documentación del 
producto en el capítulo correspondiente. Guarde bien las informaciones de seguridad elementales, así 
como la documentación del producto, y entréguelas a usuarios posteriores. 

Tener en cuenta las informaciones de seguridad sirve para evitar en lo posible lesiones o daños por 
peligros de toda clase. Por eso es imprescindible leer detalladamente y comprender por completo las 
siguientes informaciones de seguridad antes de usar el producto, y respetarlas durante el uso del 
producto. Deberán tenerse en cuenta todas las demás informaciones de seguridad, como p. ej. las 
referentes a la protección de personas, que encontrarán en el capítulo correspondiente de la 
documentación del producto y que también son de obligado cumplimiento. En las presentes 
informaciones de seguridad se recogen todos los objetos que distribuye el grupo de empresas 
Rohde & Schwarz bajo la denominación de "producto", entre ellos también aparatos, instalaciones así 
como toda clase de accesorios. Los datos específicos del producto figuran en la hoja de datos y en la 
documentación del producto. 

Símbolos y definiciones de seguridad 

Símbolo Significado Símbolo Significado 

Aviso: punto de peligro general 

Observar la documentación del producto 

Tensión de alimentación de PUESTA EN 
MARCHA / PARADA 

Atención en el manejo de dispositivos de peso 
elevado 

Indicación de estado de espera (standby) 

Peligro de choque eléctrico Corriente continua (DC) 

Advertencia: superficie caliente Corriente alterna (AC) 

Conexión a conductor de protección Corriente continua / Corriente alterna (DC/AC) 

Conexión a tierra El aparato está protegido en su totalidad por un 
aislamiento doble (reforzado) 

Conexión a masa Distintivo de la UE para baterías y 
acumuladores 

Más información en la sección 
"Eliminación/protección del medio ambiente", 
punto 1. 
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Símbolo Significado Símbolo Significado 

Aviso: Cuidado en el manejo de dispositivos 
sensibles a la electrostática (ESD) 

Distintivo de la UE para la eliminación por 
separado de dispositivos eléctricos y 
electrónicos 

Más información en la sección 
"Eliminación/protección del medio ambiente", 
punto 2. 

Advertencia: rayo láser 

Más información en la sección 
"Funcionamiento", punto 7. 

 

Palabras de señal y su significado 

En la documentación del producto se utilizan las siguientes palabras de señal con el fin de advertir contra 
riesgos y peligros. 

PELIGRO identifica un peligro inminente con riesgo elevado que 
provocará muerte o lesiones graves si no se evita.  

ADVERTENCIA identifica un posible peligro con riesgo medio de 
provocar muerte o lesiones (graves) si no se evita. 

ATENCIÓN identifica un peligro con riesgo reducido de provocar 
lesiones leves o moderadas si no se evita. 

AVISO indica la posibilidad de utilizar mal el producto y, como 
consecuencia, dañarlo. 
En la documentación del producto se emplea de forma sinónima el 
término CUIDADO. 

 
Las palabras de señal corresponden a la definición habitual para aplicaciones civiles en el área 
económica europea. Pueden existir definiciones diferentes a esta definición en otras áreas económicas o 
en aplicaciones militares. Por eso se deberá tener en cuenta que las palabras de señal aquí descritas 
sean utilizadas siempre solamente en combinación con la correspondiente documentación del producto y 
solamente en combinación con el producto correspondiente. La utilización de las palabras de señal en 
combinación con productos o documentaciones que no les correspondan puede llevar a interpretaciones 
equivocadas y tener por consecuencia daños en personas u objetos. 

Estados operativos y posiciones de funcionamiento 

El producto solamente debe ser utilizado según lo indicado por el fabricante respecto a los estados 
operativos y posiciones de funcionamiento sin que se obstruya la ventilación. Si no se siguen las 
indicaciones del fabricante, pueden producirse choques eléctricos, incendios y/o lesiones graves con 
posible consecuencia de muerte. En todos los trabajos deberán ser tenidas en cuenta las normas 
nacionales y locales de seguridad del trabajo y de prevención de accidentes.  
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1. Si no se convino de otra manera, es para los productos Rohde & Schwarz válido lo que sigue:  
como posición de funcionamiento se define por principio la posición con el suelo de la caja para 
abajo, modo de protección IP 2X, uso solamente en estancias interiores, utilización hasta 2000 m 
sobre el nivel del mar, transporte hasta 4500 m sobre el nivel del mar. Se aplicará una tolerancia de 
±10 % sobre el voltaje nominal y de ±5 % sobre la frecuencia nominal. Categoría de sobrecarga 
eléctrica 2, índice de suciedad 2.  

2. No sitúe el producto encima de superficies, vehículos, estantes o mesas, que por sus características 
de peso o de estabilidad no sean aptos para él. Siga siempre las instrucciones de instalación del 
fabricante cuando instale y asegure el producto en objetos o estructuras (p. ej. paredes y estantes). Si 
se realiza la instalación de modo distinto al indicado en la documentación del producto, se pueden 
causar lesiones o, en determinadas circunstancias, incluso la muerte. 

3. No ponga el producto sobre aparatos que generen calor (p. ej. radiadores o calefactores). La 
temperatura ambiente no debe superar la temperatura máxima especificada en la documentación del 
producto o en la hoja de datos. En caso de sobrecalentamiento del producto, pueden producirse 
choques eléctricos, incendios y/o lesiones graves con posible consecuencia de muerte. 

Seguridad eléctrica 

Si no se siguen (o se siguen de modo insuficiente) las indicaciones del fabricante en cuanto a seguridad 
eléctrica, pueden producirse choques eléctricos, incendios y/o lesiones graves con posible consecuencia 
de muerte.  

1. Antes de la puesta en marcha del producto se deberá comprobar siempre que la tensión 
preseleccionada en el producto coincida con la de la red de alimentación eléctrica. Si es necesario 
modificar el ajuste de tensión, también se deberán cambiar en caso dado los fusibles 
correspondientes del producto.  

2. Los productos de la clase de protección I con alimentación móvil y enchufe individual solamente 
podrán enchufarse a tomas de corriente con contacto de seguridad y con conductor de protección 
conectado. 

3. Queda prohibida la interrupción intencionada del conductor de protección, tanto en la toma de 
corriente como en el mismo producto. La interrupción puede tener como consecuencia el riesgo de 
que el producto sea fuente de choques eléctricos. Si se utilizan cables alargadores o regletas de 
enchufe, deberá garantizarse la realización de un examen regular de los mismos en cuanto a su 
estado técnico de seguridad. 

4. Si el producto no está equipado con un interruptor para desconectarlo de la red, o bien si el 
interruptor existente no resulta apropiado para la desconexión de la red, el enchufe del cable de 
conexión se deberá considerar como un dispositivo de desconexión.  
El dispositivo de desconexión se debe poder alcanzar fácilmente y debe estar siempre bien accesible. 
Si, p. ej., el enchufe de conexión a la red es el dispositivo de desconexión, la longitud del cable de 
conexión no debe superar 3 m).  
Los interruptores selectores o electrónicos no son aptos para el corte de la red eléctrica. Si se 
integran productos sin interruptor en bastidores o instalaciones, se deberá colocar el interruptor en el 
nivel de la instalación. 

5. No utilice nunca el producto si está dañado el cable de conexión a red. Compruebe regularmente el 
correcto estado de los cables de conexión a red. Asegúrese, mediante las medidas de protección y 
de instalación adecuadas, de que el cable de conexión a red no pueda ser dañado o de que nadie 
pueda ser dañado por él, p. ej. al tropezar o por un choque eléctrico.  
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6. Solamente está permitido el funcionamiento en redes de alimentación TN/TT aseguradas con fusibles 
de 16 A como máximo (utilización de fusibles de mayor amperaje solo previa consulta con el grupo de 
empresas Rohde & Schwarz). 

7. Nunca conecte el enchufe en tomas de corriente sucias o llenas de polvo. Introduzca el enchufe por 
completo y fuertemente en la toma de corriente. La no observación de estas medidas puede provocar 
chispas, fuego y/o lesiones. 

8. No sobrecargue las tomas de corriente, los cables alargadores o las regletas de enchufe ya que esto 
podría causar fuego o choques eléctricos. 

9. En las mediciones en circuitos de corriente con una tensión Ueff > 30 V se deberán tomar las medidas 
apropiadas para impedir cualquier peligro (p. ej. medios de medición adecuados, seguros, limitación 
de tensión, corte protector, aislamiento etc.). 

10. Para la conexión con dispositivos informáticos como un PC o un ordenador industrial, debe 
comprobarse que éstos cumplan los estándares IEC60950-1/EN60950-1 o IEC61010-1/EN 61010-1 
válidos en cada caso. 

11. A menos que esté permitido expresamente, no retire nunca la tapa ni componentes de la carcasa 
mientras el producto esté en servicio. Esto pone a descubierto los cables y componentes eléctricos y 
puede causar lesiones, fuego o daños en el producto. 

12. Si un producto se instala en un lugar fijo, se deberá primero conectar el conductor de protección fijo 
con el conductor de protección del producto antes de hacer cualquier otra conexión. La instalación y 
la conexión deberán ser efectuadas por un electricista especializado. 

13. En el caso de dispositivos fijos que no estén provistos de fusibles, interruptor automático ni otros 
mecanismos de seguridad similares, el circuito de alimentación debe estar protegido de modo que 
todas las personas que puedan acceder al producto, así como el producto mismo, estén a salvo de 
posibles daños. 

14. Todo producto debe estar protegido contra sobretensión (debida p. ej. a una caída del rayo) mediante 
los correspondientes sistemas de protección. Si no, el personal que lo utilice quedará expuesto al 
peligro de choque eléctrico. 

15. No debe introducirse en los orificios de la caja del aparato ningún objeto que no esté destinado a ello. 
Esto puede producir cortocircuitos en el producto y/o puede causar choques eléctricos, fuego o 
lesiones. 

16. Salvo indicación contraria, los productos no están impermeabilizados (ver también el capítulo 
"Estados operativos y posiciones de funcionamiento", punto 1). Por eso es necesario tomar las 
medidas necesarias para evitar la entrada de líquidos. En caso contrario, existe peligro de choque 
eléctrico para el usuario o de daños en el producto, que también pueden redundar en peligro para las 
personas. 

17. No utilice el producto en condiciones en las que pueda producirse o ya se hayan producido 
condensaciones sobre el producto o en el interior de éste, como p. ej. al desplazarlo de un lugar frío a 
otro caliente. La entrada de agua aumenta el riesgo de choque eléctrico. 

18. Antes de la limpieza, desconecte por completo el producto de la alimentación de tensión (p. ej. red de 
alimentación o batería). Realice la limpieza de los aparatos con un paño suave, que no se deshilache. 
No utilice bajo ningún concepto productos de limpieza químicos como alcohol, acetona o diluyentes 
para lacas nitrocelulósicas. 
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Funcionamiento 

1. El uso del producto requiere instrucciones especiales y una alta concentración durante el manejo. 
Debe asegurarse que las personas que manejen el producto estén a la altura de los requerimientos 
necesarios en cuanto a aptitudes físicas, psíquicas y emocionales, ya que de otra manera no se 
pueden excluir lesiones o daños de objetos. El empresario u operador es responsable de seleccionar 
el personal usuario apto para el manejo del producto. 

2. Antes de desplazar o transportar el producto, lea y tenga en cuenta el capítulo "Transporte". 

3. Como con todo producto de fabricación industrial no puede quedar excluida en general la posibilidad 
de que se produzcan alergias provocadas por algunos materiales empleados ―los llamados 
alérgenos (p. ej. el níquel)―. Si durante el manejo de productos Rohde & Schwarz se producen 
reacciones alérgicas, como p. ej. irritaciones cutáneas, estornudos continuos, enrojecimiento de la 
conjuntiva o dificultades respiratorias, debe avisarse inmediatamente a un médico para investigar las 
causas y evitar cualquier molestia o daño a la salud.  

4. Antes de la manipulación mecánica y/o térmica o el desmontaje del producto, debe tenerse en cuenta 
imprescindiblemente el capítulo "Eliminación/protección del medio ambiente", punto 1. 

5. Ciertos productos, como p. ej. las instalaciones de radiocomunicación RF, pueden a causa de su 
función natural, emitir una radiación electromagnética aumentada. Deben tomarse todas las medidas 
necesarias para la protección de las mujeres embarazadas. También las personas con marcapasos 
pueden correr peligro a causa de la radiación electromagnética. El empresario/operador tiene la 
obligación de evaluar y señalizar las áreas de trabajo en las que exista un riesgo elevado de 
exposición a radiaciones. 

6. Tenga en cuenta que en caso de incendio pueden desprenderse del producto sustancias tóxicas 
(gases, líquidos etc.) que pueden generar daños a la salud. Por eso, en caso de incendio deben 
usarse medidas adecuadas, como p. ej. máscaras antigás e indumentaria de protección. 

7. Los productos con láser están provistos de indicaciones de advertencia normalizadas en función de la 
clase de láser del que se trate. Los rayos láser pueden provocar daños de tipo biológico a causa de 
las propiedades de su radiación y debido a su concentración extrema de potencia electromagnética. 
En caso de que un producto Rohde & Schwarz contenga un producto láser (p. ej. un lector de 
CD/DVD), no debe usarse ninguna otra configuración o función aparte de las descritas en la 
documentación del producto, a fin de evitar lesiones (p. ej. debidas a irradiación láser). 

8. Clases CEM (según CISPR 11) 
Clase A: dispositivo apropiado para el uso en cualquier zona excepto en áreas residenciales y en 
aquellas zonas que se encuentran conectadas a una red de suministro de baja tensión que alimenta 
un edificio de viviendas. 
Clase B: dispositivo apropiado para el uso en áreas residenciales y en aquellas zonas que se 
encuentran conectadas a una red de suministro de baja tensión que alimenta un edificio de viviendas. 

Reparación y mantenimiento 

1. El producto solamente debe ser abierto por personal especializado con autorización para ello. Antes 
de manipular el producto o abrirlo, es obligatorio desconectarlo de la tensión de alimentación, para 
evitar toda posibilidad de choque eléctrico.  
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2. El ajuste, el cambio de partes, el mantenimiento y la reparación deberán ser efectuadas solamente 
por electricistas autorizados por Rohde & Schwarz. Si se reponen partes con importancia para los 
aspectos de seguridad (p. ej. el enchufe, los transformadores o los fusibles), solamente podrán ser 
sustituidos por partes originales. Después de cada cambio de partes relevantes para la seguridad 
deberá realizarse un control de seguridad (control a primera vista, control del conductor de 
protección, medición de resistencia de aislamiento, medición de la corriente de fuga, control de 
funcionamiento). Con esto queda garantizada la seguridad del producto.  

Baterías y acumuladores o celdas 

Si no se siguen (o se siguen de modo insuficiente) las indicaciones en cuanto a las baterías y 
acumuladores o celdas, pueden producirse explosiones, incendios y/o lesiones graves con posible 
consecuencia de muerte. El manejo de baterías y acumuladores con electrolitos alcalinos (p. ej. celdas de 
litio) debe seguir el estándar EN 62133. 

1. No deben desmontarse, abrirse ni triturarse las celdas.  

2. Las celdas o baterías no deben someterse a calor ni fuego. Debe evitarse el almacenamiento a la luz 
directa del sol. Las celdas y baterías deben mantenerse limpias y secas. Limpiar las conexiones 
sucias con un paño seco y limpio. 

3. Las celdas o baterías no deben cortocircuitarse. Es peligroso almacenar las celdas o baterías en 
estuches o cajones en cuyo interior puedan cortocircuitarse por contacto recíproco o por contacto con 
otros materiales conductores. No deben extraerse las celdas o baterías de sus embalajes originales 
hasta el momento en que vayan a utilizarse. 

4. Las celdas o baterías no deben someterse a impactos mecánicos fuertes indebidos. 

5. En caso de falta de estanqueidad de una celda, el líquido vertido no debe entrar en contacto con la 
piel ni los ojos. Si se produce contacto, lavar con agua abundante la zona afectada y avisar a un 
médico. 

6. En caso de cambio o recarga inadecuados, las celdas o baterías que contienen electrolitos alcalinos 
(p. ej. las celdas de litio) pueden explotar. Para garantizar la seguridad del producto, las celdas o 
baterías solo deben ser sustituidas por el tipo Rohde & Schwarz correspondiente (ver lista de 
recambios).  

7. Las baterías y celdas deben reciclarse y no deben tirarse a la basura doméstica. Las baterías o 
acumuladores que contienen plomo, mercurio o cadmio deben tratarse como residuos especiales. 
Respete en esta relación las normas nacionales de eliminación y reciclaje.  

Transporte 

1. El producto puede tener un peso elevado. Por eso es necesario desplazarlo o transportarlo con 
precaución y, si es necesario, usando un sistema de elevación adecuado (p. ej. una carretilla 
elevadora), a fin de evitar lesiones en la espalda u otros daños personales.  

2. Las asas instaladas en los productos sirven solamente de ayuda para el transporte del producto por 
personas. Por eso no está permitido utilizar las asas para la sujeción en o sobre medios de transporte 
como p. ej. grúas, carretillas elevadoras de horquilla, carros etc. Es responsabilidad suya fijar los 
productos de manera segura a los medios de transporte o elevación. Para evitar daños personales o 
daños en el producto, siga las instrucciones de seguridad del fabricante del medio de transporte o 
elevación utilizado. 
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3. Si se utiliza el producto dentro de un vehículo, recae de manera exclusiva en el conductor la 
responsabilidad de conducir el vehículo de manera segura y adecuada. El fabricante no asumirá 
ninguna responsabilidad por accidentes o colisiones. No utilice nunca el producto dentro de un 
vehículo en movimiento si esto pudiera distraer al conductor. Asegure el producto dentro del vehículo 
debidamente para evitar, en caso de un accidente, lesiones u otra clase de daños.  

Eliminación/protección del medio ambiente 

1. Los dispositivos marcados contienen una batería o un acumulador que no se debe desechar con los 
residuos domésticos sin clasificar, sino que debe ser recogido por separado. La eliminación se debe 
efectuar exclusivamente a través de un punto de recogida apropiado o del servicio de atención al 
cliente de Rohde & Schwarz. 

2. Los dispositivos eléctricos usados no se deben desechar con los residuos domésticos sin clasificar, 
sino que deben ser recogidos por separado. 
Rohde & Schwarz GmbH & Co.KG ha elaborado un concepto de eliminación de residuos y asume 
plenamente los deberes de recogida y eliminación para los fabricantes dentro de la UE. Para 
desechar el producto de manera respetuosa con el medio ambiente, diríjase a su servicio de atención 
al cliente de Rohde & Schwarz. 

3. Si se trabaja de manera mecánica y/o térmica cualquier producto o componente más allá del 
funcionamiento previsto, pueden liberarse sustancias peligrosas (polvos con contenido de metales 
pesados como p. ej. plomo, berilio o níquel). Por eso el producto solo debe ser desmontado por 
personal especializado con formación adecuada. Un desmontaje inadecuado puede ocasionar daños 
para la salud. Se deben tener en cuenta las directivas nacionales referentes a la eliminación de 
residuos. 

4. En caso de que durante el trato del producto se formen sustancias peligrosas o combustibles que 
deban tratarse como residuos especiales (p. ej. refrigerantes o aceites de motor con intervalos de 
cambio definidos), deben tenerse en cuenta las indicaciones de seguridad del fabricante de dichas 
sustancias y las normas regionales de eliminación de residuos. Tenga en cuenta también en caso 
necesario las indicaciones de seguridad especiales contenidas en la documentación del producto. La 
eliminación incorrecta de sustancias peligrosas o combustibles puede causar daños a la salud o 
daños al medio ambiente. 

Se puede encontrar más información sobre la protección del medio ambiente en la página web de 
Rohde & Schwarz. 



Sehr geehrter Kunde,
Sie haben sich für den Kauf eines  
Rohde & Schwarz-Produktes ent-
schieden. Hiermit erhalten Sie ein 
nach modernsten Fertigungsmethoden 
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Vous avez choisi d’acheter un pro-
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CE Declaration of Conformity 

ROHDE & SCHWARZ GmbH & Co. KG 
Mühldorfstr. 15,  D-81671 München 
 
Munich, 2011-04-01  Central Quality Management GF-QP / Chadzelek 
 
1416.0505.02 CE E-1 

 

Certificate No.: 2011-11 
 

This is to certify that: 
 

Equipment type Stock No. Designation 
SGS100A 1416.0505.02 SGMA RF SOURCE BASE UNIT 
 

complies with the provisions of the Directive of the Council of the European Union on the 
approximation of the laws of the Member States  
 
- relating to electrical equipment for use within defined voltage limits  

(2006/95/EC) 
 
- relating to electromagnetic compatibility  

(2004/108/EC) 
 
Conformity is proven by compliance with the following standards: 
 
EN 61010-1: 2001 
EN 61326-1: 2006 
EN 61326-2-1: 2006 
EN 55011: 2007 + A2: 2007 
EN 61000-3-2: 2006 
EN 61000-3-3:2008 
 
For the assessment of electromagnetic compatibility, the limits of radio interference for Class 
B equipment as well as the immunity to interference for operation in industry have been used 
as a basis. 
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Customer Support 
 

Technical support – where and when you need it 
For quick, expert help with any Rohde & Schwarz equipment, contact one of our Customer Support 
Centers. A team of highly qualified engineers provides telephone support and will work with you to find a 
solution to your query on any aspect of the operation, programming or applications of Rohde & Schwarz 
equipment. 
 

Up-to-date information and upgrades 
To keep your instrument up-to-date and to be informed about new application notes related to your 
instrument, please send an e-mail to the Customer Support Center stating your instrument and your wish. 
We will take care that you will get the right information. 
 

Europe, Africa, Middle East Phone +49 89 4129 12345 
customersupport@rohde-schwarz.com

North America Phone 1-888-TEST-RSA (1-888-837-8772) 
customer.support@rsa.rohde-schwarz.com

Latin America Phone +1-410-910-7988 
customersupport.la@rohde-schwarz.com

Asia/Pacific Phone +65 65 13 04 88 
customersupport.asia@rohde-schwarz.com

China Phone +86-800-810-8228 /  
 +86-400-650-5896 
customersupport.china@rohde-schwarz.com

mailto:customersupport.asia@rohde-schwarz.com
mailto:customersupport.la@rohde-schwarz.com
mailto:customer.support@rsa.rohde-schwarz.com
mailto:customersupport@rohde-schwarz.com
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1 Preface
The R&S SGS RF Source is a signal generator intended either for the generation of IQ-
modulated signals or as a pure local oscillator (LO) source in the frequency range of 1
MHz to 12.75 GHz.

Optimized for use in automated test equipment (ATE), the instrument offers very fast
settling times in an exceptionally small formfactor and low power consumption. The
R&S SGS can be equipped optionally with an active electronic step attenuator, a high
stability reference oscillator and LO connectors for coupling multiple generators to a
common LO source.

1.1 Key Features

The key features of the R&S SGS include the following:

● Compact size and low power consumption
● Remote connection via PCI Express, minimizing time for setup

Alternatively, LAN or USB connections available
● Optional coherent LO input and output connectors, also usable as MIMO input/output

and phase coherent I/Q demodulation
● Broadband analogue input for vector modulation (I, Q)
● Linux operating system
● Graphical user interface R&S SGMA-GUI to set up and control one or more R&S SGS

instruments simultaneously from one remote computer, available for Windows and
Linux systems

1.2 Documentation Overview

The user documentation for the R&S SGS consists of the following parts:

● "Getting Started" printed manual
● Documentation CD-ROM with:

– Online help system (*.chm) as a standalone help

– User Manual for base unit and options
– Service manual
– Data sheet and product brochure
– Links to useful sites on the R&S internet

R&S SGMA-GUI Online Help

The Online Help is embedded in the R&S SGMA-GUI software. It offers quick, context-
sensitive access to the complete information needed for operation and programming. The
online help contains help on operating the R&S SGS and all available options.
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Getting Started

This manual is delivered with the instrument in printed form and in PDF format on the
Documentation CD-ROM. It provides the information needed to set up and start working
with the instrument. Basic operations and typical measurement examples are described.
The manual includes also general information, e.g., safety instructions.

User Manual

The User Manual is a supplement to the Getting Started manual. The manual is available
in PDF format - in printable form - on the Documentation CD-ROM delivered with the
instrument. In this manual, all instrument functions are described in detail. Furthermore,
it provides an introduction to remote control and a complete description of the remote
control commands with programming examples. Information on maintenance, instrument
interfaces and error messages is also given.

Service Manual

The Service Manual is available in PDF format - in printable form - on the documentation
CD-ROM delivered with the instrument. It informs on how to check compliance with rated
specifications, on instrument function, repair, troubleshooting and fault elimination. It
contains all information required for repairing the instrument by the replacement of mod-
ules.

1.3 Typographical Conventions

The following text markers are used throughout this documentation:

Convention Description

"Graphical user interface ele-
ments"

All names of graphical user interface elements on the screen, such as dia-
log boxes, menus, options, buttons, and softkeys are enclosed by quota-
tion marks.

KEYS Key names are written in capital letters.

File names, commands,
program code

File names, commands, coding samples and screen output are distin-
guished by their font.

Input Input to be entered by the user is displayed in italics.

​Links Links that you can click are displayed in blue font.

"References" References to other parts of the documentation are enclosed by quotation
marks.
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2 System Overview
The R&S SGS RF Source is a signal generator intended either for the generation of IQ-
modulated signals or as a pure local oscillator (LO) source in the frequency range of 1
MHz to 12.75 GHz.

Optimized for use in automated test equipment (ATE), the instrument offers very fast
settling times in an exceptionally small formfactor and low power consumption. The
R&S SGS can be equipped optionally with an active electronic step attenuator, a high
stability reference oscillator and LO connectors for coupling multiple generators to a
common LO source.

2.1 Setups for Instrument Control

The R&S SGS is a signal generator designed for the automated test equipment (ATE)
needs. To maintain the small size, the instrument is not equipped with a display and hence
additional equipment is required to control the instrument.

This section provides an overview of the possible configuration setups for control of the
R&S SGS.

2.1.1 Manual Operation from R&S SGMA-GUI

The example below represents a basic configuration of the R&S SGS, operated manually
by the configuration software R&S SGMA-GUI. The configuration software is installed on
a remote PC and controls several instruments. The instruments are connected to the
remote PC over different remote control interfaces. Any combination of the used interfa-
ces is possible.
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For information about the manual control, refer to:
● ​chapter 3, "Understanding the R&S SGMA-GUI Software", on page 25
● ​chapter 4, "Signal Generator Settings", on page 42
● ​chapter 5, "General Instrument Settings and Instrument Setup", on page 56

2.1.2 Remote Control from a Controller

The remote control provides access to the instrument's settings from a remote computer
(external controller) by means of remote commands. To automate often repeating set-
tings and settings sequences, these are grouped in the remote control programs, i.e.
application programs. These application programs may either run on the same controller
as the R&S SGMA-GUI or on any other PC in the network.

The instruments are connected to the controller over different remote control interfaces.
Any combination of the used interfaces is possible.

Fig. 2-1: Configuration example: remote control over controller

For information about remote control, refer to:
● ​chapter 6, "Remote Control Operation", on page 72
● ​chapter A, "Remote Control Basics", on page 149

2.2 Introduction to the Instrument Functions

This section is intended to give a brief introduction to the instrument's function and
detailed information on how to work with the instrument and to perform basic and
advanced operating tasks. The description of the related user interface parameters is
provided in the corresponding section in ​chapter 4, "Signal Generator Set-
tings", on page 42.

The ​figure 2-2 provides a simplified block diagram of the instrument.

 

 

Introduction to the Instrument Functions



System OverviewR&S®SGS100A

13User Manual 1173.9105.02 ─ 05

For better understanding of the instrument functions and the signal flow, the block dia-
gram shows the main blocks of the instrument together with the corresponding GUI
parameters.

Fig. 2-2: Simplified Block Diagram

TCXO = Built-in reference oscillator
OCXO = Oven-controlled oscillator, requires hardware

option R&S SGS-B1
Synth. = Synthesizer
I/Q Mod = I/Q Modulator
REF/LO IN, REF/LO OUT, I, Q, RF OUT = Connector at the rear panel
"Ref. Osc. Source", "REF/LO Out", "LO Coupling Source",
"Mod On/Off", RF On/Off", "Operation Mode"

= R&S SGMA-GUI equivalent parameter

The instrument can generate an CW or an I/Q modulated signal ("Mod On/Off"). The
frequency and level settings are adjustable ("Level", "RF on/Off", "Frequency"). The
instrument can use its internal reference frequency or a fed-in external one (REF/LO IN,
"Ref. Osc. Source"). The reference frequency can also be output for synchronisation
purposes (REF/LO OUT, "REF/LO Out"). The local oscillator (LO) signal can be distrib-
uted in such a way, that two or more instruments are connected to generate phase
coherent signals ("LO Coupling Source", REF/LO OUT, "REF/LO Out"). Whereat both
possibilities, the input of the reference frequency and the input of a LO signal, exclude
each other because they use the same connectors. The same applies for the output of
the reference frequency and the LO signal. The instrument can also be configured to work
in the special baseband bypass mode ("Operation Mode").

Refer to ​chapter 2.2.1, "Basic Configuration Tasks", on page 13 for an overview of the
general operating tasks. The ​chapter 2.2.1.1, "Generating an I/Q Modulated Sig-
nal", on page 14 explains the basic operating concept by means of an example.

2.2.1 Basic Configuration Tasks

This section provides a general explanation on how to operate the instrument manually
via the R&S SGMA-GUI software.
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We assume, that the R&S SGS is connected to a remote PC. The R&S SGMA-GUI soft-
ware has to be installed on this remote PC and the instrument is added to the list of
"Available Instruments".

For information on how to fulfill these requirements, refer to:
● Getting Started manual, section "Connecting the Instrument to the Network"
● Getting Started manual, section "Installing the R&S SGMA-GUI Software on the

External PC"
● ​chapter 3.4.2.3, "Adding New Instruments Manually to the R&S SGMA-

GUI", on page 37

General Workflow

The general workflow for generating a signal with the R&S SGS comprises the following
main steps:

1. Decide whether a CW or an I/Q modulated signal will be generated.
See ​chapter 2.2.1.1, "Generating an I/Q Modulated Signal", on page 14.

2. Select the operating mode.
See ​chapter 2.2.2.4, "Working in Baseband Bypass Mode", on page 22.

3. Configure the reference and local oscillator settings.
See ​chapter 2.2.1.3, "Configuring the Reference Oscillator Source", on page 18
and ​chapter 2.2.1.4, "Configuring the Local Oscillator (LO) Coupling
Source", on page 18.

4. Adjust the frequency, level and I/Q settings, for example, to optimize performance or
to add impairments to the generated signal (see ​chapter 2.2.2.5, "Optimizing Per-
formance", on page 23).

2.2.1.1 Generating an I/Q Modulated Signal

The instrument is manually operated via the R&S SGMA-GUI software.

The I/Q Modulator requires the hardware option R&S SGS-B106V.

1. Connect the test equipment and provide the external analog signal to be modulated
at the I and Q connectors of the instrument.
The figure below shows an example of the test setup. A signal generator, e.g. R&S
AFQ100B is used as a source of the external analog signal. The R&S Signal Gen-
erator provides its internal reference signal to the R&S SGS and the connected signal
analyzer, e.g. the R&S FSV.
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Tip: Refer to the Operating Manual of the R&S Signal Generator and the R&S Signal
Analyzer for information on how to configure the corresponding instrument.

2. Select "SGMA-GUI main panel > Instrument Name > Reference Oscillator > Ext" and
adjust the settings as required.

3. Select "SGMA-GUI main panel > Instrument Name > Frequency/Phase > LO Cou-
pling Source > Int".

Tip: For detailed description on how to select the reference frequency source and
the LO Coupling source, refer to ​chapter 2.2.1.3, "Configuring the Reference Oscil-
lator Source", on page 18 and ​chapter 2.2.1.4, "Configuring the Local Oscillator
(LO) Coupling Source", on page 18.

4. In the "Frequency/Phase" dialog, configure the frequency settings.

5. Select the "SGMA-GUI main panel > Instrument Name > Level > Level" and set the
RF Level.
In the same dialog, configure the further "Level" and "Power-On" settings.

6. Select the "SGMA-GUI main panel > Instrument Name > I/Q settings" and enable I/
Q impairments.
In the "I/Q settings" dialog, set "State > On" to enable the I/Q modulator.

7. Select "SGMA-GUI main panel > RF > On" or press the RF ON key on the front panel
of the instrument.

The RF ON key is green.

The I/Q modulated signal is output at the RF connector of the instrument.

An example on how to configure the instrument to generate a continuous wave (CW)
signal is provided in chapter "Trying Out the Instrument", in the Getting Started manual.

Introduction to the Instrument Functions
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2.2.1.2 Switching Between the Operating States

The ​figure 2-3 gives an overview of the operating states of the instruments and how to
trigger the switch-over between them.

Fig. 2-3: Operating states

:RESTart, :STANdby = SCPI commands
"Setup > Standby", "Setup > Restart", "Shut Down and Exit" = R&S SGMA-GUI controls
POWER ON/STANDBY, POWER SWITCH ON/OFF = Hardkey controls on the front/rear panel of the

instrument

The ​table 2-1 provides a short description of the operating states and their indication.

Table 2-1: Indication of the operating states

Operating
State

Description Indication

Off The instrument is shut down. All LEDs on the front panel of the instrument are
off.

Booting The instrument boots the operating system
and starts the instrument firmware.

If the previous session was terminated regu-
larly, the instrument uses the last setup with
the relevant instrument settings.

The green POWER ON/STANDBY key blinks.
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Operating
State

Description Indication

Standby The standby power mode keeps the power
switch circuits and the remote control system
active.

In this state it is safe to switch off the AC
power and disconnect the instrument from
the power supply.

In the R&S SGMA-GUI, the status indicator in
front of the instrument name is red.

The orange POWER ON/STANDBY key is on.

Ready

(normal
operation)

The instrument is ready for operation. All
modules are power-supplied.

In the R&S SGMA-GUI, the status indicator in
front of the instrument name is green.

The green POWER ON/STANDBY key is on.

Switching the Instrument to Standby State

► To switch the instrument to the standby state, use one of the following alternatives:

a) On the remote PC, select "SGMA-GUI > Instrument Name > Setup > Standby".
b) Press the POWER ON/STANDBY key on the front panel of the instrument.
c) Send the SCPI command ​: ​STANdby ​

The current instruments settings are automatically stored. The instrument switches
to a power saving mode. On the R&S SGMA-GUI, the standby state is indicated by
the red state symbol in front of the corresponding instrument's name, on the front
panel, by the orange POWER ON/STANDBY button.
The instrument can still be remote controlled.

Returning the Instrument from Standby to Ready State

To switch from standby to ready state, use one of the following alternatives:

1. Press the orange POWER ON/STANDBY key on the front panel of the instrument.

2. Send the SCPI command ​: ​RESTart ​

The instrument loads the last setup with all instrument settings, switches to ready
state and is ready for normal operation. In the R&S SGMA-GUI, the ready state is
indicated by the green state symbol in front of the corresponding instrument's name,
on the front panel, by the green POWER ON/STANDBY button.

Switching all Connected Instruments to Standby State and Closing the R&S SGMA-
GUI

► In the R&S SGMA-GUI main panel, select "File > Shut down instruments and exit".

The R&S SGMA-GUI quits and switches the connected instruments to standby state.

For description on how to terminate work and shut down the instrument regularly, refer
to section "Shutting Down the Instrument" in the Getting Started manual.

Introduction to the Instrument Functions
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2.2.1.3 Configuring the Reference Oscillator Source

Using the internal reference frequency source

1. To enable the instrument to use its internal reference frequency source, perform one
of the following:

a) Select "SGMA-GUI main panel > REF > INT".
b) Select "SGMA-GUI > Instrument Name > Reference Oscillator > Source > Int".

2. In the "Reference Oscillator" dialog, set the "REF/LO Out > REF".

The "Output Frequency" can be configured to either 10 MHz or 1 GHz.

The instrument uses the internal reference signal. The REF EXT LED at the front
panel of the instrument is off.

To output the reference frequency (internal or external) at the REF/LO OUT connector
of the instrument, select "SGMA-GUI > Instrument Name > Reference Oscillator > REF/
LO Output > REF".

Using an external reference frequency source

To improve measurement accuracy, it is advisable to provide an external reference fre-
quency to all of the instruments in the test setup or to distribute the internal reference
signal of the signal generator to the remain instruments.

1. Provide the signal of an external reference frequency source to the REF/LO IN con-
nector of the instrument.

2. To enable the instrument to use the external reference frequency source, perform
one of the following:

a) Select "SGMA-GUI main panel > REF > EXT".
b) Select "SGMA-GUI > Instrument Name > Reference Oscillator > Source > Ext".

3. In the "Reference Oscillator" dialog, set the parameter "Ext. Ref. Input Frequency" to
the value of the fed external reference frequency.

Now, the instrument uses an external reference signal. The green REF EXT LED at
the front panel of the instrument indicates that the instrument is synchronized to the
external clock.

If the instrument is configured to use an external reference signal but no signal is fed in
at the REF/LO IN connector, the REF EXT LED on the front panel of the instrument is
red and an error message is displayed in the "Info" line.

2.2.1.4 Configuring the Local Oscillator (LO) Coupling Source

The R&S SGS can use two frequency sources for the carrier frequency (LO Signal) of
the I/Q modulator, an internal and an external one. The first possibility is to use the output
signal of the internal synthesizer. If an external LO signal is provided at the REF/LO IN
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connector, this signal can alternatively be directly routed to the LO input of the I/Q mod-
ulator.

Using an external LO source

1. Provide the signal of an external LO source to the REF/LO IN connector of the instru-
ment.

Note: The Local Oscillator input/output requires the additional software option
R&S SGS-K90.

2. Select "SGMA-GUI > Instrument Name > Frequency/Phase > LO Coupling Source >
Ext".

The signal provided by the external frequency source is directly routed to the input
of the I/Q modulator and used as carrier frequency.

Using an internal LO source

► Select "SGMA-GUI > Instrument Name > Frequency/Phase > LO Coupling Source >
Int".

The output signal of the internal synthesizer is used.

2.2.1.5 Defining the Signal at the REF/LO OUT Connector

The Ref. Oscillator and the LO use the same REF/LO IN connector. Hence, it is not
possible to use both, an external reference source and an external LO source signal at
the same time.

The signal at the REF/LO OUT connector also depends on the selected Reference Oscil-
lator and LO sources. The following table gives an overview of this dependency.

Table 2-2: Selection available at the REF/LO OUT connector depending on the LO and Reference Oscil-
lator Sources

 LO Coupling Source  

Ref. Oscillator Source Int Ext

Int "OFF/REF/LO" "OFF/LO"

Ext "OFF/REF/LO" Combination not possible

1. In the "Frequency / Phase > Local Oscillator (LO) Coupling" dialog, select the "LO
Source" as required.

2. In the "SGMA-GUI > Instrument Name > Reference Oscillator" dialog, select the "Ref.
Oscillator Source" as required.

3. In the "Frequency / Phase > Local Oscillator (LO) Coupling" dialog, set the REF/LO
Output.
Consider the dependencies, see ​table 2-2.
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2.2.1.6 Connecting and Configuring Instruments for Optimum Phase Coherence

Using the LO input/output connectors, two or more instruments can be coupled to achieve
optimum phase coherence between the RF output signals. The first instrument in the
chain delivers the LO signal at the REF/LO OUT connector to the REF/LO IN connector
of second instrument. If required, more instruments can be connected in the same way.
The first instrument is set such that the internal synthesizer generates the system LO
frequency. In all following instruments, the internal synthesizer is switched off and the LO
signal from the REF/LO IN connector drives the I/Q modulator or the CW path.

Connecting the instruments

1. Connect the instruments as a daisy chain (see figure below), i.e. connect the REF/
LO IN connector of each further instrument to the REF/LO OUT connector of the
previous one.

2. Optionally, provide an external reference signal for the first instrument.

3. Avoid unnecessary cable lengths and branching points.

The following figure shows an example of how to connect two instruments for achieving
phase coherence. The configuration can be extended by further instruments.

Fig. 2-4: Example of setup: LO Coupling

Configuring the first instrument in the chain

1. In the "Frequency / Phase > Local Oscillator (LO) Coupling" dialog, select "LO Source
> Internal".

2. In the "Frequency / Phase > Local Oscillator (LO) Coupling" dialog, select "REF/LO
Output > LO".

3. If an external reference frequency is used, select "SGMA-GUI > Instrument Name >
Reference Oscillator > Source > External".

Configuring the following instrument(s)

1. In the "Frequency / Phase > Local Oscillator (LO) Coupling" dialog, select "LO Source
> External".

2. In the "Frequency / Phase > Local Oscillator (LO) Coupling" dialog, select "REF/LO
Output > LO".

 

Introduction to the Instrument Functions



System OverviewR&S®SGS100A

21User Manual 1173.9105.02 ─ 05

2.2.2 Advanced Configuration Tasks

This section provides instructions on advanced tasks, e.g. on how to change the instru-
ment's operation mode, to configure the instrument to optimize performance, to install a
new firmware version, etc.

2.2.2.1 Restoring the LAN Connection to an Instrument

► If the LAN connection to an instrument configured to use a static IP address is lost,
press the LAN LED on the instrument's front panel to reset the LAN settings und to
set the ​"Address Mode" on page 66 to DHCP.

Provided the network supports automatic assignment of IP address, new IP address
will be automatically assigned to the instrument.

2.2.2.2 Using Computer Names

Provided that there is a name server in the network, alternatively to the IP address each
PC or instrument connected in a LAN can be accessed via an unambiguous computer
name. Each instrument is delivered with an assigned computer name, but this name can
be changed.

For instruction on how to find out the default computer name, refer to ​chapter 3.4.3,
"Finding Out the Default Hostname of the Instrument", on page 38.

Querying and changing a computer name

To avoid violations and to make use of the easy identification provided by the computer
name, it is recommended to keep the default hostname unchanged.

1. Open "SGMA-GUI > Instrument Name > Setup > Network Settings" dialog.

The computer name is displayed under "Hostname".

2. Select "SGMA-GUI > Instrument Name > Setup > Protection" and enable the "Pro-
tection Level 1".

The parameter "Hostname" in the "Network Settings" dialog is now enabled for con-
figuration.

3. Change the "Hostname".

4. Press the POWER ON/STAND BY key to restart the instrument.

Note: The "Factory Preset" function restores the factory value of the parameter
"Hostname"!
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2.2.2.3 Reserving an Instrument

Reserving the instrument for control from R&S SGMA-GUI

1. Open the "SGMA-GUI > Setup > Instruments > Configure Instruments" dialog, select
the instrument in the list of "Available Instruments" and select "Edit".

2. In the "Edit Instrument" dialog, enable "Exclusive Access".

3. Alternatively, send the SCPI command ​: ​INSTruments: ​EACCess[: ​STATe] ​ from
the external PC the R&S SGMA-GUI is installed on.

The instrument is reserved for control from this external PC and cannot be accessed
from any other controller. A scan function started from another controller will find the
instrument but the instrument is indicated as locked.

The two functions "Exclusive Access" and monitoring are mutually exclusive!
The "Exclusive Access" must be disabled to remote control or monitor the instrument
form another external PC (see ​chapter 6.4, "Using the R&S SGMA-GUI to Monitor the
Remote Control Operation", on page 84).

Locking the instrument to a controller

1. From the controller, send the SCPI command ​: ​LOCK ​, e.g. :LOCK? 72349234

2. Query whether the request is granted and the instrument is locked.

The response of the query :LOCK? has to be 1.

3. Abort further remote control if the request is refused.

2.2.2.4 Working in Baseband Bypass Mode

1. Provide an external analog signal at the I or Q connectors or on both at the rear of
the instrument.
Refer to ​figure 2-2 for visualization of the signal flow.

2. Select "SGMA-GUI > Instrument Name > Operation Mode > Baseband Bypass".

Some instrument's functions like Frequency and I/Q settings are disabled.

3. Select "SGMA-GUI > Instrument Name > Level" and adjust the level of the output
signal.

4. For the corresponding instrument, set "SGMA-GUI > RF > On" or press the RF ON
key on the front panel of the instrument to enable the output of the generated signal
at the RF connector.
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The RF ON key is green.

The fed signal is amplified with the selected value and output at the RF connector of
the instrument.

2.2.2.5 Optimizing Performance

In its (factory) preset state, the instrument uses predefined frequency and level setting
designed for best performance. The predefined settings, e.g. the Level modes "Auto" and
"Normal" or the use of calibrated value of the internal reference signal, ensure that the
instrument automatically selects the optimal settings depending on the configured RF
frequency and level.

However, in some special application cases it might be necessary to choose different
settings or to optimize the signal for the particular application. This section describes
instructions on how to achieve this.

Restoring the default settings
Use the "R&S SGMA-GUI main panel > Instrument name > Preset" or the "R&S SGMA-
GUI main panel > Instrument name > Setup > Factory Preset" function to return the
instrument to its predefined state.

For information on how to adjust the quality characteristics of the RF output signal, i.e.
to optimize the quality characteristics of RF output signal, like improving the harmonic
distortion or improving the wideband noise, refer to ​chapter 4.5, "Level and Power-On
Settings", on page 48.

For information on how to adjust the reference oscillator, e.g. to allow the frequency of
the internal reference oscillator to be impaired for example to simulate a frequency error
or to adjust the bandwidth of an external reference oscillator, refer to ​chapter 4.4, "Ref-
erence Oscillator", on page 45.

2.2.2.6 Installing new Firmware Version on the Instrument

If an update to a new firmware version is required for both the R&S SGMA-GUI and the
instrument, it is mandatory that the new instrument's firmware is installed prior to the
update of the R&S SGMA-GUI to the new version.

1. Select "SGMA-GUI main panel > Instrument Name > Setup > Maintenance > Oper-
ation > Install firmware package".

2. Press "Select Package" and navigate to the directory the new firmware is stored in.

3. If several SGS instruments have to be updated to new firmware version, enable the
feature "Update All SGSs" to accelerates the update process.

All SGS instruments that are in active state and are connected to this controller are
updated simultaneous.
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4. Enter the "Security Password".

5. Confirm the update with "Accept".

The software transfers the firmware file and automatically starts the update proce-
dure. During the update, the message "Updating Firmware" is displayed in the Info
line. The update process indicated by an LED running light.

Note: The update procedure requires a restart of the instrument. The restart is per-
formed automatically. The instrument is not accessible during that time.

6. Wait until the message "Updating Firmware" disappears and the update is completed.

The green POWER ON/STANDBY LED is on.

Tip: Calibration Error. If the Info line shows the message "Calibration Error", select
"SGMA-GUI main panel > Instrument Name > Setup > Internal Adjustments > Adjust
All" to trigger internal adjustment.

7. If required, install the new R&S SGMA-GUI.
For detailed description, refer to the Getting Started manual, section "Installing the
R&S SGMA-GUI Software on the External PC".

8. If the instrument and the conroller/PC are connected over the PCIe interface and the
external PC does not support hot-plugging, it is required to restart the external PC.

Unsuccessful or Erroneous Firmware Update
An erroneous or unsuccessful installation of firmware update package is indicated by a
combination of red and one orange LEDs on the front panel.
Refer to the Service Manual for description of the displayed error code or contact the
customer support center. The description and the official company contact addresses are
provided on the CD included in the delivery .

2.2.2.7 Activating Options

A firmware update prior to the activation of the SW option may be required.
Refer to the description of the SW option for the required firmware version!
See also ​chapter 2.2.2.6, "Installing new Firmware Version on the Instru-
ment", on page 23 for instruction on how to update the firmware version.

1. Select "SGMA-GUI main panel > Instrument Name > Setup > Install SW-Options".

2. Select "Option Key" and enter the key code delivered with the new option.

The new option is now enabled and ready for operation.
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3 Understanding the R&S SGMA-GUI Software
This section gives a detailed description of the R&S SGMA-GUI user interface and infor-
mation on how to work with it. The main panel with the overview of the configured instru-
ments is the operating and control interface for the whole program. From here, all program
functions are accessible. This panel is displayed after the start of R&S SGMA-GUI. The
program always loads the previously used settings so you can continue your work in the
next session.

3.1 Operating Menu and Toolbar

On the top of the main panel, there are the menu bar, the tool bar and the info bar with
the corresponding "Info" button. Some of the functions are accessible via the toolbar with
its icons below the menu selection line.

The dialogs are built using elements, e.g., selection lists, check boxes, and entry fields.
A blue frame indicates that the selected item is active. In a highlighted element, entries
can be made.

Table 3-1: Content of the operating menu

File Setup Help

 ​New ​Instruments About

 ​Open ​Software Contents

​Save ​Reset SGMA-GUI Index

 ​Save as   

​Exit   

​Shut down instruments and exit   

3.1.1 File Menu

The R&S SGMA-GUI employs the standard Save/Recall file management function and
allows you to store and reload settings in/to a file with a user-defined name and location
(see also ​chapter 3.4.1, "Storing and Loading Settings", on page 36).

 

 

 

Operating Menu and Toolbar



Understanding the R&S SGMA-GUI SoftwareR&S®SGS100A

26User Manual 1173.9105.02 ─ 05

In the following, the "File" menu of the R&S SGMA-GUI is described in detail. It incorpo-
rates standard functions.

New
Resets R&S SGMA-GUI and all connected instruments to their preset settings.

Open
Opens the standard file open browser for loading a saved R&S SGMA-GUI file
(*.savrcl). The file contains the user specific settings of a session, such as instruments
configured in the software, etc. The complete settings of a session can be saved and
loaded.

Only files of this type are selectable.

Note: Instrument specific settings, e.g. frequency and level settings, are stored locally
on the particular instrument itself. These instruments settings are saved automatically in
a predefined directory and loaded by default when starting the instrument again.
The files with instrument settings are not accessible.

Save
Standard quick save of the settings of the current session if a file name previously has
been applied. If not, the "Save As" dialog is opened.

Save as
Opens the standard file save browser for saving the settings of the current session.
R&S SGMA-GUI files have the file extension .savrcl so the name typed in is equipped
with this extension. The complete settings of a session are saved.

Exit
Quits the R&S SGMA-GUI. The current settings of the instrument's session are saved
and loaded by default when starting the software again.

Note: The instruments configured in the R&S SGMA-GUI are not shut down.

Shut down instruments and exit
Quits the R&S SGMA-GUI and switches the connected instruments to the standby state
(see also ​chapter 2.2.1.2, "Switching Between the Operating States", on page 16).

3.1.2 Setup Menu

The setup menu provides an access to dialogs for setting the general settings of the
software, like dialogs for managing the connected instruments or dialogs providing infor-
mation about the installed options.
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3.1.2.1 Configure Instruments

This dialog is the central point for managing the instrument that will be configured and
operated via the R&S SGMA-GUI. New instruments can be created and appended to the
list of available instruments, connection settings can be edited, instruments can be
removed from the list or they can be deactivated, but kept in the list for further use.

Refer to ​chapter 3.4.2, "Handling Instruments in the R&S SGMA-GUI", on page 37 for
information on how to configure and manage instruments in R&S SGMA-GUI.

Available Instruments
This section comprises a list of configured instruments. Each instrument is represented
by a "Symbolic Name" which is also displayed in the main panel and an "Instrument
Type". Also, it is displayed whether the instrument is activated in the R&S SGMA-GUI
and hence displayed in the main panel or not.

SCPI command: 
​: ​INSTruments: ​COUNt ​ on page 140

New Instrument
Calls the ​Add/Edit Instruments dialog.

Delete Instrument
Removes the selected instrument from the list of ​Available Instruments.

Edit Instrument
Calls the ​Add/Edit Instruments dialog.
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Scan
Triggers a scan function and searches for instruments connected to the remote computer
via all of the available interfaces. During the scan process a progress bar is displayed.

Tip: The first initialization of a newly connected instrument in a network and the instru-
ment's request to the DHCP server for an IP address may take some time. During this
time, the instrument does not respond to the query sent by the scan function. If the
instrument does not appear in the list of "Available Instruments", trigger the scan function
again after some minutes.

SCPI command: 
​: ​INSTruments: ​SCAN ​ on page 141

Export
Opens the standard file save browser for saving the list of the available instruments in a
mapping file. The mapping files have the file extension .map so the file name typed in is
automatically equipped with this extension.

A mapping file provides a cross-reference between the instruments' symbolic names and
their respective remote control parameters. The information in the mapping file is grouped
in rows, where one row corresponds to one configured instrument. The rows have the
following structure:
<InstrumentType> <SymbolicName> <IP_Address/Hostname>
<RemoteChannel> <SerialNumber>

Fig. 3-1: Mapping file example

Tip: In a remote control application program, address the instruments by their symbolic
names and retrieve the remain required settings from the mapping file. This workflow is
especially useful by frequent exchange of instruments.

SCPI command: 
​: ​INSTruments: ​MAPPing: ​FILE ​ on page 140

Scan LAN instruments with host name prefix
Sets the prefix the searched host names begin with. Use this function to limit the amount
of the searched instruments and to speed up the scan process.

SCPI command: 
​: ​INSTruments: ​SCAN: ​HNPRefix ​ on page 141

3.1.2.2 Add/Edit Instruments

The dialog provides an access to the main instrument's settings, such as "Symbolic
Name", "Instrument Type" and connection settings.
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Refer to ​chapter 3.4.2, "Handling Instruments in the R&S SGMA-GUI", on page 37 for
information on how to configure and manage instruments in R&S SGMA-GUI.

Instrument Nr.
Automatically assigned number that indicates the instrument's index in the list of "Avail-
able Instruments".

Symbolic Name
Selects the alias name of the instrument.

SCPI command: 
​: ​INSTruments: ​NAME ​ on page 140

Instrument Type
Selects the instrument's family. Currently only type SGS is available.

SCPI command: 
​: ​INSTruments: ​TYPE ​ on page 142

Active
Activates/deactivates the display of the instrument's settings in the main panel.

Note: Only instruments in an active state can be controlled from the R&S SGMA-GUI!

SCPI command: 
​: ​INSTruments: ​ACTive[: ​STATe] ​ on page 139

Exclusive Access
"Locks" the instrument, i.e. the instrument is reserved and can be operated manually or
remote exclusively from the remote PC on which the R&S SGMA-GUI is running or from
which the SCPI command is sent.

For interfaces using VISA, i.e. for LAN and USB, enabling the "Exclusive Access" triggers
the standard viLock request. For remote control over PCIe or Socket the lock request
is performed on a higher application level.

Operating Menu and Toolbar
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Note: It is recommended to lock the instrument prior to further configuration.
Locked instruments will not be found by the scan function.
The instrument has to be unlocked to allow operation from another remote PC.

See also ​chapter 2.2.2.3, "Reserving an Instrument", on page 22.

Note: The two functions "Exclusive Access" and monitoring are mutually exclusive!
Disable "Exclusive Access" if the instrument is monitored by an external PC.

SCPI command: 
​: ​INSTruments: ​EACCess[: ​STATe] ​ on page 140
​: ​LOCK ​ on page 100
​: ​UNLock ​ on page 100

Device Identity
Trigger the device identification function. The LAN LED on the front panel of the selected
instrument blinks.

See also ​chapter 3.4.4, "Bidirectional Instrument Identification in the Net-
work", on page 39.

Hardware Channel
Selects the hardware interface used by the remote channel.

SCPI command: 
​: ​INSTruments: ​REMote: ​CHANnel ​ on page 141

Instrument Name / IP Address
Enters the IP Address or the host name of the connected instrument.

See also ​chapter 3.4.3, "Finding Out the Default Hostname of the Instru-
ment", on page 38.

SCPI command: 
​: ​INSTruments: ​REMote: ​NAME ​ on page 141

Serial Number
Enters the serial number as instrument's identification while using the USB or PCIe inter-
faces for remote control.

SCPI command: 
​: ​INSTruments: ​SERial ​ on page 141

OK
Confirms the settings and closes the dialog.

Apply
Confirms the settings.

Cancel
Discards settings and closes the dialog.

Operating Menu and Toolbar
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3.1.2.3 Software/Options Dialog

Querying information about the installed options and software version

► To access the dialog, select "Setup > Software".

An info dialog opens, showing program information.

Firmware
In the group box "Firmware", the following columns are displayed:

"Package" Installed software packages, e.g. SW platform.

"Version" Release of the software package.

Loaded Modules
The group box "Loaded Modules" provides information on the loaded modules.

Note: Click on a row to get detailed information for the selected loaded module.

"Path" Path to the file location.

"Module" A module file.

"Version" Version of a file.

"Description" Description of the module file.

3.1.2.4 Reset SGMA-GUI

Resets R&S SGMA-GUI to its factory preset settings.

The connected instruments are not affected by this preset!
To preset one specific instrument to its factory preset settings, select "SGMA-GUI >
Instrument Name > Setup > Factory Preset". Refer to ​chapter 5.10, "Factory Pre-
set", on page 68 for an overview of the settings affected by this function.

3.1.3 Help

The R&S SGMA-GUI is equipped with a context-sensitive help function. A help page can
be called any time during software operation.

The context-sensitive page which is opened with the F1 button is part of a comprehensive
help system.
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It is possible to move from this context-sensitive page to any page of the help system.
An overview of the contents of the online help can be reached via the menu "SGMA-GUI
> Help > Contents".

A search for keywords within the help function is available via menu item "SGMA-GUI >
Help > Index".

3.2 Info Dialog and Messages in the Info Bar

A few operating states and the current messages are displayed in the info line. For infor-
mation on messages in greater detail and their management, an "Info" dialog can be
opened.

3.2.1 Info Dialog

The "Info" dialog provides a list of currently active permanent messages and a detailed
description of each message. The messages are color-coded according to their level.

Accessing the Info Dialog

► In the "R&S SGMA-GUI main panel", select the "Info" button.

The "Info" dialog opens.

The upper part of the "Info" dialog lists the currently active permanent messages. See
the following table for explanation of the displayed information.
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Parameter Description

"LEV" Message level. Messages referring to a logical component of R&S SGMA-GUI, e.g., Uni-
code, are marked in red color, info messages are marked in black color.
The following levels might occur:
● Err: Error message
● Info: Information message
● Sys: System message
● Crit: Critical message

For detailed information on the message types, see ​chapter 3.2.2, "Understanding the
Messages in the Info Bar", on page 33.

"SCPI" Indicates the SCPI error code.

Text A list of all currently permanent messages in the order of their occurrence, i.e., the most
recent message is displayed first.

The buttons in the lower part of the "Info" dialog provide quick access to some functions
for managing these messages. For a detailed description on how to clear error messages
or display a history of all messages, refer to ​chapter 3.4.5, "Managing Messages in the
Info Dialog", on page 41.

Function Description

"Delete" Clears the highlighted message. This button is available only if the history of the
messages is displayed.

"Delete All" Clears all messages.

This button is available only if the history of the messages is displayed.

"Del. volatile" Clears all brief messages. This button is available only if the history of the messages
is displayed.

"History" Calls the list of all messages that have occurred since instrument switch-on. The
most recent messages are displayed at the top of the list. When the button is pressed
again, the list of current messages is displayed.

Refer to ​chapter 3.4.5, "Managing Messages in the Info Dialog", on page 41 for infor-
mation on how to manage messages.

3.2.2 Understanding the Messages in the Info Bar

Messages indicate information, warnings, and errors. They are displayed in the info line
in different colors depending on their importance and display duration. The following
messages are displayed:
● Error

There are two options:
– Critical errors are errors that prevent the instrument from working, e.g. a HW

failure. Critical errors are displayed in red color.
– System errors are errors that concern the operating system, e.g., wrong file path.

System errors are displayed in black color.
● Information
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The information, e.g., file not found, is displayed in black color.
● Warning

A warning indicates a less significant error and is displayed in black color.
● Brief message

Brief messages report automatic settings in the program, e.g. switching on illegal
entries that are not accepted by the program, e.g., range violations. They are dis-
played in the info line on a yellow background. They are displayed on top of status
information or permanent messages.
Brief messages usually do not demand user actions and disappear automatically after
a short period of time. They are stored in the history, however.

● Permanent messages
Permanent messages are displayed if an error occurs that impairs further program
operation. The error signaled by a permanent message must be eliminated before
correct software operation can be ensured.
The message is displayed until the error is eliminated. It covers the status display in
the info line. After error elimination, the message automatically disappears and is also
recorded in the history.

3.3 Main Panel

The main panel of the R&S SGMA-GUI provides quick access to the main settings of the
configured instruments. The display shows one row per instrument and comprises the
instrument name and state, the used frequency and power level, the states of the RF
output and modulator and the used reference source.

Click on one of the buttons with an instrument name on it to access the menu tree with
further settings for the corresponding instrument. For a detailed description about the
provided settings, refer to ​chapter 4, "Signal Generator Settings", on page 42.

Instrument/Connection State
The three colors of the state indicator in front of the Instrument Name distinguish between
the following states:
● grey: the instrument is configured and activated in the R&S SGMA-GUI but there is

no connection to the instrument.
● green: the instrument is active, the connection is working and the instrument can be

manually and remotely operated.
● red: the instrument is in one of the following states:

– Standby state
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To operate the instrument manually, it has to be switched to ready state (see ​
"Returning the Instrument from Standby to Ready State" on page 17).

– Instrument locked
The red state indication together with the message "Instrument Locked" in the
"Info" line indicates that the instrument is locked for ​Exclusive Access from
another SGMA-GUI or controller.

– The instrument is performing a time consuming operation, e.g. an internal adjust-
ment or selftest.

Instrument Name
Displays the alias name of the instrument, as selected by the parameter "SGMA-GUI >
Setup > Instruments > Add/Edit Instruments > Symbolic Name".

A click on this button provides access to a menu tree for configuring the available instru-
ment's settings, e.g. "Frequency / Phase" settings.

Frequency
Sets the RF frequency at the RF output connector of the selected instrument.

SCPI command: 
​[: ​SOURce: ​]FREQuency[: ​CW|FIXed] ​ on page 115

RF ON/OFF
Activates and deactivates the RF output signal.

The current state of the RF output (activated and deactivated) is indicated in the main
panel by means of the different block color (blue or grey) and the status "On/Off".

SCPI command: 
​: ​OUTPut[: ​STATe] ​ on page 115

Mod State
Switches the I/Q modulation on and off.

SCPI command: 
​[: ​SOURce: ​]IQ: ​STATe ​ on page 116

PEP
Displays the Peak Envelope Power (PEP) of the RF signal of the selected instrument.
The value is calculated as follow:

Main Panel
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"PEP" = ​Level + ​Crest Factor

SCPI command: 
​[: ​SOURce: ​]POWer: ​PEP ​ on page 120

Level
Sets the RF level at the RF output connector of the selected instrument.

SCPI command: 
​[: ​SOURce: ​]POWer[: ​LEVel][: ​IMMediate][: ​AMPLitude] ​ on page 119

REF/Ref. Oscillator Source
Determines whether the internal built-in oscillator (TXCO or OXCO) is used as a reference
source or if an external reference is used. The internal reference oscillator OCXO requires
the additional option R&S SGS-B1.

To feed in an external instrument reference, use the input connector REF/LO IN. To
output the reference frequency at the output REF/LO OUT, select "SGMA-GUI > Instru-
ment Name > Ref. Oscillator > REF/LO Output > REF".

See also ​chapter 2.2.1.3, "Configuring the Reference Oscillator Source", on page 18.

"Int" The internal reference signal of 10 MHz is used.

"Ext" An external reference signal is used. The frequency of the external ref-
erence signal must be selected with the parameter "SGMA-GUI >
Instrument Name > Ref. Oscillator > Ex. Ref. Input Frequency".

SCPI command: 
​[: ​SOURce: ​]ROSCillator: ​SOURce ​ on page 121

3.4 Working with R&S SGMA-GUI

3.4.1 Storing and Loading Settings

In order to proceed work with a particular configuration of the instruments in the R&S
SGMA-GUI, it is useful to save the used settings and load them again later.

1. Select "SGMA-GUI main panel > File > Save As".

2. Navigate to the desired directory and enter the file name.
The extension *.savrcl is applied automatically.

The current settings of the software are saved to the selected file.

3. To load settings from a file, select "SGMA-GUI main panel > File > Open"

4. Navigate to the directory the file is stored in and select the setting file.

The saved settings are loaded to the R&S SGMA-GUI and the main panel of the
software displays the saved instrument's configuration.
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3.4.2 Handling Instruments in the R&S SGMA-GUI

This section provides information on how to configure and manage instruments in the
R&S SGMA-GUI. For reference information about all provided settings in the user inter-
face, refer to the corresponding sections.

● ​chapter 3.1.2.1, "Configure Instruments", on page 27 and ​chapter 3.1.2.2, "Add/Edit
Instruments", on page 28

● ​chapter 3.1.2.3, "Software/Options Dialog", on page 31
​chapter 3.1.2.4, "Reset SGMA-GUI", on page 31

3.4.2.1 Scanning for New Instruments

1. In the R&S SGMA-GUI main panel, select "Setup > Instruments".

The ​Configure Instruments dialog opens.

2. Click the "Scan" button to trigger the instrument to scan all remote channel interfaces
for connected instruments.

Tip: To limit the amount of the searched instruments and to speed up the scan proc-
ess, select "Configure Instruments > Scan LAN instruments with hostname prefix"
and enter the prefix the searched hostnames begin with.
The scan function searches only for instruments whose hostnames begin with the
selected prefix.

All instruments which are connected to one of the available interfaces, are switched
on and are not locked are displayed in the"Available Instruments" list.
The R&S SGMA-GUI obtains all information for connecting to the instrument, so fur-
ther configuration is not necessary.

3.4.2.2 Activating Instruments for Control from the R&S SGMA-GUI

1. In the R&S SGMA-GUI main panel, select "Setup > Instruments".

The "Available Instruments" in the ​Configure Instruments dialog lists all instruments
configured in the software.

2. Select the newly configured/connected or deactivated instrument and set "Active" to
On to activate it.

Tip: Only active instruments are displayed in the R&S SGMA-GUI main panel!

3.4.2.3 Adding New Instruments Manually to the R&S SGMA-GUI

1. In the R&S SGMA-GUI main panel, select "Setup > Instruments".

The ​Configure Instruments dialog opens.

2. Select the "New" button.
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The ​Add Instrument dialog opens to register a new instrument.

3. In the "Symbolic Name" field, enter an alias name of your choice, e.g. SGS-100021.

4. Select "Remote Control > Hardware Channel" and select the hardware interface.

5. For LAN or Socket interfaces, select "Remote Control > Instrument Name / IP
Address" and enter the IP Address or the hostname of the connected instrument, e.g.
rssgs100a100021.

Tip: See also ​chapter 3.4.3, "Finding Out the Default Hostname of the Instru-
ment", on page 38 .

6. For USB or PCIe interfaces, select "Remote Control > Serial Number" and enter the
serial number of the connected instrument, e.g. 100021.

7. Set "Active > On" to activate the instrument. Only active instruments are displayed in
the R&S SGMA-GUI main panel.

8. Click "OK" to confirm the settings and to close the dialog or press the "Apply" button
to confirm the settings.

9. Click the "Cancel" button to discard settings and to close the dialog.

3.4.2.4 Editing Instruments

1. In the R&S SGMA-GUI main panel, select "Setup > Instruments".

The ​Configure Instruments dialog opens and lists the "Available Instruments".

2. Select the instrument to be edited and click the "Edit" button.

The ​Edit Instrument dialog opens.

3. Change the settings and confirm with OK.

The edited settings are applied.

3.4.2.5 Deleting Instruments

1. In the R&S SGMA-GUI main panel, select "Setup > Instruments".
The ​Configure Instruments dialog opens.

2. Select the instrument to be deleted and click the "Delete" button.

The selected instrument is deleted from the list of "Available Instruments".

3.4.3 Finding Out the Default Hostname of the Instrument

The default hostname of the instrument is a non case sensitive string built as follow:

hostname = <instrument name><serial number>, where
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<serial number> is the individual serial number of the instrument

<instrument name> is the complete name of the instrument, written without spaces,
e.g. rssgs100a.

1. Find the individual serial number on rear of the instrument, e.g. 100021.

2. Build the default hostname.

For the R&S SGS100A with serial number 100021, the default hostname is
rssgs100a100021.

For instructions on how to change the default computer name, refer to ​"Querying and
changing a computer name" on page 21.

3.4.4 Bidirectional Instrument Identification in the Network

In practice, instruments are integrated into a large network or placed in racks together
with several other instruments of the same kind. It might be difficult then to find out which
of the instruments configured in the R&S SGMA-GUI corresponds to which physical
instrument or to localize all instruments operated by the current controller.

The R&S SGMA-GUI and the instrument provide the "Device Identification" function for
this purpose.

Finding an instrument in the R&S SGMA-GUI

► If several instruments have been configured and activated in the R&S SGMA-GUI,
press the ID button on the instrument's front panel to trigger device identification.

The "Edit Instrument" dialog of this instrument opens.

Field "Edit Instrument > Symbolic Name" displays the name of the instrument as
shown in the R&S SGMA-GUI main panel.
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Dialog "Edit Instrument" does not appear
If this dialog does not open, perform the following:
● Check whether the instrument is correctly connected to the external PC on which you

work with the R&S SGMA-GUI.
● Check if the instrument is configured in the R&S SGMA-GUI and perform, if neces-

sary, the steps described in ​chapter 3.4.2, "Handling Instruments in the R&S SGMA-
GUI", on page 37.

● Select "SGMA-GUI > Setup > Instruments", check the state of the instrument in the
"Configure Instruments > Available Instruments" table and activate it, if disabled.

Identifying an instrument in an instrument set

► To identify the instrument in an instrument set, use one of the device identification
functions:

a) select "SGMA-GUI > Setup > Instruments > Available Instruments > Instrument
> Edit > Edit Instrument" and trigger "Device Identify"

b) select "SGMA-GUI > Instrument Name > Setup > Remote > Remote Channels"
and trigger "Device Identify"

The green LAN LED on the front panel of the instrument blinks.

Working with R&S SGMA-GUI
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3.4.5 Managing Messages in the Info Dialog

Getting Additional Information on the Message

► In the "Info" dialog, click a message to select it.

In the lower section of the dialog, additional information on the highlighted message
is displayed.

Displaying all Messages

► In the "Info" dialog, click the "History" button.

A history of all messages that have occurred since the R&S SGMA-GUI software was
started is listed in the upper dialog pane. The most recent message is displayed first.

Deleting an Error Message

► In the "Info" dialog, select the highlighted message and click the "Delete" button.

Tip: This button is available only when the history of the messages is displayed.

The highlighted message is cleared.

Deleting all Error Messages

► In the "Info" dialog, click the "Delete All" button.

Tip: This button is available only when the history of the messages is displayed.

All messages are cleared.

Deleting all Brief Messages

► In the "Info" dialog, click the "Del. volatile" button.

Tip: This button is available only when the history of the messages is displayed.

All brief messages are cleared.

Calling the History

1. In the "Info" dialog, click the "History" button.

A list of all messages that have occurred since the instrument switch-on is displayed.
The most recent messages are displayed at the top of the list.

2. Click the "History" button once more.
A list of current messages is displayed.
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4 Signal Generator Settings
This section summarizes the settings necessary to configure the instrument for signal
generation. The description in this section follows the menu tree structure of the graphical
user interface. Each of the discussed topis follows a common structure, providing basic
background information, step-by-step instruction for fulfilling typical tasks and reference
to the user interface.

Additionally, there is a section summarizing advanced configuration tasks.

4.1 Operation Mode

The R&S SGS can be operated in two modes, normal mode and baseband bypass mode.
In baseband bypass mode, an external IF signal fed in at the I or Q connectors is directly
routed to the RF OUT connector. The level of the signal can be adjusted.

Refer to ​figure 2-2 for visualization of the signal flow.

► To access the "Operation Mode" dialog, select "SGMA-GUI > Instrument Name >
Operation Mode".

Operation Mode
Sets the operation mode.

"Normal" The complete signal processing chain is used.

"Baseband
Bypass"

The IF signal fed in at the I or Q connectors is directly routed to the RF
OUT connector.

Note: The "Baseband Bypass" is a special operation mode. See also ​
chapter 2.2.2.4, "Working in Baseband Bypass Mode", on page 22.

SCPI command: 
​[: ​SOURce: ​]OPMode ​ on page 115

4.2 Frequency/Phase Settings

Depending on the installed options, the instrument provides an adjustable output fre-
quency in the frequency range of 1 MHz to 6 GHz or to 12.75 GHz.

The frequency and phase related settings are provided in the "Frequency/Phase" dialog.

► To access this dialog, select "SGMA-GUI > Instrument Name > Frequency/Phase".
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Configuring the RF Frequency

► To change the RF frequency of the selected instrument, perform one of the following:

a) Select "SGMA-GUI main panel > Freq" and enter the desired frequency.
b) Select "SGMA-GUI > Instrument Name > Frequency/Phase > Frequency" and

enter the desired frequency.

Changes of the RF frequency have an immediate effect on the output signal.

Frequency
Sets the RF frequency at the RF output connector of the selected instrument.

SCPI command: 
​[: ​SOURce: ​]FREQuency[: ​CW|FIXed] ​ on page 115

Delta Phase
Sets the phase of the RF signal. The current phase of the signal is used as the reference.
This function allows, for example, the phase of the output signal to be synchronized with
the phase of a signal from a second signal generator.

SCPI command: 
​[: ​SOURce: ​]PHASe ​ on page 118

Reset Delta Phase Display
Resets delta phase value. The set phase is adopted as the new current phase, i.e. the
delta phase value is reset to 0.

SCPI command: 
​[: ​SOURce: ​]PHASe: ​REFerence ​ on page 118

4.3 Local Oscillator (LO) Coupling

The LO Coupling function allows a distribution of the local oscillator signal in a way that
multiple R&S SGSs or other R&S Signal Generators can be driven by the same LO signal.
This is mandatory for phase coherent application, e.g. MIMO setups, and for phase
coherent demodulation.
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The LO Coupling function is available only for instruments equipped with the option
R&S SGS-K90 (Phase Coherence). This option enables phase coherent RF outputs of
two or more RF signals. The local oscillator signal is provided at the REF/LO OUT con-
nector. An external signal can be input at the REF/LO IN connector.
Refer to ​figure 2-2 for visualization of the signal flow.

See also
● ​chapter 2.2.1.4, "Configuring the Local Oscillator (LO) Coupling

Source", on page 18
● ​chapter 2.2.1.5, "Defining the Signal at the REF/LO OUT Connector", on page 19
● ​chapter 2.2.1.6, "Connecting and Configuring Instruments for Optimum Phase Coher-

ence", on page 20

4.3.1 Phase Coherence

Phase coherence of two RF signals means that there is a defined and stable phase rela-
tionship between two (or more) RF carriers, i.e. there is a fixed delta phase ΔΦ between
the carriers. Strictly speaking, phase coherence is only defined for CW carriers with the
same frequency (or for CW carriers at frequencies that are multiples of each other).

If two signal generators are coupled via their 10 MHz reference, they are generating
exactly the same frequency but only from the long term perspective. Having a closer look
into the instantaneous differential phase (“delta phase”) of these two RF signals, this is
quite instable due to:
● phase noise of the two synthesizers
● “weak” coupling at 10 MHz and a long synthesis chain up to the RF domain
● temperature differences which cause slightly different phase drifts for the different

synthesizers

Most critical for a stable delta phase is the thermal RF phase drift between multiple RF
synthesizers. This drift can be nearly eliminated by using a common synthesizer (com-
mon local oscillator (LO) signal) for all RF carriers.

See also ​chapter 2.2.1.6, "Connecting and Configuring Instruments for Optimum Phase
Coherence", on page 20.
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4.3.2 Reference

The LO Coupling related settings are provided in the "Frequency/Phase" dialog.

► To access this dialog, select "SGMA-GUI > Instrument Name > Frequency/Phase >
Local Oscillator (LO) Coupling".

Source
Selects the source of the local oscillator signal.

"Int" The instrument uses the built-in local oscillator.

"Ext" The signal fed-in at the REF/LO IN input connector is used as signal
source.

Note: The Local Oscillator input/output requires the additional software
option R&S SGS-K90.

SCPI command: 
​[: ​SOURce: ​]LOSCillator: ​SOURce ​ on page 116

REF/LO Output
Determines the signal provided at the output connector REF/LO OUT.

See also ​chapter 2.2.1.5, "Defining the Signal at the REF/LO OUT Connec-
tor", on page 19.

"OFF" No signal is provided.

"LO" The signal of the local oscillator (LO) is available at the REF/LO OUT
connector.

"REF" The signal of the reference oscillator is available at the REF/LO OUT
connector.

SCPI command: 
​: ​CONNector: ​REFLo: ​OUTPut ​ on page 103

4.4 Reference Oscillator

The R&S SGS is equipped with an internal TXCO reference oscillator. If equipped with
the additional HW option R&S SGS-B1, an OXCO can be used as an internal reference
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frequency source for the synthesizer. Moreover, an external reference signal source can
be connected to the REF/LO IN connector of the instrument.

Refer to ​figure 2-2 for visualization of the signal flow.

► To access this dialog, select "SGMA-GUI > Instrument Name > Reference Oscilla-
tor".

REF/Ref. Oscillator Source
Determines whether the internal built-in oscillator (TXCO or OXCO) is used as a reference
source or if an external reference is used. The internal reference oscillator OCXO requires
the additional option R&S SGS-B1.

To feed in an external instrument reference, use the input connector REF/LO IN. To
output the reference frequency at the output REF/LO OUT, select "SGMA-GUI > Instru-
ment Name > Ref. Oscillator > REF/LO Output > REF".

See also ​chapter 2.2.1.3, "Configuring the Reference Oscillator Source", on page 18.

"Int" The internal reference signal of 10 MHz is used.

"Ext" An external reference signal is used. The frequency of the external ref-
erence signal must be selected with the parameter "SGMA-GUI >
Instrument Name > Ref. Oscillator > Ex. Ref. Input Frequency".

SCPI command: 
​[: ​SOURce: ​]ROSCillator: ​SOURce ​ on page 121

Ext. Ref. Input Frequency
(Source External only)

Selects the frequency of the external reference signal. An external reference signal with
a frequency of 10 MHz, 100 MHz or 1000 MHz can be used (see also ​table 4-1).

SCPI command: 
​[: ​SOURce: ​]ROSCillator: ​EXTernal: ​FREQuency ​ on page 120

Synchronization Bandwidth
(Source External only)

Selects the synchronization bandwidth for an external reference signal. The wideband
setting is provided for using very good reference sources of high spectral purity.

Reference Oscillator
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"Wide" Synchronization bandwidth is app. 250 Hz.

"Narrow" Synchronization bandwidth is app. 40 Hz.

SCPI command: 
​[: ​SOURce]: ​ROSCillator: ​EXTernal: ​SBANdwidth ​ on page 122

Output Frequency
Selects the output for the reference oscillator signal. The available values depend on the
input frequency and the reference oscillator source.
Table 4-1: Output Frequency

Reference Oscillator Source Input frequency Output Frequency

"Internal" 10 MHz 10 MHz

1 GHz

"External" 10 MHz

100 MHz

1 GHz

10 MHz, 1 GHz

100 MHz, 1 GHz

1 GHz

SCPI command: 
​[: ​SOURce: ​]ROSCillator: ​OUTPut: ​FREQuency ​ on page 121

REF/LO Output
Determines the signal provided at the output connector REF/LO OUT.

See also ​chapter 2.2.1.5, "Defining the Signal at the REF/LO OUT Connec-
tor", on page 19.

"OFF" No signal is provided.

"LO" The signal of the local oscillator (LO) is available at the REF/LO OUT
connector.

"REF" The signal of the reference oscillator is available at the REF/LO OUT
connector.

SCPI command: 
​: ​CONNector: ​REFLo: ​OUTPut ​ on page 103

Active Adjustment Data
Displays whether the factory or user defined (custom) calibration value is currently used
for the external calibration of the reference oscillator.

Adjusting the calibration value for the OCXO adjustments is a protected service proce-
dure, that requires a Protection Level 2 password.

Adjustment Active
(Source internal only)

Selects adjustment mode.

"OFF" The calibrated adjustment value of the internal reference frequency is
used. This value is determined at one of the R&S service centers during
calibration.

Reference Oscillator
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"ON" A user-defined adjustment value is used. The value is entered under
"Adjustment DAC Value".
This allows the frequency to be impaired freely, for example, to simulate
a frequency error.
The instrument is no longer in the calibrated state. However, the cali-
bration value is not changed and the instrument resumes the calibrated
state after switching the "Adjustment State" to Off.

SCPI command: 
​[: ​SOURce]: ​ROSCillator[: ​INTernal]: ​ADJust[: ​STATe] ​ on page 121

DAC Value
Enters a user-defined adjustment value for the internal reference frequency. This value
is not used unless "Adjustment Active On" is selected.

SCPI command: 
​[: ​SOURce]: ​ROSCillator[: ​INTernal]: ​ADJust: ​VALue ​ on page 121

4.5 Level and Power-On Settings

This section explains the level settings of the R&S SGS. The instrument can be equipped
optionally with an active electronic step attenuator (R&S SGS-B26).

The level related settings e.g. the RF level and level limit are provided in the "Level"
dialog. The power-on behavior of the instrument is set in the "Power-On Settings" section.

Configuring RF Level

► To change the RF level of the selects instrument, perform one of the following:

a) Select "SGMA-GUI main panel > Level" and enter the desired value.
b) Select "SGMA-GUI > Instrument Name > Level Settings > Level" and enter the

desired value.

Changes of the RF level have an immediate effect on the output signal.

Level Settings
Comprises the level settings.
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Mode ← Level Settings
Allows to optimize the RF output signal for applications, where improved harmonic dis-
tortion or improved wideband noise is required.

"Normal" In normal mode, the generator provides an RF output signal with high
signal to noise ratio as well as low distortion, according to the data
sheet.

"Low Noise" This setting forces the generator to optimize the signal to noise ratio.

"Low Distor-
tion"

In this mode, the generator reduces distortions of the RF signal to a
minimum.

SCPI command: 
​[: ​SOURce: ​]POWer: ​LMODe ​ on page 119

Setting Characteristic ← Level Settings
Selects the characteristic for the level setting. For some general applications, the instru-
ment operation can be optimized by choosing one of the predefined level setting char-
acteristics.

"Auto" The instrument provides the highest dynamic range and the fastest
setting times according to the data sheet.
The RF signal is shortly blanked during the moment the step attenuator
is switched on.

"Uninterrupted
Level setting"

Suppresses level blanking at frequency and level changes.
This mode reduces the dynamic range of the instrument. The step
attenuator is fixed.

"Strictly Mono-
tone"

Provides level setting without discontinuities. All electronic switches in
the RF path are clamped. The operation mode is useful for applications
using level searching algorithms.
This mode further reduces the dynamic range of the instrument. The
step attenuator is also fixed.

"Constant-
VSWR"

Suppresses output impedance variations at the RF OUT connector due
to changed level setting.
This mode reduces the dynamic range of the instrument. The step
attenuator is fixed.

SCPI command: 
​[: ​SOURce: ​]POWer: ​SCHaracteristic ​ on page 119

Level ← Level Settings
Sets the RF level at the RF output connector of the selected instrument.

SCPI command: 
​[: ​SOURce: ​]POWer[: ​LEVel][: ​IMMediate][: ​AMPLitude] ​ on page 119

Level Range ← Level Settings
Displays the adjustable level range deepening on the selected ​Mode.

Limit ← Level Settings
Sets the level limit.

Level and Power-On Settings
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The value specifies the upper limit of the level at the RF OUT connector. A message
appears if an attempt is made to set a level above this limit and the level at the RF output
is confined to the upper limit. However, the level indication is not influenced.

The value is not affected by an instrument preset function. This parameter is influenced
only by the ​Factory Preset and its factory value is equal to the upper limit.

SCPI command: 
​[: ​SOURce: ​]POWer: ​LIMit[: ​AMPLitude] ​ on page 120

Readjust ← Level Settings
Recalculates the instrument internal settings optimized for the current level. Not required
for automatic modes.

SCPI command: 
​[: ​SOURce: ​]POWer: ​ALC: ​SONCe ​ on page 119

Power-On State
Selects the state which the RF output takes after the instrument is switched on.

"RF Off" The output is deactivated when the instrument is switched on.

"Previous Set-
ting"

When the instrument is switched on, the output takes the same state
as it had when the instrument was switched off.

SCPI command: 
​: ​OUTPut[: ​STATe]: ​PON ​ on page 114

4.6 I/Q Modulation and Signal Impairment

The R&S SGS offers I/Q modulation with external analog I/Q signals. I/Q modulation with
an external analog I/Q signal is possible for the instrument equipped with frequency
option R&S SGS-B106V. The external signal is input via the I and Q connectors and
transferred to the I/Q modulator.

Before the signal is fed into the I/Q modulator, the signal can be impaired. Impairment at
this point along the signal flow is offered to allow error correction of the supplied signal
or set dedicated impairments. Impairments caused by the I/Q modulator are automatically
corrected by the "Internal Adjustments" function.

System error correction of the I/Q modulator permits precise and repeatable measure-
ments. The correction routine should be called in the case of temperature fluctuations of
several degrees. To call the routine, select "SGMA-GUI > Instrument Name > Setup >
Internal Adjustment" and execute the desired adjustment procedure.

4.6.1 I/Q Impairments

Signal impairments are well-defined arithmetic modifications of the data. Every data
sample is modified in the same way. The purpose of adding impairments to the data
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stream is to simulate frequent sources of distortions in a real signal-processing chain in
order to generate a test signal with dirty transmitter conditions.

4.6.1.1 Gain and Gain Imbalance

An I/Q gain is a multiplication of all I/Q amplitudes by a common factor. The effect is
equivalent to two identical I and Q gain factors. The effect of an increased gain factor in
the I/Q constellation diagram is shown below.

Fig. 4-1: Effect of an increased amplitude in the I/Q constellation diagram

An I gain multiplies the I amplitudes by a factor, leaving the Q amplitudes unchanged. A
Q gain has the opposite effect. Different I and Q gain factors result in an I/Q imbalance,
which is usually due to different gains of the amplifiers in the I and Q channels of the I/Q
modulator. The effect of a positive and negative gain imbalance is shown below.

Fig. 4-2: Negative gain imbalance (left) and positive (right) gain imbalance in the I/Q constellation dia-
gram
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4.6.1.2 I and Q Offset

An I offset adds a constant value to all I amplitudes, leaving the Q amplitudes unchanged.
A Q offset has the opposite effect. A combination of I and Q values results in an I/Q offset,
which is usually due to carrier feedthrough in the I/Q modulator. Possible reasons are
interfering signals at the RF carrier frequency, e.g. an unsuppressed RF carrier sub-
channel. The effect of a positive I and Q offset in the I/Q constellation diagram is shown
below.

Fig. 4-3: I offset (left) and Q offset (right) in the I/Q constellation diagram

4.6.1.3 Quadrature Offset

Changes the phase angle between the I and Q vectors from the ideal 90 degrees, while
the amplitudes are maintained. A positive quadrature offset results in a phase angle
greater than 90 degrees. The effect of a positive quadrature offset in the I/Q constellation
diagram is shown below.

Fig. 4-4: Positive quadrature offset in the I/Q constellation diagram
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4.6.2 Reference

► To access the settings of the I/Q modulator, select "SGMA-GUI > Instrument Name
> I/Q Settings".

Mod State
Switches the I/Q modulation on and off.

SCPI command: 
​[: ​SOURce: ​]IQ: ​STATe ​ on page 116

State
Activates/deactivates I/Q impairments.

If activated, the settings for offset, gain imbalance and quadrature offset become effec-
tive.

Whether or not I/Q impairment is activated is indicated in the function block.

SCPI command: 
​[: ​SOURce: ​]IQ: ​IMPairment[: ​STATe] ​ on page 117

Offset
Sets the carrier offset (in percent) of the amplitudes (scaled to the peak envelope power
(PEP) for the I and/or Q signal component. An ideal I/Q modulator suppresses the carrier
offset completely (offset = 0 percent).

For more information, see ​chapter 4.6.1.2, "I and Q Offset", on page 52.

SCPI command: 
​[: ​SOURce: ​]IQ: ​IMPairment: ​LEAKage: ​I ​ on page 117
​[: ​SOURce: ​]IQ: ​IMPairment: ​LEAKage: ​Q ​ on page 117

Gain Imbalance
Sets the imbalance of the I and Q vector (see ​chapter 4.6.1.1, "Gain and Gain Imbal-
ance", on page 51).
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The entry is made in dB (default) or %, where 1 dB offset is roughly 12 % according to
the following:

Imbalance [dB] = 20log ( | GainQ | / | GainI |)

Positive values mean that the Q vector is amplified more than the I vector by the corre-
sponding percentage. Negative values have the opposite effect.

SCPI command: 
​[: ​SOURce: ​]IQ: ​IMPairment: ​IQRatio[: ​MAGNitude] ​ on page 116

Quadrature Offset
Sets the quadrature offset (see ​chapter 4.6.1.3, "Quadrature Offset", on page 52).

SCPI command: 
​[: ​SOURce: ​]IQ: ​IMPairment: ​QUADrature[: ​ANGLe] ​ on page 117

I/Q Wideband
Setting mode for wideband modulation signals (higher I/Q modulation bandwidth).

The modulation frequency response of the R&S SGS in the useful bandwidth is improved
at the expense of poorer harmonic suppression. This is achieved by shifting the switching
frequencies of the lowpass filters in the output section.

SCPI command: 
​[: ​SOURce: ​]IQ: ​WBSTate ​ on page 118

Crest Factor
Sets the crest factor of the I/Q modulation signal.

The crest factor gives the difference in level between the peak envelope power (PEP)
and average power value (RMS) in dB. This value is necessary for the generation of the
correct output power at the RF output, i.e. the instrument uses the PEP value to com-
pensate the average power.

The maximum input voltage at the I/Q input is equated to the peak power and is used as
the "reference" for setting the level of the output signal. Since the signal does not usually
supply the peak power at a constant level and instead supplies a lower average power,
the crest factor specifies how many dB have to be added internally so that the correct
output power is achieved.

SCPI command: 
​[: ​SOURce: ​]IQ: ​CREStfactor ​ on page 117

4.7 Preset

Calls up a defined instrument setup. All parameters and switching states are preset (also
those of inactive operating modes). The default instrument settings provide a reproduci-
ble initial basis for all other settings. However, functions that concern the integration of
the instrument into a measurement setup are not changed, e.g. reference oscillator set-
tings.
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Overview of the most important preset states

The following list gives an overview of the presets for the most important generator set-
tings. The other presets can be found in the information accompanying the remote com-
mands.
● "RF frequency" = 1 GHz
● "Reference frequency" = Internal; adjustment off
● "RF output" switched off
● "Modulator State" = Off

Settings that are not affected by the "SGMA-GUI > Instrument Name > Preset" function:
● Reference frequency settings ("Ref Oscillator" dialog)
● Power on settings ("Level" dialog)
● Network settings ("Setup" dialog)
● Password and settings protected by passwords ("Setup" dialog)
● Eco Mode state ("Setup > Eco Mode" dialog)

To preset the R&S SGMA-GUI itself and all configured instruments to their predefined
state, use the "SGMA-GUI > File > New" function.

SCPI command:

​SYSTem: ​PRESet ​ on page 101

Preset
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5 General Instrument Settings and Instrument
Setup
This section describes the settings which do not directly affect signal generation.

► To access these settings, select "SGMA-GUI > Instrument Name > Setup" and select
the required dialog.

5.1 Internal Adjustments

The R&S SGS is accurate due to the integrated procedures for adjustments.

All internal adjustments for which no external measuring equipment is needed can be
started in the "Internal Adjustments" dialog. The adjustments with external measuring
equipment are described in the Service Manual (on CD ROM, supplied with the instru-
ment).

Adjustment is recommended if the temperature range in which the instrument is operated
changes, prior to all applications which require maximum level and frequency accuracy,
or after enabling/disabling of the "Eco Mode" (see ​chapter 5.11, "Eco
Mode", on page 69).

During adjustment a bar indicates the status of progress. If an error occurs, adjustment
is terminated and an error message is output in the info line.

Risk of invalid adjustment
In order to achieve correct adjustment of the instrument, make sure that the instrument
is warm before performing adjustments. The warm-up time is 30 minutes.
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Adjust All
Starts all internal adjustments for which no external measuring equipment is needed. The
adjustments with external measuring equipment are described in the Service Manual
(supplied).

SCPI command: 
​: ​CALibration: ​ALL[: ​MEASure] ​ on page 102

Adjust Synthesis
Performs all adjustments which affect the frequency.

SCPI command: 
​: ​CALibration: ​FREQuency[: ​MEASure] ​ on page 102

Adjust Level
Performs all adjustments which affect the level. The acquired correction values improve
the settling time and the signal quality.

SCPI command: 
​: ​CALibration: ​LEVel[: ​MEASure] ​ on page 103

Adjust I/Q Modulator
Starts the adjustment for the I/Q modulator for the entire frequency range. The I/Q mod-
ulator is adjusted with respect to carrier leakage, I/Q imbalance and quadrature.

SCPI command: 
​: ​CALibration: ​IQModulator: ​FULL ​ on page 102

Adjust I/Q Modulator at Current Frequency
Starts the adjustment for the I/Q modulator for the currently set frequency. The I/Q mod-
ulator is adjusted with respect to carrier leakage, I/Q imbalance and quadrature.

Adjustment for only the set frequency is considerably faster than adjustment across the
entire frequency range. This is possible with ​Adjust I/Q Modulator.

SCPI command: 
​: ​CALibration: ​IQModulator: ​LOCal ​ on page 102

Internal Adjustments
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5.2 Hardware Configuration

In the "Hardware Config" dialog, the installed assemblies together with their variants and
revision states can be displayed for servicing purposes.

► To access the "Hardware Config" dialog, select "SGMA-GUI > Instrument Name >
Setup > Hardware Config".

The dialog is a table that lists the installed assemblies. It is divided into the sections
● "Common Assembly" and
● "RF Assembly"

Assembly
The tables list the installed assemblies.

"Assembly" Assembly name

"Part Number" Part Number of assembly

"Serial Num-
ber"

Serial Number of assembly

"Revision" Revision state of assembly

SCPI command: 
​: ​SYSTem: ​HARDware: ​ASSembly<dir>: ​NAME ​ on page 134
​: ​SYSTem: ​HARDware: ​ASSembly<dir>: ​PNUMber ​ on page 135
​: ​SYSTem: ​HARDware: ​ASSembly<dir>: ​SNUMber ​ on page 135
​: ​SYSTem: ​HARDware: ​ASSembly<dir>: ​REVision ​ on page 135
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5.3 Software / Options

The "Software/Options" dialog shows the firmware version of the instrument software as
well as all installed hardware and software options.

Software options purchased at a later stage can be activated with a keycode. The acti-
vation code is supplied with the software option. An instruction on how to install options
is described in Chapter 4 of the Service Manual (supplied with the instrument). Most
hardware options need to be installed at an authorized Rohde&Schwarz service center.

► To access the "Software/Options" dialog, select "SGMA-GUI > Instrument Name >
Setup > Software/Options".

The dialog is divided into the following sections:
● "Firmware"
● "Hardware"
● "Software"
● "Loaded Modules"

Firmware
The "Firmware" section shows the firmware version and the version of the software plat-
form.

Note: Your instrument is delivered with the latest firmware version available. Firmware
updates as well as the Release Notes describing the improvements and modifications
are provided on the Internet at the download site of the instrument's home page. This
home page always offers the latest information on your instrument, e.g. also on changes
of the firmware update procedure.
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Hardware / Software
The tables in the sections "Hardware" and "Software" list the installed hardware and
software options.

"Option" Short name of option

"Designation" Name of Option

"Licenses" Number of licenses

"Expiration
Date"

For regular options, "Permanent" is indicated in this column. Some
options are available as trial versions. This column shows their expira-
tion date. After this date, the option is no longer available on the instru-
ment.

SCPI command: 
​: ​SYSTem: ​SOFTware: ​OPTion<dir>: ​NAME ​ on page 136
​: ​SYSTem: ​SOFTware: ​OPTion<dir>: ​DESignation ​ on page 135
​: ​SYSTem: ​SOFTware: ​OPTion<dir>: ​LICenses ​ on page 136
​: ​SYSTem: ​SOFTware: ​OPTion<dir>: ​EXPiration ​ on page 136

Loaded Modules
Section "Loaded Modules" is provided for service purposes. It lists all loaded software
modules with their versions and offers a short description of each module.

5.4 Installing SW-Options

Newly purchased software options are enabled in the "Install SW-Option" dialog. They
are ready to operate after they are enabled by means of a key code supplied with the
option.

Only if the instrument is equipped with an older firmware version, a firmware update prior
to enabling the software option may be required. The information on the valid firmware
versions for the purchased software option is provided together with the option. Refer to
​chapter 2.2.2.6, "Installing new Firmware Version on the Instrument", on page 23 for
information on how to perform firmware update and to ​chapter 2.2.2.7, "Activating
Options", on page 24 for instruction on how to install new options.

The firmware update is also described in the service manual, chapter 4 (on CD ROM,
supplied with the instrument).
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5.5 Protection

The "Protection" dialog provides access to the unlocking of protected service functions
(authorized personnel of R&S Service Departments only).

Unlocking of Protected Service Functions

1. Select "SGMA-GUI main panel > Instrument Name > Setup > Protection".

The "Protection" dialog provides access to the unlocking of protected service func-
tions (authorized personnel of R&S Service Departments only).

2. To deactivate the protection, the correct password has to be entered. After the instru-
ment has been switched on, the protection levels 1 to 4 are automatically activated.
Enter "Protection Level 1 > Password > 123456".

Protection Level 1 is activated.

Protection Level / Password
Protection Level 1 can be activated to expand the functionality of the internal adjustment.

The password is 123456.

5.6 Security Setting

The R&S SGS employs a security concept based on user and security password. The
security password is required for changing several critical settings, like performing firm-
ware updates. An access to the passwords and mass storage security settings is provided
in the "Security" dialog.

► To access the "Security" dialog, select "SGMA-GUI > Instrument Name > Setup >
Security"

The menu is divided into the password sections and the security settings section. In the
password section, the passwords for securing a controlled access to the instrument are
defined and changed.
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A change of passwords for the operating system and security password requires the entry
of the old and new password and the conformation of the new password. All settings are
only accepted after the "Change Password" button is pressed.

The settings of this dialog are not accessible over remote control (e.g. SCPI commands).

Change User Password
The user name and password are required for remote access to the instrument via VNC,
FTP or SAMBA.

Note:  It is highly recommended to change the default user password before connecting
the instrument to the network.

User Name ← Change User Password
Indicates the user name used for access to the Linux operating system and valid for VNC,
FTP and SAMBA access.

Old Password ← Change User Password
Enter the currently used user password. The default password is "instrument".

New Password ← Change User Password
Enter the new user password.

Security Setting
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Confirm Password ← Change User Password
Enters the new password for conformation.

The new password is only valid after the "Change Password" button is pressed.

Change Password ← Change User Password
Change the password accordingly.

Change Security Password
Note: It is highly recommended to change the default security password before connect-
ing the instrument to the network.
The security password is required when changing the status of the USB and LAN inter-
face.

Old Password ← Change Security Password
Enter the currently used security password. The default password is '123456'.

New Password ← Change Security Password
Enter the new security password. The security password may contain decimal characters
only.

Confirm Password ← Change Security Password
Enter the new password for conformation.

The new password is only valid after the "Change Password" button is pressed.

Change Password ← Change Security Password
Change the password accordingly.

Security Settings
Comprises the settings for enabling and disabling the USB and LAN interfaces. The set-
ting requires the entry of the security password and is only accepted after the "Accept"
button is pressed.

USB Device ← Security Settings
Enable/disable the USB interfaces.

Note: The instrument does not recognize any device connected to the USB interface
when the interface is disabled.

LAN Connection ← Security Settings
Enable/disable the LAN interfaces.

Note: It is not possible to access the instrument via LAN while the LAN connection is
disabled.
An enabled LAN Connection is a prerequisite for the remote control of the instrument via
VNC, FTP or SAMBA.

Security Password ← Security Settings
Enters the password that is required to enable or to disable the settings protected by a
security password. The default is '123456'.

Security Setting
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Note: It is highly recommended to change the default security password before connect-
ing the instrument to the network. To change the security password, select "SGMA-GUI
> Instrument Name > Setup > Security > Change Security Password".
The settings are only accepted after the "Accept" button is pressed.

Accept ← Security Settings
Accept a new entry or selection and change the settings accordingly.

5.7 Maintenance

The R&S SGS provides a special dialog for performing some maintenance procedures,
like installing firmware packages.

► To access this dialog, select "SGMA-GUI > Instrument Name > Setup > Mainte-
nance".

Operation
Selects the desired maintenance operation.

Trigger Connector Operating Mode
Defines the operating mode of the trigger connector.

"In" input; provided for internal test purposes

"Low" output low signal

"High" output high signal

"Meas
Latency"

measure PCIe latency

"Msg Arrived" PCIe message arrived

"Fb Fault, Sig-
nal valid, Ext
Out1, Ext Out2"

provided for internal use

"Blank" reserved for future use

SCPI command: 
​: ​CONNector: ​TRIGger: ​OMODe ​ on page 103
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Select Package
Selects the firmware package to be installed, see also ​chapter 2.2.2.6, "Installing new
Firmware Version on the Instrument", on page 23.

Update All SGSs
Enable this function to perform a simultaneous firmware update on all SGS instruments,
that are in active state and are connected to this controller.

Note: A firmware update and the required subsequent restart of the controller may be a
time consuming operation. This feature accelerates the update process and the required
restart of the external PC can be executed once after the update operation of all instru-
ments is completed.

Security Password
Enters the password that is required to enable or to disable the settings protected by a
security password. The default is '123456'.

Note: It is highly recommended to change the default security password before connect-
ing the instrument to the network. To change the security password, select "SGMA-GUI
> Instrument Name > Setup > Security > Change Security Password".
The settings are only accepted after the "Accept" button is pressed.

Accept
Accept the selected operation and perform the required procedure.

5.8 Network Settings

The instrument is equipped with a network interface and can be connected to an Ethernet
LAN (local area network). The "Network Settings" dialog provides access to the network
settings.

Risk of network errors!
Connecting errors may affect the entire network.
We recommend to coordinate the connection of the instrument to the network with the
network administrator.
Do not connect or disconnect the network cable until the instrument is switched off
(standby). Only then the network connection can be reliably detected and impairments
to instrument operation can be avoided.

► To access this dialog, select "SGMA-GUI > Instrument Name > Setup > Network
Settings".
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The dialog provides access to the network settings, like settings about the general net-
work environment and specific identification of the computer in the network, as well as
an indication whether the instrument is connected to the network or not.

Restart Network
Shuts down the network connection of the instrument and subsequently re-establishes
the connection.

This function can be used to resolve network problems.

Note: Only the connection of the instrument to the network restarts, the network itself is
not affected.

Hostname
Displays the individual computer name of the instrument.

A predefined name is indicated and can be used for network connections, see ​chap-
ter 3.4.3, "Finding Out the Default Hostname of the Instrument", on page 38.

It is recommend that connection of the instrument to the network be coordinated with the
network administrator. Connection errors may affect the entire network.

SCPI command: 
​: ​SYSTem: ​COMMunicate: ​NETWork[: ​COMMon]: ​HOSTname ​ on page 131

MAC Address
Indicates the MAC address of the network adapter.

Address Mode
Selects if the IP address is assigned automatically or manually.

We recommend that connection of the instrument to the network be coordinated with the
network administrator. Connection errors may affect the entire network.

Note: Lost LAN Connection to an Instrument. If the connection to an instruments con-
figured to use static IP addresses is lost, press the LAN LED on the instrument front panel
for 3 seconds to reset the "Address Mode" to its default value.

"Auto (DHCP)" The IP address is assigned automatically.
The network used must support automatic assignment of IP address
via DHCP or APIPA (Zeroconf) in order to use this function.

Network Settings
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"Static" The IP address is assigned manually.

SCPI command: 
​: ​SYSTem: ​COMMunicate: ​NETWork: ​IPADdress: ​MODE ​ on page 131

IP Address
Displays the IP address. To enter the IP address manually, select "Static" Address Mode.

In case of manual input of IP address we recommend that connection of the instrument
to the network be coordinated with the network administrator. Connection errors may
affect the entire network

SCPI command: 
​: ​SYSTem: ​COMMunicate: ​NETWork: ​IPADdress ​ on page 130

Subnet Mask
Displays the Subnet mask. To enter the Subnet mask manually, select "Static" Address
Mode.

This number is used together with the IP address to identify the network segment the
instrument is in.

We recommend that connection of the instrument to the network be coordinated with the
network administrator. Connection errors may affect the entire network

SCPI command: 
​: ​SYSTem: ​COMMunicate: ​NETWork[: ​IPADdress]: ​SUBNet: ​MASK ​ on page 132

Default Gateway
Displays the IP address of the default gateway. To enter the default gateway manually,
select "Static" Address Mode.

This address identifies the router on the same network as the instrument that is used to
forward traffic to destinations beyond the local network.

We recommend that connection of the instrument to the network be coordinated with the
network administrator. Connection errors may affect the entire network

SCPI command: 
​: ​SYSTem: ​COMMunicate: ​NETWork[: ​IPADdress]: ​GATeway ​ on page 132

5.9 Remote Channels

The "Remote" dialog provides access to the settings for remote control.

► To access this dialog, select "SGMA-GUI > Instrument Name > Setup > Remote".
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Visa Resource Strings
Indicates the VISA resource strings used for remote control of the instrument. A separate
string is provided for remote control via the different interfaces.

Note: For background information and description of the syntax of the VISA resource
strings, refer to the description of the corresponding interface in ​chapter 6.1, "Remote
Control Interfaces and Protocols", on page 72.

SCPI command: 
​: ​SYSTem: ​COMMunicate: ​HISLip: ​RESource ​ on page 133
​: ​SYSTem: ​COMMunicate: ​NETWork: ​RESource ​ on page 132
​: ​SYSTem: ​COMMunicate: ​SOCKet: ​RESource ​ on page 133
​: ​SYSTem: ​COMMunicate: ​USB: ​RESource ​ on page 133
​: ​SYSTem: ​COMMunicate: ​PCIexpress: ​RESource ​ on page 133

Device Identity
Trigger the device identification function. The LAN LED on the front panel of the selected
instrument blinks.

See also ​chapter 3.4.4, "Bidirectional Instrument Identification in the Net-
work", on page 39.

5.10 Factory Preset

The "Factory Preset" dialog provides a function to reset the instrument's settings to their
factory states. This function is activated by pressing the "Execute Factory Preset" button.

► To access this dialog, select "SGMA-GUI > Instrument Name > Setup > Factory Pre-
set".
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Execute Factory Preset
Reset the instrument's settings to their factory state.

Note: Because "Factory Preset" resets the "Remote Channel Settings" and "Network
Settings" to the default values, executing Factory Preset via remote control may terminate
the connection to the instrument, if these settings had been configured to values different
to the default ones!
The factory preset function resets nearly all instrument settings. In addition to the regular
preset a "Factory Preset" resets also the following values:
● Reference frequency settings ("Ref Oscillator" dialog)
● Power on settings ("Level" dialog)
● Network settings including hostname ("Setup > Network Setting" dialog)
● Remote Channel settings ("Setup > Remote Channel" dialog)
● Eco Mode state ("Setup > Eco Mode" dialog)
To maintain security, password settings and all settings protected by these passwords
like disabled USB and LAN connections are not changed.

Not affected by the "Factory Preset" are also user data, lists or instrument settings files,
created for example by means of the "File Save As" function.

SCPI command: 
​: ​SYSTem: ​FPReset ​ on page 101

5.11 Eco Mode

This energy saving mode is available only for instruments equipped with option
R&S SGS-B112/B112V.

► To access this dialog, select "SGMA-GUI > Instrument Name > Setup > Eco Mode".

With enabled "Eco Mode 1 (6 GHz)" the doubler stage in a 12 GHz instrument is
permanently switched off to reduce power consumption and the maximum frequency
is limited to 6 GHz. An enabled "Eco Mode" is indicated in the instrument row in the
R&S SGMA-GUI.
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Risk of invalid adjustment after changing the Eco Mode
The switching off and on of the doubler stage changes the thermal conditions in the
instrument.
In order to achieve correct adjustment of the instrument, make sure that the instrument
is warm before performing adjustments. The warm-up time is 30 minutes.

Performing adjustment in Eco Mode
The instruments performs the internal adjustment within the currently active frequency
range, i.e. up to 6 GHz for enabled mode "Eco Mode 1". The correct alignment of the
parameters outside of the current active frequency range is not guaranteed. A subse-
quent re-adjustment for the total frequency range of the instrument is recommended.

The state of this parameter is not affected by an instrument ​Preset. This parameter is
influenced only by the ​Factory Preset.

SCPI command:

​: ​SYSTem: ​EMODe ​ on page 127

5.12 Standby and Restart

See ​chapter 2.2.1.2, "Switching Between the Operating States", on page 16.

5.13 Diagnostic and Tests

This section describes the settings provided for diagnostic and test purposes.

5.13.1 Self Test

1. To access this dialog, select "SGMA-GUI > Instrument Name > Diagnostic Tests >
Self Test".

2. To trigger a self test, select "Selftest".
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Performs a self test on all installed hardware options.

The result of the self test, succeeded or failed, is displayed. The list of the numeric
results of the performed test cases is protected by protection level 2.

SCPI command:

​: ​TEST: ​ALL: ​STARt ​ on page 137

​: ​TEST: ​ALL: ​RESult ​ on page 137

5.13.2 Keyboard Tests

► To access this dialog, select "SGMA-GUI > Instrument Name > Diagnostic Tests >
Keyboard Test".

Use this function to check the proper operation of all front panel elements. If "Keyboard
Test" is enabled, all front panel LEDs except the POWER ON/OFF are orange. The exact
test procedure is described in the Service Manual (on CD ROM, supplied with the instru-
ment).
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6 Remote Control Operation
As an alternative to operating the R&S SGS interactively via the R&S SIGMA-GUI, one
can also be controll the R&S SGS using programmed commands from a remote PC.

6.1 Remote Control Interfaces and Protocols

The instrument supports several interfaces for remote control. The following table gives
an overview.

Table 6-1: Remote control interfaces and protocols

Interface Protocols, VISA*) address string and Library Remarks

Local Area
Network
(LAN)

● HiSLIP High-Speed LAN Instrument Protocol (IVI-6.1)
TCPIP::host address::hislip0[::INSTR]

● VXI-11
TCPIP::host address::inst0[::INSTR]
Library: VISA

● socket communication (Raw Ethernet, simple Telnet)
TCPIP::host address[::LAN device name]::
<port>::SOCKET
Library: VISA or socketcontroller

A LAN connector is located on
the rear panel of the instrument.

The interface is based on TCP/
IP and supports various proto-
cols.

For details see ​chapter 6.1.2,
"LAN Interface", on page 75

USB USBTMC

USB::<vendor ID>::<product ID>::
<serial number>[::INSTR]
Library: VISA

A USB connector is located on
the rear panel of the instrument.

For details see ​chapter 6.1.3,
"USB Interface", on page 77

PCIe Proprietary

PCIe::<vendor ID>::<product ID>::
<serial number>[::INSTR]
Library: pciecontroller

A PCIe connector is located on
the rear panel of the instrument.

For details see ​chapter 6.1.4,
"PCI Express Inter-
face", on page 78

*) VISA is a standardized software interface library providing input and output functions
to communicate with instruments. A VISA installation on the controller is a prerequisite
for remote control over LAN (when using VXI-11 or HiSLIP protocol) or USB. However,
no VISA installation is necessary to remote control while using socket communication.
For more information about VISA refer to the user documentation.

For information on how to query the VISA resource strings, see ​chapter 5.9, "Remote
Channels", on page 67.

SCPI (Standard Commands for Programmable Instruments)

SCPI commands are used for remote control. Commands that are not taken from the
SCPI standard follow the SCPI syntax rules. The instrument supports the SCPI version
1999. The SCPI standard is based on standard IEEE 488.2 and aims at the standardi-
zation of device-specific commands, error handling and the status registers. The tutorial
"Automatic Measurement Control - A tutorial on SCPI and IEEE 488.2" from John M.
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Pieper (R&S order number 0002.3536.00) offers detailed information on concepts and
definitions of SCPI.

6.1.1 Remote Control Programs and Libraries

The following figure provides a schematic illustration of the remote control capabilities of
the instrument.

Fig. 6-1: Remote control interfaces, protocols and libraries

The following examples give an overview of dependencies between the available libra-
ries, the possible interfaces and protocols, and whether an instrument driver is provided.
The involved parts are highlighted.
● Remote control program using VISA

Fig. 6-2: Remote control program using VISA
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Protocol Remote Control Program

Socket viOpen (..., "TCPIP:rssgs100a100010::5025::SOCKET", ...)
viPrintf (..., "SOUR:FREQ 2GHz\n")

VXI-11 viOpen (..., "TCPIP:rssgs100a100010::inst0::INSTR", ...)
viPrintf (..., "SOUR:FREQ 2GHz\n")

HiSLIP viOpen (..., "TCPIP:rssgs100a100010::hislip0::INSTR", ...)
viPrintf (..., "SOUR:FREQ 2GHz\n")

USBTMC viOpen (..., "USB::0x0aad::0x0088::1000010::INSTR", ...)
viPrintf (..., "SOUR:FREQ 2GHz\n")

● Remote control program using instrument driver (VISA available)

Fig. 6-3: Remote control program using instrument driver (VISA available)

Protocol Remote Control Program

Socket rssgs_init ("TCPIP:rssgs100a100010::5025::SOCKET", ...)
rssgs_SetFrequency (..., 2e9)

VXI-11 rssgs_init ("TCPIP:rssgs100a100010::inst0::INSTR", ...)
rssgs_SetFrequency (..., 2e9)

HiSLIP rssgs_init ("TCPIP:rssgs100a100010::hislip0::INSTR", ...)
rssgs_SetFrequency (..., 2e9)

USBTMC rssgs_init ("USB::0x0aad::0x0088::1000010::INSTR", ...)
rssgs_SetFrequency (..., 2e9)

PCIe rssgs_init ("PCIe::0x162f::0x132e::1000010::INSTR", ...)
rssgs_SetFrequency (..., 2e9)

● Remote control program using instrument driver (VISA not available)
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Remote Control OperationR&S®SGS100A

75User Manual 1173.9105.02 ─ 05

Fig. 6-4: Remote control program using instrument driver (VISA not available)

Protocol Remote Control Program

Socket rssgs_init ("TCPIP:rssgs100a100010::5025::SOCKET", ...)
rssgs_SetFrequency (..., 2e9)

PCIe rssgs_init ("PCIe::0x162f::0x132e::1000010::INSTR", ...)
rssgs_SetFrequency (..., 2e9)

6.1.2 LAN Interface

To be integrated in a LAN, the instrument is equipped with a LAN interface, consisting of
a connector, a network interface card and protocols. For remote control via a network,
the PC and the instrument must be connected via the LAN interface to a common network
with TCP/IP network protocol. They are connected using a commercial RJ45 cable. The
TCP/IP network protocol and the associated network services are preconfigured on the
instrument. Software for instrument control and the VISA program library (for specified
protocols only) must be installed on the controller.

Only the IP address or the computer name (LAN device name) is required to set up the
connection. The IP address/computer name is part of the "VISA resource string" used by
the programs to identify and control the instrument.

Identifying instruments in a network
If several instruments are connected to the network, each instrument has its own IP
address and associated resource string. The controller identifies these instruments by
means of the resource string.

Forms of the VISA resource string:

TCPIP::host address[::LAN device name][::INSTR]
or

TCPIP::host address::port::SOCKET
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where

● TCPIP designates the network protocol used
● host address is the IP address or host name of the device

See also ​chapter 3.4.3, "Finding Out the Default Hostname of the Instru-
ment", on page 38.

● LAN device name defines the protocol and the instance number of a sub-instrument:
– inst0 selects the VXI-11 protocol (default)

– inst1 used by the R&S SGMA-GUI to prevent possible collisions during simul-
taneous remote control over VXI-11. See also ​table 6-2.

– hislip0 selects the newer HiSLIP protocol

● INSTR indicates the instrument resource class (optional)
● port determines the used port number
● SOCKET indicates the raw network socket resource class

Example: 
● Instrument has the IP address 10.113.11.91; the valid resource string using VXI-11

protocol is:
TCPIP::10.113.11.91::INSTR

● The DNS host name name is rssgs100a100021; the valid resource string is:
TCPIP::rssgs100a100021::hislip0 (HiSLIP)
TCPIP::rssgs100a100021::inst0 (VXI-11)

● A raw socket connection can be established using:
TCPIP::10.113.11.91::5025::SOCKET

6.1.2.1 HiSLIP Protocol

The HiSLIP (High Speed LAN Instrument Protocol) is the successor protocol for VXI-11
for TCP-based instruments specified by the IVI foundation. The protocol uses two TCP
sockets for a single connection - one for fast data transfer, the other for non-sequential
control commands (e.g. Device Clear or SRQ).

HiSLIP has the following characteristics:

● High performance as with raw socket network connections
● Compatible IEEE 488.2 support for Message Exchange Protocol, Device Clear,

Serial Poll, Remote/Local, Trigger, and Service Request
● Uses a single IANA registered port (4880), which simplifies the configuration of fire-

walls
● Supports simultaneous access of multiple users by providing versatile locking mech-

anisms
● Usable for IPv6 or IPv4 networks
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Note that HiSLIP data is sent to the device using the "fire and forget" method with imme-
diate return, as opposed to VXI-11, where each operation is blocked until a VXI-11 device
handshake returns. Thus, a successful return of a VISA operation such as viWrite()
does not guarantee that the instrument has finished or started the requested command,
but is delivered to the TCP/IP buffers.

6.1.2.2 VXI-11 Protocol

The VXI-11 standard is based on the ONC RPC (Open Network Computing Remote
Procedure Call) protocol which in turn relies on TCP/IP as the network/transport layer.
The TCP/IP network protocol and the associated network services are preconfigured.
TCP/IP ensures connection-oriented communication, where the order of the exchanged
messages is adhered to and interrupted links are identified. With this protocol, messages
cannot be lost.

6.1.2.3 Socket Communication

An alternative way for remote control of the software is to establish a simple network
communication using sockets. The socket communication, also referred to as “Raw
Ethernet communication”, does not necessary require a VISA installation on the remote
controller side.

The simplest way to establish socket communication is to use the built-in telnet program.
The telnet program is part of every operating system and supports communication with
the software on a command-by-command basis.

Socket connections are established on a specially defined port. The socket address is a
combination of the IP address or the host name of the instrument and the number of the
port configured for remote-control. All instruments use port number 5025 for this purpose.
The port is configured for communication on a command-to-command basis and for
remote control from a program running on a connected PC.

6.1.3 USB Interface

For remote control via USB connection, the PC and the instrument must be connected
via the USB interface. A USB connection requires the VISA library to be installed. VISA
detects and configures the R&S instrument automatically when the USB connection is
established. You do not have to install a separate driver.

The USB VISA resource string is:
USB::<vendor ID>::<product ID>::<serial number>[::INSTR], where:

● <vendor ID> is the vendor ID
● <product ID> is the product ID
● <serial number> is the individual serial number
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Example: 
USB::0x0AAD::0x0088::100021::INSTR
0x0AAD is the vendor ID for Rohde&Schwarz
0x0088 is the product ID for the R&S SGS
100021 is the serial number of the particular instrument

6.1.4 PCI Express Interface

A PCI Express (PCIe) connector is provided on the rear panel of the instrument.

Via PCI Express some commands can be sent to the instrument with optimized speed
(memory-mapped remote control), e.g. frequency or level settings. This allows for mini-
mum setup time.

The PCIe VISA resource string is:
PCIe::<vendor ID>::<product ID>::<serial number>[::INSTR], where:

● <vendor ID> is the vendor ID
● <product ID> is the product ID
● <serial number> is the individual serial number on the rear of the instrument

Example: 
PCIe::0x162f::0x132e::100021::INSTR
0x162f is the vendor ID for Rohde&Schwarz
0x132e is the product ID for the R&S SGS
100021 is the serial number of the particular instrument

6.2 Starting a Remote Control Session

The instrument and the controller have to be connected with the suitable cable and
switched on.

A remote control program must open a connection to the instrument, before it can send
commands to and receive device responses from the instrument.

Instrument Address
In order to operate the instrument via remote control it must be addressed using the
defined interface address. See ​chapter 6.1.2, "LAN Interface", on page 75, ​chapter 6.1.3,
"USB Interface", on page 77 or ​chapter 6.1.4, "PCI Express Interface", on page 78 for
details.

The VISA resource strings are indicated in the "SGMA-GUI main panel > Instrument
name > Setup > Remote Channels" dialog.
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6.2.1 Example: Remote Control over LAN using Socket Communication

This section provides an example on how to establish a remote control connection over
telnet protocol and a simple sockets-based program example that can be further devel-
oped (see also ​chapter B, "Telnet program examples", on page 170).

Basic knowledge of programming and operation of the controller are assumed. A descrip-
tion of the interface commands can be obtained from the relevant manuals.

Refer to the Getting Started maual for an example on how to set up remote control con-
nection over LAN using VXI-11 protocol.

Setting up a Telnet Connection

To control the software, only a telnet program is required. The telnet program is part of
every operating system.

1. To establish a Telnet connection with the R&S SGS, start the telnet program and
enter the socket address.
The socket address is a combination of the IP address or the host name of the
R&S SGS and the number of the port configured for remote-control via telnet.
Tip: The R&S SGS uses the port number 5025 for remote connection via Telnet.

The connection to the instrument is set up and remote-control commands can be
sent.

2. Even if the cursor is not visible on the screen, enter blind a remote-control command
and confirm with Enter.
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6.3 Advanced Remote Control Using PCIe

The PCIe bus is a high-speed serial bus, composed of point-to-point serial links. A pair
of serial links, one transmitting and one receiving link, make up a lane.

Fast Settings

The PCIe interface can be utilized not only to transfer text messages e.g. SCPI com-
mands but also to carry register based remote control messages. The latter mode is
called fast settings mode. The specially provided for this purposes instrument's driver is
mandatory for the instrument control by means of fast settings. This instrument driver
contains special functions for fast setup.

To use the advantage of the fast settings, the following prerequisites must be fulfilled:
● Using the PCIe interface is mandatory (see also ​chapter 6.3.1, "Setting Up a Remote

Control Connection via PCIe", on page 81)
● The fast settings must be enabled by means of the function rssgs_useFastSet 

tings (see also ​chapter 6.3.4, "Enabling Fast Settings", on page 84).

This instrument driver will automatically use the fast settings method whenever possible
- currently only for the parameters frequency, level, RF state, modulator state and mod-
ulator wideband state - and will send SCPI messages in all other cases.

Modulator Wideband State via PCIe
This fast setting requires an instrument driver corresponding to firmware version FW
2.20.417 and higher.

Remote control programs written for PCIe will, without modifications, also run if one of
the other control channels, LAN or USB is used.
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6.3.1 Setting Up a Remote Control Connection via PCIe

To set up a remote control connection vie PCIe, perform the following steps:

1. Configure the controller, see ​6.3.2

2. Connect the controller and the instrument, see ​6.3.3

3. Enable fast settings, see ​6.3.4

6.3.2 Configuring the Controller

This section focus on the steps necessary to configure a controller with Linux or Windows
operating system.

The necessary files are provided on the CD, included in the delivery. The files are stored
in folder /software.

Contents of folder /software
● InstrumentDriver

C source code files which provide a functional application programming interface
(API) to R&S SGS instruments. Required if you want to contol an instrument via PCIe.

● LinuxKernelDriver
C source code files from which you can build a Linux kernel mode driver for the R&S
SGS PCIe remote control interface.

● SGMA-GUI
Graphical user interface program for one or more instruments. Runs on a remote PC.

● SgsDriverDemo
C source code module for a demo program using the instrument driver API.

● SharedLibraries-Dlls
Shared libraries (Dlls) for remote control channels Socket and PCIe. To be used with
the instrument driver.

6.3.2.1 Building and Installing the Hardware Driver

The hardware driver defines the way to communicate with the instrument via PCIe inter-
face.

For Windows operating systems, the hardware driver is installed automatically together
with the installation of the R&S SGMA-GUI software.
See also section "Installation of R&S SGMA-GUI Software" in the Getting Started manual.

For Linux operating system, the source code of the driver is provided on the CD, included
in the delivery.
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In order to build and install this driver, root authority is required.

1. Copy folder LinuxKernelDriver to your hdd

2. Go to directory host.

3. On the command line enter make.

The driver sgshost.ko is automatically built.

4. Enter make install.

Device nodes sgsX are created under the folder /dev (X from 0 to 31).
The module sgshost is loaded.

5. Enter lsmod to verify the module.

6.3.2.2 Making Shared Libraries Accessible

Two library files per operating system are provided on the CD included in the delivery:
● for Linux operating system

libsocketcontroller.so and libpciecontroller.so
● for Windows operating system

SocketController.dll and PCIeController.dll
These libraries act as the dynamic link libraries for programs using the socket or PCIe
interface.

Linux operating system

► To make the libraries accessible, perform one of the following:

a) Append the environment variable LD_LIBRARY_PATH with the path of these two
files e.g. by changing the /etc/environment file.

b) Move these two files to /usr/lib or /lib directory.

Windows operating system

► To make the libraries accessible, perform one of the following:

a) Copy these two files to the folder of your executable.
b) Copy these two files to the WINDOWS\system32 folder.

6.3.2.3 Building a Program

The help file rssgs_vxi.chm shows all functions of the instrument which you can use
in your own remote control program.

Additionally, an example file is provided ( SgsDriverDemo.c).

Building the example program (Linux)

1. Copy folders InstrumentDriver and SgsDriverDemo to your hard disk.

 

 

Advanced Remote Control Using PCIe



Remote Control OperationR&S®SGS100A

83User Manual 1173.9105.02 ─ 05

2. Go to folder Build

3. On the command line enter cmake ..

4. Enter make
Folder Build should now contain the executable SgsDriverDemo.

Building the example program (Windows)

1. Copy folders InstrumentDriver and SgsDriverDemo to your hard disk.

2. Open SgsDriverDemo.vcproj with Visual Studio.

3. Build the program.

Running the example program

► On the command line enter ./SgsDriverDemo RESOURCESTRING [cmd].

Where

● RESOURCESTRING is the (Visa) resource string of your instrument, e.g.
TCPIP::ipaddress::5025::SOCKET or PCIE::0x162f::
0x132e::serialno::INSTR.
Where ipaddress is the IP address or hostname of your instrument and
serialno is its serial number.

● cmd is an optional command (see table).

The following table list the available cammands.

Command Description

? Usage

q Quit

f value Set frequency

f? Query frequency

l value Set level

l? Query level

r  value Set RF state (value = 0,1,ON,OFF)

r? Query RF state

If you enter an additional optional command SgsDriverDemo will execute it and
enter a loop waiting for further commands.

Example: 
TCPIP::10.111.11.44::5025::SOCKET ?
Lists the avalable commands.
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6.3.3 Connecting the Controller and the Instrument

A PCIe connector is provided on the rear panel of the instrument.

Risk of device failure
The R&S SGS is equipped with a single lane PCIe interface that supports hot plug-in.
Do not connect an external PC to the PCIe connector of the instrument during operation
if this external PC does not support hot-plugging!

Connecting an external PC that does not support hot-plugging

1. Switch off the external PC and the instrument.
See also chapter "Switching the instrument On and Off" in the Getting Started Manual.

2. Connect the instrument and the controller with the suitable cable.

3. Switch on the instrument.

4. Switch on the external PC.

6.3.4 Enabling Fast Settings

► To enable the special PCI express feature fast settings, enable the function
rssgs_UseFastSettings (ViSession instrumentHandle, ViBoolean
fastEnabled, ViBoolean asynchronousEnabled) included in the instru-
ment driver.

Settings for some parameters like level and frequency will accelerate.

To disable the fast settings, call function rssgs_UseFastSettings with argument
fastEnable=false.

6.4 Using the R&S SGMA-GUI to Monitor the Remote Con-
trol Operation

The R&S SGMA-GUI can be used to monitor the behavior of one or more instruments
while they are remote controlled.

A typical configuration consists of one monitor, controller(s) and instrument(s), where the
monitor is the remote PC on which the R&S SGMA-GUI is installed and the controller is
the remote PC on which the application program runs.

Simultaneous control of an instrument from a controller and a monitor may lead to colli-
sions whenever both the controller and the monitor utilize the same remote channel.
These collisions are indicated by an error message in the Info line, e.g. "Query interrup-
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ted" or "Resource locked". Simultaneous monitoring and control over the same remote
channel is only possible, if the used protocols support viLock()/viUnlock() and the
remote program uses these functions.

The ​table 6-2 shows whether a collision-free communication over a particular combina-
tion of remote channels is possible or not and if there are any restrictions.

Table 6-2: Cross-reference between used remote channels and collision-free communication

Monitor/

Controller

LAN
(VXI-11)

LAN (HiSLIP) USB LAN (Socket) PCIe

LAN (VXI-11) OK* OK OK OK OK

LAN (HiSLIP) OK OK OK OK OK

USB OK OK viLock/viUnlock OK OK

LAN (Socket) OK OK OK X OK

PCIe OK OK OK OK X

where:
● OK: communication possible, no collisions

*) the R&S SGMA-GUI allways uses the LAN device name instr1, see also ​chap-
ter 6.1.2.2, "VXI-11 Protocol", on page 77.

● X: communication is not possible without collisions
● viLock/viUnlock: communication is only possible, if the remote control com-

mands are enclosed in a viLock () - viUnlock() pair.

The R&S SGMA-GUI uses the viLock()/viUnlock() functions.

The figure below shows an example of configuration where the monitor and the controller
are two different computers, connected to the same instrument over two different hard-
ware interfaces.

Fig. 6-5: Example of setup for remote control monitoring
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Connecting and configuring the monitoring PCs

In the "Setup > Security > Security Settings" dialog, check the state of the LAN and USB
interfaces and enable them if necessary.

1. Connect the monitoring PC to the instrument.

Note: Choose the hardware interface considering the limitations described in ​
table 6-2!

2. Configure the instrument in the R&S SGMA-GUI, see ​chapter 3.4.2, "Handling Instru-
ments in the R&S SGMA-GUI", on page 37.

3. In the "SGMA-GUI > Setup > Instruments > Edit Instruments" dialog, disable "Exclu-
sive Access".

Note: The two functions "Exclusive Access" and monitoring are mutually exclusive!

4. Send remote control commands from the controller to the instrument, open the cor-
responding dialogs in the R&S SGMA-GUI and observe the status of the parameters.
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7 Remote Control Commands
In the following, all remote-control commands will be presented in detail with their param-
eters and the ranges of numerical values.

For an introduction to remote control and the status registers, refer to ​chapter A, "Remote
Control Basics", on page 149.

7.1 Programming Examples

This chapter provides simple programming examples for the R&S SGS. The purpose of
the examples is to present all commands for a given task. In real applications, one would
rather reduce the examples to an appropriate subset of commands.

The programming examples have been tested with a software tool which provides an
environment for the development and execution of remote tests. To keep the examples
as simple as possible, only the "clean" SCPI syntax elements are reported. Non-execut-
able command lines (e.g. comments) start with two // characters.

At the beginning of the most remote control program, an instrument (p)reset is recom-
mended to set the R&S SGS to a definite state. The commands *RST and
SYSTem:PRESet are equivalent for this purpose. *CLS also resets the status registers
and clears the output buffer.

It is also recommended to lock the instrument for remote control from the selected con-
troller prior to further configuration. Use the LOCK command for this purpose.

7.1.1 Performing General Task for Instrument Setup

In the following example we assume that a remote PC is connected to the instrument,
the remote PC and the instrument are switched on and a connection between them is
established.

// ******************************************************************
// Reset instrument first
// ******************************************************************

*RST; *CLS
// :SYSTem:PRESet
// :RESTart
// :SYSTem:FPReset

// ******************************************************************
// Lock the instrument to the controller
// ******************************************************************

:LOCK? 72349234
// Lock instrument to avoid interference by other controllers
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// Use an arbitrary number
// Response: 1
// Request granted, i.e. the instrument is locked
// Abort program if request is refused

// ******************************************************************
// Launch selftest, diagnostic and internal adjustments and retrieve results
// ******************************************************************

:TEST:ALL:STARt?
:TEST:ALL:RESult?
// Response: RUN
// Call :TEST:ALL:RESult? repeatedly until finished (0 or 1 is returned)

:DIAGnostic:POINt:CATalog?
// Response: D_TEMP_RFB,D_TEMP_CPU,D_TEMP_DBL,...
:DIAGNostic:MEASure:POINt? 'D_TEMP_RFB'

// Calibration functions may take several minutes
// Set timeout values of controller accordingly

:CALibration:ALL:MEASure?
// starts the adjustment of all functions for the entire instrument
// Response: 0 / 1
// i.e. adjustment has been performed successfully / adjustment failed
:CALibration:FREQuency:MEASure?
// starts the adjustment of frequency and level
:CALibration:LEVel:MEASure?
// starts adjustments for maximum level accuracy

// Options R&S SGS-B106V required for modulator functions
:CALibration:IQModulator:FULL?
:CALibration:IQModulator:LOCal

// ******************************************************************
// Query the entries in the error queue
// ******************************************************************

SYSTem:SERRor?
// Query static errors
// SYSTem:ERRor:CODE:COUNT?
// SYSTem:ERRor:CODE:NEXT?
// SYSTem:ERRor:NEXT?
// STATus:QUEue:NEXT?
// SYSTem:ERRor:CODE:ALL?
SYSTem:ERRor:ALL?
// Query error queue

// ******************************************************************
// Query system information
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// ******************************************************************

SYSTem:VERSion?
SYSTem:DATE?
SYSTem:TIME? 

// ******************************************************************
// Activate eco mode
// ******************************************************************
SYSTem:EMODe EM1

// ******************************************************************
// Query the installed common assemblies and HW options 
// ******************************************************************

SYSTem:SOFTware:OPTion1:NAME?
SYSTem:SOFTware:OPTion1:DESignation?
SYSTem:SOFTware:OPTion1:LICenses?
SYSTem:SOFTware:OPTion1:EXPiration?

SYSTem:HARDware:ASSembly1:NAME?
SYSTem:HARDware:ASSembly1:PNUMber?
SYSTem:HARDware:ASSembly1:SNUMber?
SYSTem:HARDware:ASSembly1:REVision?

// ******************************************************************
// Unlock the instrument
// ******************************************************************

:UNL 72349234

7.1.2 Generating an I/Q Modulated Signal

In the following example we assume that a remote PC is connected to the instrument,
the remote PC and the instrument are switched on and a connection between them is
established. An external analog signal is provided at the I and Q connectors of the instru-
ment.

// ******************************************************************
// Reset instrument first
// ******************************************************************

*RST; *CLS

// ******************************************************************
// Lock the instrument to the controller
// ******************************************************************

:LOCK? 72349234
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// Lock instrument to avoid interference by other controllers
// Use an arbitrary number
// Response: 1
// Request granted, i.e. the instrument is locked
// Abort program if request is refused

// ******************************************************************
// Select normal operation mode
// ******************************************************************

:SOURce:OPMode NORMal

// ******************************************************************
// Set RF frequency and level 
// ******************************************************************

:SOURce:FREQuency:CW 2 GHz
// :SOURce:PHASe 0
// :SOURce:PHASe:REFerence
:SOURce:POWer -10dBm
:SOURce:POWer:PEP?

// ******************************************************************
// Enable internal reference frequency source 
// ******************************************************************

:SOURce:ROSCillator:SOURce INTernal

// ******************************************************************
// Enable internal LO source 
// ******************************************************************

:SOURce:LOSCillator:SOURce INT

// ******************************************************************
// Define and enable impairments
// Enable modulation
// ******************************************************************

:SOURce:IQ:IMPairment:LEAKage:I -1
:SOURce:IQ:IMPairment:LEAKage:Q 1
:SOURce:IQ:IMPairment:IQRatio:MAGNitude 1
// Sets the gain imbalance to 1 %
:SOURce:IQ:IMPairment:IQRatio:MAGNitude?
// Response: 0.087 dB
:SOURce:IQ:IMPairment:QUADrature:ANGLe 2
:SOURce:IQ:WBSTate ON
:SOURce:IQ:CREStfactor 0.05

:SOURce:IQ:IMPairment:STATe ON
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:SOURce:IQ:STATe ON

// ******************************************************************
// Enable output of the generated signal at the RF connector
// ******************************************************************

:OUTPut:STATe ON

// ******************************************************************
// Unlock the instrument
// ******************************************************************

:UNL 72349234

7.1.3 Adjusting Network and Remote Channel Settings

In the following example we assume that a remote PC is connected to the instrument,
the remote PC and the instrument are switched on and a connection between them is
established.

// ******************************************************************
// Reset instrument first
// ******************************************************************

*RST; *CLS

// ******************************************************************
// Lock the instrument to the controller
// ******************************************************************

:LOCK? 72349234
// Lock instrument to avoid interference by other controllers
// Use an arbitrary number
// Response: 1
// Request granted, i.e. the instrument is locked
// Abort program if request is refused

// ******************************************************************
// Query the VISA resource strings
// ******************************************************************

:SYSTem:COMMunicate:NETWork:RESource?
// Response: TCPIP::10.113.11.91::INSTR
:SYSTem:COMMunicate:SOCKet:RESource?
// Response: TCPIP:rssgs100a100021::5025::SOCKET
:SYSTem:COMMunicate:USB:RESource?
// Response: USB::0x0AAD::0x0088::100021::INSTR
:SYSTem:COMMunicate:PCIexpress:RESource?
// Response: PCIe::0x0AAD::4909::100021::INSTR
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// ******************************************************************
// Query network settings
// ******************************************************************

:SYSTem:COMMunicate:NETWork:COMMon:HOSTname?
// Response: rssgs100a100021
:SYSTem:COMMunicate:NETWork:IPADdress:MODE?
// Response: AUTO
:SYSTem:COMMunicate:NETWork:IPADdress?
// Response: 10.113.11.91
:SYSTem:COMMunicate:NETWork:IPADdress:SUBNet:MASK?
//Response: 255.255.0.0
:SYSTem:COMMunicate:NETWork:IPADdress:GATeway?
//Response: 10.113.0.1

// ******************************************************************
// Unlock the instrument
// ******************************************************************

:UNL 72349234

7.1.4 Advanced Task for Optimizing Performance

In the following example we assume that a remote PC is connected to the instrument,
the remote PC and the instrument are switched on and a connection between them is
established.

// ******************************************************************
// Reset instrument first
// ******************************************************************

*RST; *CLS
// :SYSTem:PRESet
// :RESTart
// :SYSTem:FPReset

// ******************************************************************
// Lock the instrument to the controller
// ******************************************************************

:LOCK? 72349234
// Lock instrument to avoid interference by other controllers
// Use an arbitrary number
// Response: 1
// Request granted, i.e. the instrument is locked
// Abort program if request is refused

// ******************************************************************
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// Query and adjust the reference oscillator settings
// ******************************************************************

:SOURce:ROSCillator:SOURce?
// Response: EXT
:SOURce:ROSCillator:EXTernal:FREQuency?
// Response: 100MHZ
:SOURce:ROSCillator:EXTernal:SBANdwidth?
//Response: WIDE
:SOURce:ROSCillator:SOURce INTernal
:SOURce:ROSCillator:OUTput:FREQuency 100MHZ
:SOURce:ROSCillator:INTernal:ADJust:STATe OFF
// uses the calibrated adjustment value of the internal ref. frequency
:SOURce:ROSCillator:INTernal:ADJust:VALue?
:CONNector:REFLo:OUTPut?
// Response: REF

// ******************************************************************
// Optimizing the quality characteristics of the RF signal
// ******************************************************************

:SOURce:POWer:LMODe LNO
// optimize the signal to noise ratio
:SOURce:POWer:SCHaracteristic AUTO
// ensure highest dynamic range and fastest setting time
:SOURce:POWer:LEVel:IMMediate:AMPLitude -30dBm
:SOURce:POWer:LIMit:AMPLitude 30dBm
:SOURce:POWer:ALC:SONCe
:OUTPut:STATe:PON UNCHanged

// ******************************************************************
// Unlock the instrument
// ******************************************************************

:UNL 72349234

7.1.5 Configuring Instruments in the R&S SGMA-GUI

This section provides an example of automation of the R&S SGMA-GUI.

In the following example we assume that a remote PC with installed R&S SGMA-GUI on
it is connected to a LAN and that the remote PC and the instruments are switched on.

For more information, refer to section "Connecting an External PC and Devices" in the
Getting Started manual.

// ******************************************************************
// Trigger the scan function to search for instruments connected 
//  to the remote computer via all of the available interfaces. 
// ******************************************************************
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:INSTruments:SCAN:HNPRefix "rssgs100a"
// schaned are only instruments with hostname beginning with "rssgs100a"
:INSTruments:SCAN 1
:INSTruments:SCAN?
// Make sure the scanning proccess has finished  
// before proceeding to the next command. The scan state must be 0.

// ******************************************************************
// Query the number of available instruments and the settings of each 
// configured instrument: instrument type, symbolic name, 
// remote channel used, serial number, hostname/IP address
// Adjust settings if required
// ******************************************************************

:INSTruments:COUNt?
// Response: 3

:INSTruments:TYPE?
// Response: SGS,SGS,SGS

:INSTruments:NAME?
// Response: SGS-100010,SGS-100021,SGS-100100

:INSTruments:REMote:CHANnel?
// Response: USB,LAN,PCIe

:INSTruments:REMote:NAME?
// Response: rssgs100a100010,rssgs100a100021,10.113.11.22

:INSTruments:SERial?
// Response: 100010,100021,100100

// ******************************************************************
// Check the instrument state and activate instruments if required
// ******************************************************************

:INSTruments:ACTive:STATe?
// Response: 0,0,1
:INSTruments:ACTive:STATe OFF,ON,ON
// Activates the second and the third instruments in the list, 
// i.e. the instruments with symbolich names SGS-100021 and SGS-100100

// ******************************************************************
// Export the configuration into a mapping file
// ******************************************************************

:INSTruments:MAPPing:FILE 'd:\mapping_files\mapping.map'

// ******************************************************************
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// Enable exclusive access for the selected instrument
// ******************************************************************

:INSTruments:EACCess:STATe?
// Response: 0,0,0
:INSTruments:EACCess:STATe OFF,0N,0FF
// Locks the second instrument

7.2 Common Commands

Common commands are described in the IEEE 488.2 (IEC 625-2) standard. These com-
mands have the same effect and are employed in the same way on different devices.
The headers of these commands consist of "*" followed by three letters. Many common
commands are related to the Status Reporting System.

Available common commands:

*CAL ​...............................................................................................................................95
*CLS ​...............................................................................................................................95
*ESE ​...............................................................................................................................96
*ESR ​..............................................................................................................................96
*IDN ​...............................................................................................................................96
*IST​................................................................................................................................96
*OPC ​..............................................................................................................................97
*OPT​..............................................................................................................................97
*PCB ​..............................................................................................................................97
*PRE ​..............................................................................................................................97
*PSC ​..............................................................................................................................97
*RCL ​...............................................................................................................................98
*RST ​...............................................................................................................................98
*SAV ​...............................................................................................................................98
*SRE ​..............................................................................................................................98
*STB​...............................................................................................................................99
*TRG​..............................................................................................................................99
*TST​...............................................................................................................................99
*WAI​...............................................................................................................................99

*CAL?

Calibration Query

Initiates a calibration of the instrument and subsequently queries the calibration status.
Responses > 0 indicate errors.

Usage: Query only

*CLS

CLear Status
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Sets the status byte (STB), the standard event register (ESR) and the EVENt part of the
QUEStionable and the OPERation registers to zero. The command does not alter the
mask and transition parts of the registers. It clears the output buffer.

Usage: Setting only

*ESE <Value>

Event Status Enable

Sets the event status enable register to the specified value. The query returns the con-
tents of the event status enable register in decimal form.

Parameters:
<Value> Range: 0 to 255

*ESR?

Event Status Read

Returns the contents of the event status register in decimal form and subsequently sets
the register to zero.

Return values: 
<Contents> Range: 0  to  255

Usage: Query only

*IDN?

IDeNtification: returns the instrument identification.

Return values: 
<ID> "Rohde&Schwarz,<device type>,<serial number>,<firmware ver-

sion>"

Example: Rohde&Schwarz,ZVA8-4Port,12345,0.10.1.23
Usage: Query only

*IST?

Individual STatus query

Returns the contents of the IST flag in decimal form. The IST flag is the status bit which
is sent during a parallel poll.

Return values: 
<ISTflag> 0 | 1

Usage: Query only
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*OPC

OPeration Complete

Sets bit 0 in the event status register when all preceding commands have been executed.
This bit can be used to initiate a service request. The query form writes a "1" into the
output buffer as soon as all preceding commands have been executed. This is used for
command synchronization.

*OPT?

OPTion identification query

Queries the options included in the instrument. For a list of all available options and their
description refer to the CD-ROM.

Return values: 
<Options> The query returns a list of options. The options are returned at

fixed positions in a comma-separated string. A zero is returned for
options that are not installed.

Usage: Query only

*PCB <Address>

Pass Control Back

Indicates the controller address to which remote control is returned after termination of
the triggered action.

Setting parameters: 
<Address> Range: 0  to  30

Usage: Setting only

*PRE <Value>

Parallel poll Register Enable

Sets parallel poll enable register to the indicated value. The query returns the contents
of the parallel poll enable register in decimal form.

Parameters:
<Value> Range: 0  to  255

*PSC <Action>

Power on Status Clear

Determines whether the contents of the ENABle registers are preserved or reset when
the instrument is switched on. Thus a service request can be triggered when the instru-
ment is switched on, if the status registers ESE and SRE are suitably configured. The
query reads out the contents of the "power-on-status-clear" flag.

Common Commands
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Parameters:
<Action> 0 | 1

0
The contents of the status registers are preserved.
1
Resets the status registers.

*RCL <Number>

ReCaLl calls up the instrument settings from an intermediate memory identified by the
specified number. The instrument settings can be stored to this memory using the com-
mand ​*SAV ​ with the associated number.

It also activates the instrument settings which are stored in a file and loaded using the
MMEMory:LOAD <number>, <file_name.extension> command.

*RST

ReSeT

Sets the instrument to a defined default status. The default settings are indicated in the
description of commands.

The command is equivalent to SYSTem:PRESet.

Usage: Setting only

*SAV <Number>

SAVe stores the current instrument settings under the specified number in an intermedi-
ate memory. The settings can be recalled using the command ​*RCL ​ with the associated
number.

To transfer the stored instrument settings in a file, use the command ​: ​MMEMory: ​
STORe: ​STATe ​.

*SRE <Contents>

Service Request Enable

Sets the service request enable register to the indicated value. This command determines
under which conditions a service request is triggered.

Parameters:
<Contents> Contents of the service request enable register in decimal form.

Bit 6 (MSS mask bit) is always 0.
Range: 0  to  255

Common Commands
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*STB?

STatus Byte query

Reads the contents of the status byte in decimal form.

Usage: Query only

*TRG

TRiGger

Triggers all actions waiting for a trigger event. In particular, *TRG generates a manual
trigger signal (Manual Trigger). This common command complements the commands of
the TRIGger subsystem.

Usage: Event

*TST?

self TeST query

Triggers selftests of the instrument and returns an error code in decimal form (see Service
Manual supplied with the instrument). "0" indicates no errors occured.

Usage: Query only

*WAI

WAIt to continue

Prevents servicing of the subsequent commands until all preceding commands have
been executed and all signals have settled (see also command synchronization and ​
*OPC ​).

Usage: Event

7.3 General Commands

:​RESTart​.........................................................................................................................99
:​STANdby ​.....................................................................................................................100
:​LOCK ​...........................................................................................................................100
:​UNLock ​........................................................................................................................100

:RESTart

Restarts the instrument.

Usage: Event
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:STANdby

Switchs the instruments to stand by state. To return the instrument from standy to ready
ste, send the SCPI command ​: ​RESTart ​.

Usage: Event

:LOCK? <Lock Request Id>

Sends a lock request ID which uniquely identifies the controller to the instrument.

Query parameters: 
<Lock Request Id> Number

0
test query to prove whether the instrument is locked
Controller ID
request lock from the controller with the specified Controller ID

Return values: 
<Value> Number

0
request refused; the instrument is already locked to other <Lock
Request Id>, i.e. to another controller
1
request granted

Example: :LOCK? 12345
Response: 1
:UNL 12345

Usage: Query only

:UNLock <Unlock Id>

Unlocks an instrument locked to a controller with Controller ID = <Unlock Id>.

Setting parameters: 
<Unlock Id> Number

Unlock ID which uniquely identifies the controller to the instrument.
The value must match the Controller ID <Lock Request Id>
set with the command ​: ​LOCK ​.
0
Clear lock regardless of locking state

Usage: Setting only
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7.4 Preset Commands

The preset commands are not bundled in one subsystem. Therefore, they are listed sep-
arately in this section. In addition, a specific preset command is provided for each digital
standard and for the fader. These specific commands are described in the associated
subsystems.

The following presetting actions are available:
● Activating the default state of all internal instrument functions ( ​*RST ​ on page 98).

Functions that concern the integration of the instrument into a measurement setup
are not changed, e.g. TCP/IP address or reference oscillator source settings.

● Activating the original state of delivery (factory reset, ​: ​SYSTem: ​FPReset ​
on page 101). Only functions that are protected by a password remain unchanged
as well as the passwords themselves.

:SOURce<hw>:PRESet
SYSTem:PRESet
The command triggers an instrument reset. It has the same effect as:
● the *RST command

● the "SGMA-GUI > Instrument Name > Preset" function

For an overview of the settings affected by the preset function, see ​chapter 4.7, "Pre-
set", on page 54.

Example: SYST:PRES
All instrument settings (also those that are not currently active) are
reset to their default values.

Usage: Setting only

:SYSTem:FPReset

The command triggers an instrument reset to the original state of delivery.

For an overview of the settings affected by the factory preset function, see ​chapter 5.10,
"Factory Preset", on page 68.

Example: SYST:FPR
all instrument settings (also those that are not currently active) are
reset to the factory values.

Usage: Event

7.5 CALibration Subsystem

:​CALibration: ​ALL[:​MEASure] ​...........................................................................................102
:​CALibration: ​FREQuency[:​MEASure] ​...............................................................................102
:​CALibration: ​IQModulator: ​FULL ​.......................................................................................102
:​CALibration: ​IQModulator: ​LOCal ​......................................................................................102
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:​CALibration: ​LEVel[: ​MEASure] ​........................................................................................103

:CALibration:ALL[:MEASure]?

Starts all internal adjustments for which no external measuring equipment is needed.

Return values: 
<All> 0 | 1 | OFF | ON

Example: See ​chapter 7.1.1, "Performing General Task for Instrument
Setup", on page 87.

Usage: Query only

:CALibration:FREQuency[:MEASure]?

Performs all adjustments which affect the frequency.

Return values: 
<Synthesis> 0 | 1 | OFF | ON

Example: See ​chapter 7.1.1, "Performing General Task for Instrument
Setup", on page 87.

Usage: Query only

:CALibration:IQModulator:FULL?

Starts adjustment of the I/Q modulator for the entire frequency range. The I/Q modulator
is adjusted with respect to carrier leakage, I/Q imbalance and quadrature.

Return values: 
<Modulator> 0 | 1

Example: See ​chapter 7.1.1, "Performing General Task for Instrument
Setup", on page 87.

Usage: Query only

:CALibration:IQModulator:LOCal?

Starts adjustment of the I/Q modulator for the current frequency. The I/Q modulator is
adjusted with respect to carrier leakage, I/Q imbalance and quadrature.

Return values: 
<CFRequency> 0 | 1

Example: See ​chapter 7.1.1, "Performing General Task for Instrument
Setup", on page 87.

Usage: Query only
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:CALibration:LEVel[:MEASure]?

Starts all adjustments which affect the level.

Return values: 
<Level> 0 | 1 | OFF | ON

Example: See ​chapter 7.1.1, "Performing General Task for Instrument
Setup", on page 87.

Usage: Query only

7.6 CONNector Subsystem

:​CONNector: ​REFLo: ​OUTPut​...........................................................................................103
:​CONNector: ​TRIGger:​OMODe​.........................................................................................103

:CONNector:REFLo:OUTPut <Output>

Determines the signal provided at the output connector REF/LO OUT (rear of instrument).

Parameters:
<Output> REF | LO | OFF

*RST: REF

Example: See ​chapter 7.1.2, "Generating an I/Q Modulated Sig-
nal", on page 89.

:CONNector:TRIGger:OMODe <Mode>

Set the operating mode of the trigger connector.
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Parameters:
<Mode> BLANk | LOW | MLATency | MARRived | HIGH | IN | FBFault |

SVALid | EO2 | EO1
IN
input, for internal test purposes
LOW
output low signal
MLAT
measure PCIe latency
MARR
PCIe message arrived
HIGH
output high signal
FBF | SVAL | EO1 | EO2
for internal use
BLAN
blanking, for future use

7.7 DIAGnostic Subsystem

:​DIAGnostic:​POINt:​CATalog ​............................................................................................104
:​DIAGnostic[:​MEASure]:​POINt​.........................................................................................104

:DIAGnostic:POINt:CATalog?

The command queries the test points available in the instrument. A detailed description
of the test points can be found in chapter 3, section "Troubleshooting" of the Service
Manual (on CD-ROM, supplied with the instrument).

Example: See ​chapter 7.1.1, "Performing General Task for Instrument
Setup", on page 87.

Usage: Query only

:DIAGnostic[:MEASure]:POINt? <Name>

The command triggers voltage or temperature measurement at the specified test point
and returns the measured value. A detailed description of the test points can be found in
section "Trouble Shooting" of the Service Manual (on CD-ROM, supplied with the instru-
ment).

A list of the available test points for the respective path can be queried using the command
​: ​DIAGnostic: ​POINt: ​CATalog ​.

Query parameters: 
<Name> string
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Return values: 
<Value> number

Default unit: V or °C

Example: See ​chapter 7.1.1, "Performing General Task for Instrument
Setup", on page 87.

Usage: Query only

7.8 FORMat Subsystem

The FORMat subsystem contains the commands which determine the format of the data
that the R&S SGS returns to the controller. This affects all query commands which return
a list of numerical data or block data. Reference is made to this in the descriptions of the
commands.

For two-path instruments, the data format is set simultaneously for both paths.

:​FORMat:​BORDer ​..........................................................................................................105
:​FORMat[:​DATA]​............................................................................................................105
:​FORMat:​SREGister ​.......................................................................................................106

:FORMat:BORDer <Border>

The command determines the sequence of bytes within a binary block. This only affects
blocks which use the IEEE754 format internally.

Parameters:
<Border> NORMal | SWAPped

NORMal
The instrument expects (with setting commands) and sends (with
queries) the least significant byte of each IEEE754 floating-point
number first and the most significant byte last.
SWAPped
The instrumenet expects (with setting commands) and sends (with
queries) the most significant byte of each IEEE754 floating-point
number first and the least significant byte last.
*RST: NORMal

Example: FORM:BORD SWAP
the data is transferred with the most significant bit first.

:FORMat[:DATA] <Data>

The command determines the data format which the R&S Signal Generator uses to return
data. When data is transferred from the control computer to the instrument, the instrument
detects the data format automatically. In this case, the value set here is irrelevant.
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Parameters:
<Data> ASCii | PACKed

ASCii
Numerical data is transferred as plain text separated by commas.
PACKed
Numerical data is transferred as binary block data. The format
within the binary data depends on the command. The various
binary data formats are explained in the description of the param-
eter types.
*RST: ASCii

Example: FORM ASC
The data is transferred as ASCII data.

:FORMat:SREGister <Sregister>

The command determines the numerical format which is returned when the status reg-
isters are queried.

Parameters:
<Sregister> ASCii | BINary | HEXadecimal | OCTal

ASCii
The register content is returned as a decimal number.
BINary
The register content is returned as a binary number. #B is placed
in front of the number.
HEXadecimal
The register content is returned as a hexadecimal number. #H is
placed in front of the number.
OCTal
The register content is returned as an octal number. #Q is placed
in front of the number.
*RST: ASCii

Example: FORM:SREG HEX
The register content is returned as a hexadecimal number.

7.9 MMEMory Subsystem

The MMEMory subsystem (Mass Memory) contains the commands for managing files
and directories as well as for loading and storing complete instrument settings in files.

The files are stored on the internal flash memory of the instrument or on external USB
memory devices.

The default directory is determined using the command MMEMory:CDIR.

 

MMEMory Subsystem



Remote Control CommandsR&S®SGS100A

107User Manual 1173.9105.02 ─ 05

The /opt directory is a protected and therefore unaccessible system directory. The files
on this directory contain data that must not be changed. Therefore, this directory should
not be accessed, since reconstruction of the system partition will lead to data loss.

7.9.1 File Naming Conventions

To enable files in different file systems to be used, the following file naming conventions
should be observed.

The file name can be of any length and no distinction is made between uppercase and
lowercase letters. The file and the optional file extension are separated by a dot. All letters
and numbers are permitted (numbers are, however, not permitted at the beginning of the
file name). Where possible, special characters should not be used. Use of the slashes
"\" and "/" should be avoided since they are used in file paths. A number of names are
reserved by the operating system, e.g. CLOCK$, CON, AUX, COM1...COM4,
LPT1...LPT3, NUL and PRN.

In the R&S SGS all files in which lists and settings are stored are given a characteristic
extension. The extension is separated from the actual file name by a dot (see ​chap-
ter 7.9.2, "Extensions for User Files", on page 107 for an overview the file types).

The two characters "*" and "?" function as "wildcards", i.e. they are used for selecting
several files. The "?" character represents exactly one character, while the "*" character
represents all characters up to the end of the file name. "*.*" therefore stands for all the
files in a directory.

When used in conjunction with the commands, the parameter <file_name> is specified
as a string parameter with quotation marks. It can contain either the complete path
including the drive, only the path and file name, or only the file name. The file name must
include the file extension. The same applies for the parameters <directory_name>
and <path>.

Depending on how much information is provided, either the values specified in the
parameter or the values specified with the command MMEM:CDIR (default directory) are
used for the path and drive setting in the commands.

Before the instrument settings can be stored in a file, they have to be stored in an inter-
mediate memory using common command *SAV <number>. The specified number is
subsequently used in the ​: ​MMEMory: ​STORe: ​STATe ​ command. Also, subsequently to
loading a file with instrument settings with command ​: ​MMEMory: ​LOAD: ​STATe ​, these
settings have to be activated with the common command *RCL <number>.

7.9.2 Extensions for User Files

The following table list all available file extensions for user files. The currently available
files on the instrument depends on the installed options.
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Table 7-1: Automatically assigned file extensions in the instrument

Function Contents File suffix

R&S SGMA-GUI Save As/Open Software settings *.savrcl

Mapping File Information about the configured instru-
ments

*.map

7.9.3 Examples

In these examples, the current instrument setting is stored in the file
test1.savrcltxt in the directory user.

Storing and Loading Current Settings

1. Store the current setting in an intermediate memory with number 4. This setting can
be called using command *RCL and the associated number of the memory, e.g. *RCL
4.
*SAV 4

2. To store the settings in a file in a specific directory, specify the complete path.
MMEM:STOR:STAT 4,"var/user/test.savrcltxt"

3. To store the settings in a file in the default drive, set the default drive and specify only
the file name.
MMEM:CDIR  'var/user'*SAV 4
MMEM:STOR:STAT 4,"test.savrcltxt"

4. Load the file test.savrcltxt in the user directory.
MMEM:LOAD:STAT 4,'/var/sgs//user/test.savrcltxt'

5. Activate the instrument setting of the file test.savrcltxt.
*RCL 4

Working with Files and Directories

1. Read out all files in the specified directory.
MMEM:CAT? 'usb/user'
Response: 127145265,175325184,"test,DIR,0","temp,DIR,
0","readme.txt,ASC,1324","state.savrcltxt,STAT,
5327","waveform.wv,BIN,2342"
the directory usb/user contains the subdirectories test and temp as well as the
files readme.txt, state.savrcltxt and waveform.wv which have different file
types.

Tip: To query only the subdirectories of the current or specified directory, perform:
MMEM:DCAT? 'usb/user'
Response: 'test', 'temp'
To query only the number of subdirectories in the current or specified directory, per-
form:
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MMEM:DCAT:LENG? 'usb/user'
Response: 2

2. To query the number of files in the current or specified directory, perform:
MMEM:CAT:LENG? 'usb/user'
Response: 3

3. Create a new subdirectory for mass memory storage in the specified directory.
MMEM:MDIR 'usb/user/new'

4. Copy the file state to a new file.
MMEM:COPY '/var/sgs//user/state.savrcltxt','usb/user/new'

5. Rename the file state.
MMEM:MOVE 'state.savrcltxt','state_new.savrcltxt'

6. Remove the test directory.
MMEM:RDIR 'usb/user/test'

7.9.4 Remote Control Commands

:​MMEMory: ​CATalog ​.......................................................................................................109
:​MMEMory: ​CATalog: ​LENGth ​...........................................................................................110
:​MMEMory: ​CDIRectory ​...................................................................................................110
:​MMEMory: ​COPY​...........................................................................................................110
:​MMEMory: ​DATA​...........................................................................................................111
:​MMEMory: ​DCATalog ​.....................................................................................................112
:​MMEMory: ​DCATalog: ​LENGth ​........................................................................................112
:​MMEMory: ​DELete ​.........................................................................................................112
:​MMEMory: ​LOAD:​STATe​................................................................................................113
:​MMEMory: ​MDIRectory ​...................................................................................................113
:​MMEMory: ​MOVE​..........................................................................................................113
:​MMEMory: ​MSIS​............................................................................................................114
:​MMEMory: ​RDIRectory ​...................................................................................................114
:​MMEMory: ​STORe:​STATe​..............................................................................................114

:MMEMory:CATalog? <path>

Returns the content of the current or a specified directory.

Query parameters: 
<path> string

String parameter to specify the directory. If the direcory is omitted,
the command queries the content of the current directory, queried
with MMEM:CDIR command.
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Return values: 
<path> <used_memory>,<free_memory>,<file_name>,<file_entry>,...

<used_memory>
Total amount of storage currently used in the directory, in bytes.
<free_memory>
Total amount of storage available in the directory, in bytes.
<file_entry>
All files of the directory are listed with their file name, format and
size in bytes.

Example: See ​"Working with Files and Directories" on page 108.

Usage: Query only

:MMEMory:CATalog:LENGth?

Returns the number of files in the current or in the specified directory.

Return values: 
<Length> <path>

String parameter to specify the directory. If the direcory is omitted,
the command queries the content of the current directory, queried
with MMEM:CDIR command.

<count> Number of files

Example: See ​"Working with Files and Directories" on page 108.

Usage: Query only

:MMEMory:CDIRectory <Cdirectory>

Changes the default directory for mass memory storage. The directory is used for all
subsequent MMEM commands if no path is specified with them. It is also possible to change
to a higher directory using two dots '..' .

Setting parameters: 
<Cdirectory> <directory_name>

Example: See ​"Working with Files and Directories" on page 108.

Usage: Setting only
SCPI confirmed

:MMEMory:COPY <file_source>[,<file_destination>]

Copies an existing to a new file. Instead of just a file, this command can also be used to
copy a complete directory together with all its files.
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It is also possible to specify the path using another parameter. The command is:
MMEMory:COPY
<file_source><msus_source>[,<file_destination>,
<msus_destination>]
Setting parameters: 
<file_source> string

String parameter to specify the name of the file to be copied.
If <destination> is not specified, <source> is copied to the
MMEM:CDIR directory. Files which already exist with the same
name in the destination directory are overwritten without an error
message.
It is also possible to specify the path using another parameter. The
command is: MMEMory:COPY
<file_source><msus_source>[,<file_destination>,
<msus_destination>]

file_destination string
String parameter to specify the name of the new file. If no file des-
tination is specified, the source file is copied to the current direco-
try, queried with the MMEM:CDIR command. Files which already
exist with the same name in the destination directory are overwrit-
ten without an error message.

Example: See ​"Working with Files and Directories" on page 108.

Usage: Event
SCPI confirmed

:MMEMory:DATA <file_name>[,<binary block data>]
:MMEMory:DATA? <file_name>

Writes the block data <binary block data> to the file identified by <file_name>. The IEC/
IEEE-bus terminator should be set to EOI in order to ensure correct data transfer.

The associated query command transfers the specified file from the instrument to the
IEC/IEEE bus and then on to the control computer. It is important to ensure that the
intermediate memory on the control computer is large enough to take the file. In this case,
the setting for the IEC/IEEE-bus terminator is irrelevant. This command can be used to
read/transfer stored instrument settings or waveforms directly from/to the instrument.

Parameters:
<file_name> String parameter to specify the name of the file.

Setting parameters: 
<binary block data> #<number><length entry><block data>

# always comes first in the binary block
<number> the first digit indicates how many digits the subsequent
length entry has
<length entry> indicates the number of subsequent bytes
<binary block data> binary block data for the specified length.
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Example: MMEM:DATA 'TEST1.WV',#3767<binary data>
writes the block data to the file test1.wv.
The digit "3" indicates a length entry of 3 digits; the digits "767"
indicate a length of the binary data in bytes.
MMEM:DATA? 'TEST1.WV'
sends the data of the file Test1.wv from the instrumenet to the
controller in the form of a binary block.

:MMEMory:DCATalog?

Returns the subdirectories of the current or specified directory.

Query parameters: 
<path_name> String parameter to specify the directory. If the direcory is omitted,

the command queries the content of the current directory, queried
with MMEM:CDIR command.

Return values: 
<Dcatalog> <file_entry>

Names of the subdirectories separated by colons. The first two
strings are related to the parent directory.

Example: See ​"Working with Files and Directories" on page 108.

Usage: Query only

:MMEMory:DCATalog:LENGth? [<path_name>]

Returns the number of subdirectories in the current or specified directory.

Query parameters: 
<path_name> String parameter to specify the directory. If the directory is omitted,

the command queries the contents of the current directory, to be
queried with MMEM:CDIR command.

Return values: 
<file_entry_count> Number of parent and subdirectories.

Example: See ​"Working with Files and Directories" on page 108.

:MMEMory:DELete <Delete>

Removes a file from the specified directory.

Setting parameters: 
<Delete> <file_name>

String parameter to specify the name and directry of the file to be
removed.

Example: See ​"Working with Files and Directories" on page 108.

Usage: Event
SCPI confirmed
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:MMEMory:LOAD:STATe <sav_rcl_state_number>, <file_name>

This command loads the specified file stored under the specified name in an internal
memory.

After the file has been loaded, the instrument setting must be activated using an *RCL
command.

Setting parameters: 
<sav_rcl_state_number>Determines to the specific <number> to be used with the *RCL

command, e.g. *RCL 4.

<file_name> String parameter to specify the file name with extension
*.savrcltxt.

Example: See ​"Storing and Loading Current Settings" on page 108.

Usage: Setting only

:MMEMory:MDIRectory <directory_name>

Creates a new subdirectory for mass memory storage in the specified directory. If no
directory is specified, a subdirectory is created in the default directory. This command
can also be used to create a directory tree.

Setting parameters: 
<directory_name> string

String parameter to specify the new directory.

Example: See ​"Working with Files and Directories" on page 108.

Usage: Setting only

:MMEMory:MOVE <file_source>, <file_destination>

Moves an existing file to a new location or, if no path is specified, renames an existing
file.

It is also possible to specify the path using another parameter. The command is:

MMEMory:MOVE
file_source,msus_source[, file_destination, msus_destination]
Setting parameters: 
<file_source> String parameter to specify the name of the file to be moved.

<file_destination> String parameters to specify the name of the new file.

Example: See ​"Working with Files and Directories" on page 108.

Usage: Setting only
SCPI confirmed
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:MMEMory:MSIS <Msis>

The command is without effect for the Linux operating system.

Usage: SCPI confirmed

:MMEMory:RDIRectory <Rdirectory>

Removes an existing directory from the mass memory storage system. If no directory is
specified, the subdirectory with the specified name is deleted in the default directory.

Setting parameters: 
<Rdirectory> string

String parameter to specify the directory to be deleted.

Example: See ​"Working with Files and Directories" on page 108.

Usage: Setting only

:MMEMory:STORe:STATe <sav_rcl_state_number>, <file_name>

Stores the current instrument setting in the specified file.

The instrument setting must first be stored in an internal memory with the same number
using the common command *SAV.

Setting parameters: 
<sav_rcl_state_number>Corresponds to the specific <number> defined with the *SAV

command, e.g. *SAV 4.

<file_name> String parameter to specify the file name with extension
*.savrcltxt.

Example: See ​"Storing and Loading Current Settings" on page 108.

Usage: Event

7.10 OUTPut Subsystem

:​OUTPut[:​STATe]:​PON​...................................................................................................114
:​OUTPut[:​STATe]​...........................................................................................................115

:OUTPut[:STATe]:PON <Pon>

This command selects the state which the RF output assumes when the instrument is
switched on.
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Parameters:
<Pon> OFF | UNCHanged

OFF
The output is deactivated when the instrument is switched on.
UNCHanged
When the instrument is switched on, the output remains in the
same state as it was when the instrument was switched off.
*RST: UNCHanged

Example: See ​chapter 7.1.4, "Advanced Task for Optimizing Perform-
ance", on page 92.

:OUTPut[:STATe] <State>

This command activates and deactivates the RF output.

Parameters:
<State> 0 | 1 | OFF | ON

Example: See ​chapter 7.1.2, "Generating an I/Q Modulated Sig-
nal", on page 89.

7.11 SOURce Subsystem

[:​SOURce: ​]OPMode ​.......................................................................................................115
[:​SOURce: ​]FREQuency[:​CW|FIXed]​.................................................................................115
[:​SOURce: ​]LOSCillator: ​SOURce ​......................................................................................116

[:SOURce:]OPMode <OpMode>

Sets the operation mode.

Parameters:
<OpMode> NORMal | BBBYpass

NORMal: normal operation; BBBYpass: Baseband bypass mode.
*RST: NORMal

Example: See ​chapter 7.1.2, "Generating an I/Q Modulated Sig-
nal", on page 89.

[:SOURce:]FREQuency[:CW|FIXed] <Cw>

Sets the RF frequency at the RF output connector of the selected instrument.

Parameters:
<Cw> float

*RST: 1 GHz
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Example: See ​chapter 7.1.2, "Generating an I/Q Modulated Sig-
nal", on page 89.

[:SOURce:]LOSCillator:SOURce <Source>

Selects the source of the local oscillator signal.

Parameters:
<Source> INTernal | EXTernal

INT: use built oscillator; EXT: use signal at REF IN connector

*RST: INTernal

Example: See ​chapter 7.1.2, "Generating an I/Q Modulated Sig-
nal", on page 89.

7.12 SOURce:IQ Subsystem

[:​SOURce: ​]IQ:​STATe​.....................................................................................................116
[:​SOURce: ​]IQ:​IMPairment: ​IQRatio[:​MAGNitude] ​................................................................116
[:​SOURce: ​]IQ:​IMPairment: ​LEAKage: ​I​...............................................................................117
[:​SOURce: ​]IQ:​IMPairment: ​LEAKage: ​Q​.............................................................................117
[:​SOURce: ​]IQ:​IMPairment: ​QUADrature[: ​ANGLe] ​...............................................................117
[:​SOURce: ​]IQ:​IMPairment[:​STATe]​..................................................................................117
[:​SOURce: ​]IQ:​CREStfactor ​..............................................................................................117
[:​SOURce: ​]IQ:​WBSTate​..................................................................................................118

[:SOURce:]IQ:STATe <State>

Switches the I/Q modulation on and off.

Parameters:
<State> 0 | 1 | OFF | ON

*RST: 0

Example: See ​chapter 7.1.2, "Generating an I/Q Modulated Sig-
nal", on page 89.

[:SOURce:]IQ:IMPairment:IQRatio[:MAGNitude] <IqRatio>

Sets the ratio of I modulation to Q modulation (amplification “imbalance”). The input may
be either in dB or %. The resolution is 0.001 dB, an input in percent is rounded to the
closest valid value in dB. A query returns the value in dB.

Parameters:
<IqRatio> float

Range: -1  to  1
Increment: 1E-3
*RST: 0
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Example: See ​chapter 7.1.2, "Generating an I/Q Modulated Sig-
nal", on page 89.

[:SOURce:]IQ:IMPairment:LEAKage:I <I>
[:SOURce:]IQ:IMPairment:LEAKage:Q <Q>

This command sets the carrier leakage amplitude for the Q-signal component.

Parameters:
<Q> float

Range: -10  to  10
Increment: 0.01
*RST: 0
Default unit: PCT

Example: See ​chapter 7.1.2, "Generating an I/Q Modulated Sig-
nal", on page 89.

[:SOURce:]IQ:IMPairment:QUADrature[:ANGLe] <Angle>

This command sets the quadrature offset for the digital I/Q signal.

Parameters:
<Angle> float

Range: -10  to  10
Increment: 0.01
*RST: 0
Default unit: DEG

Example: See ​chapter 7.1.2, "Generating an I/Q Modulated Sig-
nal", on page 89.

[:SOURce:]IQ:IMPairment[:STATe] <State>

The command activates (ON) and deactivates (OFF) the three impairment or correction
values LEAKage, QUADrature and IQRatio for the baseband signal prior to input into the
I/Q modulator.

Parameters:
<State> 0 | 1 | OFF | ON

*RST: 0

Example: See ​chapter 7.1.2, "Generating an I/Q Modulated Sig-
nal", on page 89.

[:SOURce:]IQ:CREStfactor <CrestFactor>

Sets the crest factor of the IQ modulation signal.
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Parameters:
<CrestFactor> float

Range: 0  to  35
Increment: 0.01
*RST: 0

Example: see ​chapter 7.1.2, "Generating an I/Q Modulated Sig-
nal", on page 89

[:SOURce:]IQ:WBSTate <State>

Selects optimized settings for wideband modulation signals

Parameters:
<State> 0 | 1 | OFF | ON

*RST: 0

Example: See ​chapter 7.1.2, "Generating an I/Q Modulated Sig-
nal", on page 89.

7.13 SOURce:PHASe Subsystem

[:​SOURce: ​]PHASe ​.........................................................................................................118
[:​SOURce: ​]PHASe:​REFerence ​........................................................................................118

[:SOURce:]PHASe <Phase>

Specifies the phase variation relative to the current phase.

Parameters:
<Phase> float

Range: -360  to  360
*RST: 0
Default unit: DEG

Example: See ​chapter 7.1.2, "Generating an I/Q Modulated Sig-
nal", on page 89.

[:SOURce:]PHASe:REFerence

Adopts the phase set with command ​[: ​SOURce: ​]PHASe ​ as the current phase.

Example: See ​chapter 7.1.2, "Generating an I/Q Modulated Sig-
nal", on page 89.

Usage: Event
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7.14 SOURce:POWer Subsystem

[:​SOURce: ​]POWer:​ALC: ​SONCe ​......................................................................................119
[:​SOURce: ​]POWer:​LMODe ​.............................................................................................119
[:​SOURce: ​]POWer:​SCHaracteristic ​..................................................................................119
[:​SOURce: ​]POWer[:​LEVel][:​IMMediate][:​AMPLitude] ​..........................................................119
[:​SOURce: ​]POWer:​LIMit[:​AMPLitude] ​...............................................................................120
[:​SOURce: ​]POWer:​PEP​..................................................................................................120

[:SOURce:]POWer:ALC:SONCe

Briefly activates level control for correction purposes.

Example: See ​chapter 7.1.2, "Generating an I/Q Modulated Sig-
nal", on page 89.

[:SOURce:]POWer:LMODe <LevMode>

Selects the level mode.

Parameters:
<LevMode> NORM | LNOise | LDIStortion

NORM
automatic selection of the best settings
LNOISe
settings for lowest noise
LDIStortion
settings for lowest distortions

Example: See ​chapter 7.1.4, "Advanced Task for Optimizing Perform-
ance", on page 92.

[:SOURce:]POWer:SCHaracteristic <Characteristic>

Selects the characteristic for the level setting. For detailed description, see ​"Setting
Characteristic" on page 49.

Parameters:
<Characteristic> AUTO | UNINterrupted | CWSWr | USER | MONotone

UNINterrupted: Uninterrupted Level setting, CWSWr: Constant-
VSWR, MONotone: Strictly Monotone

*RST: AUTO

Example: See ​chapter 7.1.4, "Advanced Task for Optimizing Perform-
ance", on page 92.

[:SOURce:]POWer[:LEVel][:IMMediate][:AMPLitude] <Amplitude>

Sets the RF level at the RF output connector of the instrument.
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Parameters:
<Amplitude> float

Range: -130  to  30
*RST: -10

Example: See ​chapter 7.1.4, "Advanced Task for Optimizing Perform-
ance", on page 92.

[:SOURce:]POWer:LIMit[:AMPLitude] <Amplitude>

Sets the upper limit of the RF signal power.

The value is not affected by an instrument preset and *RST function. This parameter is
influenced only by the factory preset (SYST:FPR) and its factory value is equal to the
upper limit.

Parameters:
<Amplitude> float

Range: -300  to  30
*RST: 30
Default unit: dBm

Example: See ​chapter 7.1.4, "Advanced Task for Optimizing Perform-
ance", on page 92.

[:SOURce:]POWer:PEP?

Query the RF signal's peak envelope power.

Return values: 
<PEP> float

Example: see ​chapter 7.1.2, "Generating an I/Q Modulated Sig-
nal", on page 89

Usage: Query only

7.15 SOURce:ROSCillator Subsystem

[:​SOURce: ​]ROSCillator: ​EXTernal: ​FREQuency ​..................................................................120
[:​SOURce: ​]ROSCillator: ​OUTPut:​FREQuency ​....................................................................121
[:​SOURce: ​]ROSCillator: ​SOURce ​.....................................................................................121
[:​SOURce]:​ROSCillator[: ​INTernal]: ​ADJust:​VALue ​..............................................................121
[:​SOURce]:​ROSCillator[: ​INTernal]: ​ADJust[:​STATe]​............................................................121
[:​SOURce]:​ROSCillator: ​EXTernal: ​SBANdwidth ​.................................................................122

[:SOURce:]ROSCillator:EXTernal:FREQuency <ExtFreq>

Selects the frequency of the external reference.
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Parameters:
<ExtFreq> 10MHZ | 100MHZ | 1000MHZ

Example: See ​chapter 7.1.4, "Advanced Task for Optimizing Perform-
ance", on page 92.

[:SOURce:]ROSCillator:OUTPut:FREQuency <OutputFreq>

Selects the output for the reference oscillator signal.

Parameters:
<OutputFreq> 10MHZ | 100MHZ | 1000MHZ

Example: See ​chapter 7.1.4, "Advanced Task for Optimizing Perform-
ance", on page 92.

[:SOURce:]ROSCillator:SOURce <Source>

Select the reference oscillator signal source.

Parameters:
<Source> INTernal | EXTernal

Example: See ​chapter 7.1.2, "Generating an I/Q Modulated Sig-
nal", on page 89.

[:SOURce]:ROSCillator[:INTernal]:ADJust:VALue <Value>

Allows an application to shift the reference oscillator frequency by a small amount.

Parameters:
<Value> integer

Range: 0  to  65535
*RST: 32767

Example: See ​chapter 7.1.4, "Advanced Task for Optimizing Perform-
ance", on page 92.

[:SOURce]:ROSCillator[:INTernal]:ADJust[:STATe] <State>

The command determines whether the calibrated (OFF) or a user-defined (ON) adjust-
ment value is used for fine adjustment of the frequency. With STATe ON, the instrument
is no longer in the calibrated state. However, the calibration value is not changed and the
instrument resumes the calibrated state after switching the Adjustment State to Off.

Parameters:
<State> 0 | 1 | OFF | ON

*RST: 0

SOURce:ROSCillator Subsystem



Remote Control CommandsR&S®SGS100A

122User Manual 1173.9105.02 ─ 05

Example: ROSC:SOUR INT
selects the internal source.
ROSC:ADJ ON
activates use of a user-defined adjustment value.
ROSC:ADJ:VAL 1400
sets the adjustment value to 1400.

[:SOURce]:ROSCillator:EXTernal:SBANdwidth <Sbandwidth>

The command selects the synchronization bandwidth for an external reference signal.

Parameters:
<Sbandwidth> WIDE | NARRow

NARRow
Synchronization bandwidth is 40 Hz.
WIDE
Synchronization bandwidth is 250 Hz.

Example: ROSC:SOUR EXT
selects the external source.
ROSC:EXT:FREQ 5 MHz
informs the instrument that the external reference has a frequency
of 5 MHz.
ROSC:EXT:SBAN WID
selects wideband setting for synchronization bandwidth.

7.16 STATus Subsystem

This system contains the commands for the status reporting system. ​*RST ​ on page 98
has no effect on the status registers.

Queries return the current value of the respective register, which permits a check of the
device status. A decimal value between 0 and 32767 (=215-1) is returned.

The configuration commands set the respective register thus determining which status
changes of the R&S SGS causes the status registers to be changed. A decimal value
between 0 and 32767 (= 215-1) is set.

STATus:​OPERation: ​CONDition ​.......................................................................................123
STATus:​OPERation: ​ENABle ​...........................................................................................123
STATus:​OPERation[: ​EVENt]​...........................................................................................123
STATus:​OPERation: ​NTRansition ​.....................................................................................123
STATus:​OPERation: ​PTRansition ​.....................................................................................124
STATus:​PRESet ​............................................................................................................124
STATus:​QUEStionable: ​CONDition ​...................................................................................124
STATus:​QUEStionable: ​ENABle ​.......................................................................................125
STATus:​QUEStionable[: ​EVENt]​.......................................................................................125
STATus:​QUEStionable: ​NTRansition ​................................................................................125
STATus:​QUEStionable: ​PTRansition ​.................................................................................126
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STATus:​QUEue[:​NEXT]​..................................................................................................126

STATus:OPERation:CONDition? <Condition >

The command queries the content of the CONDition part of the STATus:OPERation reg-
ister. This part contains information on the action currently being performed in the instru-
ment. The content is not deleted after being read out since it indicates the current hard-
ware status.

Parameters:
<Condition > string

Example: STAT:OPER:COND
queries the Status:Operation:Condition register.

Usage: Query only
SCPI confirmed

STATus:OPERation:ENABle <Enable>

The command sets the bits of the ENABle part of the STATus:OPERation register. This
setting determines which events of the Status-Event part are forwarded to the sum bit in
the status byte. These events can be used for a service request.

Parameters:
<Enable> string

Example: STAT:OPER:ENAB 32767
all events are forwarded to the sum bit of the status byte.

Usage: SCPI confirmed

STATus:OPERation[:EVENt]? <EVENt>

The command queries the content of the EVENt part of the STATus:OPERation register.
This part contains information on the actions performed in the instrument since the last
readout. The content of the EVENt part is deleted after being read out.

Parameters:
<EVENt> string

Example: STAT:OPER:EVEN
queries the STATus:OPERation:EVENt register.

Usage: Query only
SCPI confirmed

STATus:OPERation:NTRansition <Ntransition>

The command sets the bits of the NTRansition part of the STATus:OPERation register.
If a bit is set, a transition from 1 to 0 in the condition part causes an entry to be made in
the EVENt part of the register. The disappearance of an event in the hardware is thus
registered, e.g. the end of an adjustment.
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Parameters:
<Ntransition> string

Example: STAT:OPER:NTR 0
a transition from 1 to 0 in the condition part of the Status:Operation
register does not cause an entry to be made in the EVENt part.

Usage: SCPI confirmed

STATus:OPERation:PTRansition <Ptransition>

The command sets the bits of the PTRansition part of the STATus:OPERation register.
If a bit is set, a transition from 0 to 1 in the condition part causes an entry to be made in
the EVENt part of the register. A new event in the hardware is thus registered, e.g. the
start of an adjustment.

Parameters:
<Ptransition> string

Example: STAT:OPER:PTR 32767
all transitions from 0 to 1 in the condition part of the Status:Oper-
ation register cause an entry to be made in the EVENt part.

Usage: SCPI confirmed

STATus:PRESet <Preset>

The command resets the status registers. All PTRansition parts are set to FFFFh (32767),
i.e. all transitions from 0 to 1 are detected. All NTRansition parts are set to 0, i.e. a tran-
sition from 1 to 0 in a CONDition bit is not detected. The ENABle parts of STATus:OPER-
ation and STATus:QUEStionable are set to 0, i.e. all events in these registers are not
passed on.

Parameters:
<Preset> string

Example: STAT:PRES
resets the status registers.

Usage: Event
SCPI confirmed

STATus:QUEStionable:CONDition? <Condition >

The command queries the content of the CONDition part of the STATus:QUEStionable
register. This part contains information on the action currently being performed in the
instrument. The content is not deleted after being read out since it indicates the current
hardware status.

Parameters:
<Condition > string
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Example: STAT:OPER:COND
queries the Status:Questionable:Condition register.

Usage: Query only
SCPI confirmed

STATus:QUEStionable:ENABle <Enable>

The command sets the bits of the ENABle part of the STATus:QUEStionable register.
This setting determines which events of the Status-Event part are enabled for the sum
bit in the status byte. These events can be used for a service request.

Parameters:
<Enable> string

Example: STAT:OPER:ENAB 1
problems when performing an adjustment cause an entry to be
made in the sum bit.

Usage: SCPI confirmed

STATus:QUEStionable[:EVENt]? <EVENt>

The command queries the content of the EVENt part of the STATus:QUEStionable
register. This part contains information on the actions performed in the instrument since
the last readout. The content of the EVENt part is deleted after being read out.

Parameters:
<EVENt> string

Example: STAT:QUES:EVEN?
queries the Status:Questionable:Event register.

Usage: Query only
SCPI confirmed

STATus:QUEStionable:NTRansition <Ntransition>

The command sets the bits of the NTRansition part of the STATus:QUEStionable register.
If a bit is set, a transition from 1 to 0 in the condition part causes an entry to be made in
the EVENt part of the register.

Parameters:
<Ntransition> string

Example: STAT:OPER:NTR 0
A transition from 1 to 0 in the condition part of the Status:Ques-
tionable register does not cause an entry to be made in the EVENt
part.

Usage: SCPI confirmed
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STATus:QUEStionable:PTRansition <Ptransition>

The command sets the bits of the NTRansition part of the STATus:QUEStionable register.
If a bit is set, a transition from 1 to 0 in the condition part causes an entry to be made in
the EVENt part of the register.

Parameters:
<Ptransition> string

Example: STAT:OPER:PTR 32767
All transitions from 0 to 1 in the condition part of the Status:Ques-
tionable register cause an entry to be made in the EVENt part.

Usage: SCPI confirmed

STATus:QUEue[:NEXT]?

The command queries the oldest entry in the error queue and then deletes it. Positive
error numbers denote device-specific errors, and negative error numbers denote error
messages defined by SCPI. If the error queue is empty, 0 ("No error") is returned. The
command is identical to SYSTem:ERRor?
Return values: 
<NEXT> string

Example: STAT:QUE
queries the oldest entry in the error queue.
Response: 0, 'no error'
No errors have occurred since the error queue was last read out.

Usage: Query only
SCPI confirmed

7.17 SYSTem Subsystem

The SYSTem subsystem contains a series of commands for general functions which do
not directly affect signal generation.

:​SYSTem:​DATE​.............................................................................................................127
:​SYSTem:​TIME​..............................................................................................................127
:​SYSTem:​EMODe ​..........................................................................................................127
SYSTem:​ERRor: ​ALL ​......................................................................................................128
SYSTem:​ERRor: ​CODE:​ALL ​............................................................................................128
SYSTem:​ERRor: ​CODE[:​NEXT]​.......................................................................................129
SYSTem:​ERRor: ​COUNt ​.................................................................................................129
SYSTem:​ERRor[: ​NEXT]​.................................................................................................129
SYSTem:​SERRor ​...........................................................................................................130
SYSTem:​VERSion ​.........................................................................................................130
:​SYSTem:​COMMunicate: ​NETWork:​IPADdress ​.................................................................130
:​SYSTem:​COMMunicate: ​NETWork:​IPADdress: ​MODE​.......................................................131
:​SYSTem:​COMMunicate: ​NETWork:​STATus​.....................................................................131
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:​SYSTem:​COMMunicate: ​NETWork[:​COMMon]:​DOMain ​.....................................................131
:​SYSTem:​COMMunicate: ​NETWork[:​COMMon]:​HOSTname ​...............................................131
:​SYSTem:​COMMunicate: ​NETWork[:​COMMon]:​WORKgroup ​..............................................132
:​SYSTem:​COMMunicate: ​NETWork[:​IPADdress]:​GATeway ​.................................................132
:​SYSTem:​COMMunicate: ​NETWork[:​IPADdress]:​SUBNet: ​MASK​.........................................132
:​SYSTem:​COMMunicate: ​NETWork:​RESource ​..................................................................132
:​SYSTem:​COMMunicate: ​HISLip: ​RESource ​.......................................................................133
:​SYSTem:​COMMunicate: ​PCIexpress: ​RESource ​...............................................................133
:​SYSTem:​COMMunicate: ​SOCKet:​RESource ​....................................................................133
:​SYSTem:​COMMunicate: ​USB:​RESource ​..........................................................................133
:​SYSTem:​PROTect<ch>[:​STATe]​....................................................................................133
:​SYSTem:​STARtup:​COMPlete ​.........................................................................................134
:​SYSTem:​HARDware: ​ASSembly<dir>: ​NAME ​....................................................................134
:​SYSTem:​HARDware: ​ASSembly<dir>: ​PNUMber ​...............................................................135
:​SYSTem:​HARDware: ​ASSembly<dir>: ​REVision ​................................................................135
:​SYSTem:​HARDware: ​ASSembly<dir>: ​SNUMber ​...............................................................135
:​SYSTem:​SOFTware:​OPTion<dir>: ​DESignation ​................................................................135
:​SYSTem:​SOFTware:​OPTion<dir>: ​EXPiration ​..................................................................136
:​SYSTem:​SOFTware:​OPTion<dir>: ​LICenses ​....................................................................136
:​SYSTem:​SOFTware:​OPTion<dir>: ​NAME ​........................................................................136

:SYSTem:DATE <Date>

The command queries / sets the date for the instrument-internal calendar.

This parameter is protected, in order to prevent accidental changes. It can be accessed
with protection level 1, see ​: ​SYSTem: ​PROTect<ch>[: ​STATe] ​ on page 133.

Parameters:
<Date> <year>,<month>,<day>

Example: SYST:DATE?
Response: 2011,05,01 - it is the 1st of May in 2011.

:SYSTem:TIME <Time>

The command queries / sets the time for the instrument-internal clock.

The parameter is protected, in order to prevent accidental changes. It can be accessed
with protection level 1, see ​: ​SYSTem: ​PROTect<ch>[: ​STATe] ​ on page 133.

Parameters:
<Time> 0...23,0...59,0...59

Example: SYST:TIME?
Response: 12,0,0 it is precisely 12 pm.

:SYSTem:EMODe <Mode>

Enables and selects the Eco Mode. With enabled eco mode EM1 the doubler stage in a
12 GHz instrument is permanently switched off to reduce power consumption and the
maximum frequency is limited to 6 GHz.
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Parameters:
<Mode> OFF | EM1

*RST: OFF

Example: see ​chapter 7.1.1, "Performing General Task for Instrument
Setup", on page 87

SYSTem:ERRor:ALL?

The command queries all entries in the error queue and then deletes them.

Parameters:
<All> string

0
"No error", i.e the error queue is empty.
positive value
Positive error numbers denote device-specific errors.
negative value
Negative error numbers denote error messages defined by SCPI

Example: SYST:ERR:ALL?
queries all entries in the error queue.
Response: 0, 'no error'
No errors have occurred since the error queue was last read out.

Usage: Query only

SYSTem:ERRor:CODE:ALL?

The command queries all entries in the error queue and then deletes them. Only the error
numbers are returned and not the entire error text.

Return values: 
<All> string

0
"No error", i.e. the error queue is empty
positive value
Positive error numbers denote device-specific errors
negative value
Negative error numbers denote error messages defined by SCPI.

Example: SYST:ERR:CODE:ALL
queries all entries in the error queue.
Response: 0
no errors have occurred since the error queue was last read out.

Usage: Query only
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SYSTem:ERRor:CODE[:NEXT]?

The command queries the oldest entry in the error queue and then deletes it. Only the
error number is returned and not the entire error text.

Return values: 
<Next> string

0
"No error", i.e. the error queue is empty
positive value
Positive error numbers denote device-specific errors
negative value
Negative error numbers denote error messages defined by SCPI.

Example: SYST:ERR:CODE
queries the oldest entry in the error queue.
Response: 0
No errors have occurred since the error queue was last read out.

Usage: Query only

SYSTem:ERRor:COUNt?

The command queries the number of entries in the error queue. If the error queue is
empty, '0' is returned.

Return values: 
<Count> string

Example: SYST:ERR:COUN
queries the number of entries in the error queue.
Response: 1
One error has occurred since the error queue was last read out.

Usage: Query only

SYSTem:ERRor[:NEXT]?

The command queries the oldest entry in the error queue and then deletes it.

The command is identical to the command STATus:QUEue:NEXT.

Return values: 
<Next> string

0
"No error", i.e. the error queue is empty
positive value
Positive error numbers denote device-specific errors
negative value
Negative error numbers denote error messages defined by SCPI.
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Example: SYST:ERR?
queries the oldest entry in the error queue.
Response: 0, 'no error'
No errors have occurred since the error queue was last read out.

Usage: Query only

SYSTem:SERRor?

This command returns a list of all errors existing at the time when the query is started.
This list corresponds to the display on the info page under manual control.

Return values: 
<Serror> string

Example: SYST:SERR
queries all errors existing in the error queue.

Example: Response: -221, 'Settings conflict', 153, 'Input
voltage out of range'
The two returned errors have occurred since the error queue was
last queried.

Usage: Query only

SYSTem:VERSion?

The command queries the SCPI version with which the instrument complies.

Return values: 
<Version> string

Example: SYST:VERS
queries the SCPI version.
Response: 1996
The instrument complies with the version from 1996.

Usage: Query only

:SYSTem:COMMunicate:NETWork:IPADdress <Ipaddress>

The command enters the IP address. The entry is only activated after sending command
SYST:COMM:NETW:IPAD:SET.

Parameters:
<Ipaddress> string

Range: 0.0.0.0.  to  ff.ff.ff.ff

Example: SYST:COMM:NETW:IPAD  7.8.9.10
enters the IP address of the instrument.

Example: SYST:COMM:NETW:IPAD:SET
activates all changes of the IP address settings.
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:SYSTem:COMMunicate:NETWork:IPADdress:MODE <Mode>

The command selects if the IP address is assigned automatically or manually. The entry
is only activated after sending command SYST:COMM:NETW:IPAD:SET.

Parameters:
<Mode> AUTO | STATic

AUTO
The IP address is assigned automatically. The network used must
support automatic assignment of address (DHCP) in order to use
this function.
STATic
The IP address is assigned manually.
*RST: AUTO

Example: SYST:COMM:NETW:IPAD:MODE AUTO
the IP address is assigned automatically (DHCP).
SYST:COMM:NETW:IPAD:SET ON
activates DHCP.

:SYSTem:COMMunicate:NETWork:STATus?

Queries the network configuration state.

Return values: 
<State> 0 | 1 | OFF | ON

Usage: Query only

:SYSTem:COMMunicate:NETWork[:COMMon]:DOMain <Domain>

The command enters the domain of the network.

Parameters:
<Domain> string

Example: SYST:COMM:NETW:COMM:DOM ABC.DE
enters the domain of the network.

:SYSTem:COMMunicate:NETWork[:COMMon]:HOSTname <Hostname>

The command enters the individual computer name of the R&S SGS. The entry is only
activated after sending command SYST:COMM:NETW:COMM:SET.

Note: The hostname can only be changed after deactivating protection level 1 (command
SYSTem:PROTect<n>:STATe OFF, password)

Parameters:
<Hostname> string

Example: SYST:COMM:NETW:HOST ‘SIGGEN’
enters the individual computer name of the R&S SGS.
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Example: SYST:COMM:NETW:COMM:SET ON
activates the change of the hostname.

:SYSTem:COMMunicate:NETWork[:COMMon]:WORKgroup <Workgroup>

The command enters the individual workgroup name of the instrument.

Parameters:
<Workgroup> string

Example: SYST:COMM:NETW:COMM:WORK 'TEST_09'
enters the workgroup name 'TEST_09'.

:SYSTem:COMMunicate:NETWork[:IPADdress]:GATeway <Gateway>

The command enters the IP address of the default gateway. The entry is only activated
after sending command SYST:COMM:NETW:IPAD:SET.

Parameters:
<Gateway> string

Range: 0.0.0.0  to  ff.ff.ff.ff

Example: SYST:COMM:NETW:GAT 1.2.3.4
enters the IP address of the default gateway.
SYST:COMM:NETW:IPAD:SET
activates all changes of the IP address settings.

:SYSTem:COMMunicate:NETWork[:IPADdress]:SUBNet:MASK <Mask>

The command enters the Subnet mask. The entry is only activated after sending com-
mand SYST:COMM:NETW:IPAD:SET.

Parameters:
<Mask> string

Example: SYST:COMM:NETW:SUBN:MASK 255.255.0.0
enters the Subnet mask.
SYST:COMM:NETW:IPAD:SET
activates all changes of the IP address settings.

:SYSTem:COMMunicate:NETWork:RESource <Resource>

The command queries the VISA resource string. This string is used for remote control of
the instrument with VXI-11 protocol.

Parameters:
<Resource> string

Example: SYST:COMM:NETW:RES
queries the VISA resource string.
Response: TCPIP::192.1.2.3::INSTR
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:SYSTem:COMMunicate:HISLip:RESource

Queries the VISA resource string . This string is used for remote control of the instrument
with HiSLIP protocol.

Parameters:
<Resource> string

Example: SYST:COMM:HISL:RES
queries the VISA resource string.
Response: TCPIP::192.1.2.3::hislip0::INSTR

:SYSTem:COMMunicate:PCIexpress:RESource?

The command queries the visa resource string for remote control via the PCIe interface.

Return values: 
<Resource> string

Usage: Query only

:SYSTem:COMMunicate:SOCKet:RESource?

The command queries the visa resource string for remote control via the Socket interface.

Return values: 
<Resource> string

Example: SYST:COMM:SOCK:RES?
Usage: Query only

:SYSTem:COMMunicate:USB:RESource?

The command queries the visa resource string for remote control via the USB interface.

Return values: 
<Resource> string

Example: SYST:COMM:USB:RES?
queries the VISA resource string for remote control via the USB
interface.
Response: USB::72::000000::INSTR

Usage: Query only

:SYSTem:PROTect<ch>[:STATe] <State>,<password>

The command activates and deactivates the specified protection level.
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Suffix: 
<ch>

.
Indicates the protection level.
There are several protection levels which disable specific service
functions (authorized personnel of R&S Service Departments
only).

Parameters:
<State> 0 | 1 | OFF | ON

<password> The respective functions are disabled when the protection level is
activated. No password is required for activation. A password must
be entered to deactivate the protection level. The password for the
first level is 123456. This protection level can be used to lock-out
internal adjustments.

Example: SYST:PROT1 ON
activates protection level 1. Internal adjustments are only possible
after deactivating the lock-out.
SYST:PROT1 OFF, 123456
deactivates protection level 1. Internal adjustments are enabled
again.

Usage: SCPI confirmed

:SYSTem:STARtup:COMPlete?

The command queries if the startup of the instrument is completed.

Return values: 
<Complete> 0 | 1 | OFF | ON

*RST: 0

Example: SYST:STAR:COMP
Response: 1
The startup of the instrument is completed.

Usage: Query only

:SYSTem:HARDware:ASSembly<dir>:NAME?

The query returns a list of hardware assembly names.

Suffix: 
<dir>

.
1..2
Defines the section: 1 = common assembly, 2 = RF assembly.

Return values: 
<Name> string

Example: See ​chapter 7.1.1, "Performing General Task for Instrument
Setup", on page 87.

Usage: Query only
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:SYSTem:HARDware:ASSembly<dir>:PNUMber?

The query returns the list of hardware module part numbers.

Suffix: 
<dir>

.
1..2
Defines the section: 1 = common assembly, 2 = RF assembly.

Return values: 
<PNumber> string

Example: See ​chapter 7.1.1, "Performing General Task for Instrument
Setup", on page 87.

Usage: Query only

:SYSTem:HARDware:ASSembly<dir>:REVision?

The query returns the list of hardware module revisions.

Suffix: 
<dir>

.
1..2
Defines the section: 1 = common assembly, 2 = RF assembly.

Return values: 
<Revision> string

Example: See ​chapter 7.1.1, "Performing General Task for Instrument
Setup", on page 87.

Usage: Query only

:SYSTem:HARDware:ASSembly<dir>:SNUMber?

The query returns the list of hardware module serial numbers.

Suffix: 
<dir>

.
1..2
Defines the section: 1 = common assembly, 2 = RF assembly.

Return values: 
<SNumber> string

Example: See ​chapter 7.1.1, "Performing General Task for Instrument
Setup", on page 87.

Usage: Query only

:SYSTem:SOFTware:OPTion<dir>:DESignation?

The query returns the list of option descriptions.

Suffix: 
<dir>

.
1..2
Defines the section: 1 = hardware, 2 = software.
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Return values: 
<Designation> string

Example: See ​chapter 7.1.1, "Performing General Task for Instrument
Setup", on page 87.

Usage: Query only

:SYSTem:SOFTware:OPTion<dir>:EXPiration?

The query returns the list of option expiration informations.

Suffix: 
<dir>

.
1..2
Defines the section: 1 = hardware, 2 = software.

Return values: 
<Expiration> string

Example: See ​chapter 7.1.1, "Performing General Task for Instrument
Setup", on page 87.

Usage: Query only

:SYSTem:SOFTware:OPTion<dir>:LICenses?

The query returns the list of option license counts.

Suffix: 
<dir>

.
1..2
Defines the section: 1 = hardware, 2 = software.

Return values: 
<Licenses> string

Example: See ​chapter 7.1.1, "Performing General Task for Instrument
Setup", on page 87.

Usage: Query only

:SYSTem:SOFTware:OPTion<dir>:NAME?

The query returns the list of option names.

Suffix: 
<dir>

.
1..2
Defines the section: 1 = hardware, 2 = software.

Return values: 
<Name> string

Example: See ​chapter 7.1.1, "Performing General Task for Instrument
Setup", on page 87.

Usage: Query only
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7.18 TEST Subsystem

The TEST system contains the commands for performing the routines as well as for direct
manipulation of the hardware assemblies (:TEST:DIRect).

The self tests return a "0" if the test is performed successfully, otherwise a value other
than "0" is returned. None of the commands of this system have an *RST value.

Improper use may destroy the assembly!
The respective hardware assembly responds directly to the :TEST:DIRect command;
any safety mechanisms are bypassed. The command is used for servicing purposes and
should not be applied by the user.

:​TEST:​ALL: ​STARt​..........................................................................................................137
:​TEST:​ALL: ​RESult ​.........................................................................................................137
:​TEST<hw>:​DIRect ​........................................................................................................137
:​TEST<hw>:​DIRect:​BLOCk:​READ ​...................................................................................138
:​TEST<hw>:​DIRect:​BLOCk:​WRITe​..................................................................................138

:TEST:ALL:STARt

Starts the selftest. Use the command ​: ​TEST: ​ALL: ​RESult ​ to query the result.

Example: See ​chapter 7.1.1, "Performing General Task for Instrument
Setup", on page 87.

Usage: Event

:TEST:ALL:RESult?

Queries the result of the performed selftest. Start the selftest with ​: ​TEST: ​ALL: ​STARt ​.

Return values: 
<Result> 0 | 1 | RUNning | STOPped

*RST: STOPped

Example: See ​chapter 7.1.1, "Performing General Task for Instrument
Setup", on page 87.

Usage: Query only

:TEST<hw>:DIRect <Board>, <SubAddr>, <HexDataString>
:TEST<hw>:DIRect? <Board>, <SubAddr>

The respective hardware assembly responds directly to the command; any safety mech-
anisms are bypassed. This function is only available via remote control.
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Parameters:
<Direct> string

Example: TEST:DIR 'SCPI',0,#H12345678
TEST:DIR? 'SCPI',0
Response: #H12345678

:TEST<hw>:DIRect:BLOCk:READ? <Board>, <SubAddr>, <Addr>[, <Len>]

The respective hardware assembly responds directly to the command; any safety mech-
anisms are bypassed. This function is only available via remote control.

Query parameters: 
<Board> string

<SubAddr> number

<Addr> number

<Len> number

Return values: 
<Data> string

Example: TEST:DIR:BLOC:READ? 'TEST_SCPI',0,0,8
Usage: Query only

:TEST<hw>:DIRect:BLOCk:WRITe <Write>

The respective hardware assembly responds directly to the command; any safety mech-
anisms are bypassed. This function is only available via remote control.

Setting parameters: 
<Write> string

<Board>, <SubAddr>, <Addr>, <Data>

Example: TEST:DIR:BLOC:WRIT 'TEST_SCPI',0,0,#1812345678
Usage: Setting only

7.19 UNIT Subsystem

The UNIT subsystem contains the commands specifying which units are valid if no unit
is indicated in a command. These settings are valid for the entire instrument.

:UNIT:ANGLe <Angle>

The command not influence the manual control parameter unit and the display.

Parameters:
<Angle> DEGree | DEGRee | RADian

*RST: RADian
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Example: UNIT:ANGL DEG
sets default unit DEG for all commands which determine angle
values.

:UNIT:POWer <Power>

The command defines the default unit for power. It is valid for all commands which deter-
mine power values. It does not influence the manual control parameter unit and the dis-
play.

Parameters:
<Power> V | DBUV | DBM

*RST: DBM

Example: UNIT:POW V
sets default unit V for all commands which determine power val-
ues.

7.20 R&S SGMA-GUI Settings

This section comprises the SCPI commands provided to remote control the R&S SGMA-
GUI.

:​INSTruments:​ACTive[:​STATe]​........................................................................................139
:​INSTruments:​COUNt ​.....................................................................................................140
:​INSTruments:​EACCess[: ​STATe]​.....................................................................................140
:​INSTruments:​MAPPing: ​FILE​..........................................................................................140
:​INSTruments:​NAME ​......................................................................................................140
:​INSTruments:​REMote: ​CHANnel ​.....................................................................................141
:​INSTruments:​REMote: ​NAME ​.........................................................................................141
:​INSTruments:​SCAN ​......................................................................................................141
:​INSTruments:​SCAN: ​HNPRefix ​.......................................................................................141
:​INSTruments:​SERial ​.....................................................................................................141
:​INSTruments:​TYPE​.......................................................................................................142

:INSTruments:ACTive[:STATe] <State>

Enables/disables the instrument for the R&S SGMA-GUI. The main panel of this software
displays only activated istruments.

Parameters:
<State> List of BOOL-values

<StateInstr#1>,<StateInstr#2>,...
0, 1, ON, OFF

Example: See ​chapter 7.1.5, "Configuring Instruments in the R&S SGMA-
GUI", on page 93.
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:INSTruments:COUNt?

Queries the number of the currently available instruments.

Return values: 
<Count> float

Range: 0  to  12

Example: See ​chapter 7.1.5, "Configuring Instruments in the R&S SGMA-
GUI", on page 93.

Usage: Query only

:INSTruments:EACCess[:STATe] <State>

"Locks" the instruments, i.e. the instrument is reserved and can be operated exclusively
from the remote PC from that this SCPI command is sent.

Tip: It is recommended to lock the instrument prior to further configuration.

Parameters:
<State> List of BOOL-values

<LockInstr#1>,<LockInstr#2>,...
0,1,OFF,ON

Example: See ​chapter 7.1.5, "Configuring Instruments in the R&S SGMA-
GUI", on page 93.

:INSTruments:MAPPing:FILE <File>

Saves the list of the available instruments in a mapping file. Mapping files are stored with
the predefined file extension .map; the file extension may be ommited.

The file is saved in the default directory. Use the command MMEM:CDIRectory to
change the default directory or specify the compete path.

Parameters:
<File> string

Example: See ​chapter 7.1.5, "Configuring Instruments in the R&S SGMA-
GUI", on page 93.

:INSTruments:NAME <Name>

Selects the alias name of the instruments, i.e. sets the "Symbolic Name".

Parameters:
<Name> <SymbolicNameInstr#1>,<SymbolicNameInstr#2>,...

Example: See ​chapter 7.1.5, "Configuring Instruments in the R&S SGMA-
GUI", on page 93.
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:INSTruments:REMote:CHANnel <Channel>

Sets the hardware interface used by the remote channel.

Parameters:
<Channel> List of CHAR-Data

<Channellnstr#1>,<Channellnstr#2>,...
The available interfaces are: LAN, USB, SOCKET, PCIe

Example: See ​chapter 7.1.5, "Configuring Instruments in the R&S SGMA-
GUI", on page 93.

:INSTruments:REMote:NAME <Name>

Enters the IP Address or the host name of the connected instrument.

Parameters:
<Name> <Hostname/IP-AddressInsr#1>,<Hostname/IP-Addres-

sInsr#2>,...

Example: See ​chapter 7.1.5, "Configuring Instruments in the R&S SGMA-
GUI", on page 93.

:INSTruments:SCAN <State>

Triggers a scan function and searches for instruments connected to the remote computer
via all of the available interfaces.

Parameters:
<State> number

1 = triggers the scan function, 0 = aborts the running scan process
The query command returns 1 as long as scan is running; 0 indi-
cates completed scan process.

Example: See ​chapter 7.1.5, "Configuring Instruments in the R&S SGMA-
GUI", on page 93.

:INSTruments:SCAN:HNPRefix <Prefix>

Sets the prefix the searched host names begin with.

Parameters:
<Prefix> string

Example: See ​chapter 7.1.5, "Configuring Instruments in the R&S SGMA-
GUI", on page 93.

:INSTruments:SERial <Serial>

Enters the serial number as instrument's identification while using the USB interface for
remote control.
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Parameters:
<Serial> <SerivalNumberInstr#1>, <SerivalNumberInstr#2>,...

Example: See ​chapter 7.1.5, "Configuring Instruments in the R&S SGMA-
GUI", on page 93.

:INSTruments:TYPE <Type>

Selects the instrument's family.

Parameters:
<Type> List of CHAR-Data

<TypeInstr#1>,<TypeInstr#2>,...
Available instrument types: SGS

Example: See ​chapter 7.1.5, "Configuring Instruments in the R&S SGMA-
GUI", on page 93.
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8 Maintenance
The instrument does not need a periodic maintenance. Only cleaning the instrument is
essential.

Follow the instructions in the service manual and the safety instructions when exchanging
modules or ordering spare parts. The order number for spare parts is included in the
service manual. The service manual includes further information particularly on trouble-
shooting, repair, exchange of modules (including battery exchange, adjustment of the
OCXO oscillator) and alignment.

The address of our support center and a list of all Rohde & Schwarz service centers can
be found at the beginning of this manual.

8.1 Cleaning

The outside of the instrument can be cleaned sufficiently using a soft, lint-free dust cloth.
Make sure that the fan openings are not obstructed.

Shock hazard
Before cleaning the instrument, make sure that the instrument is switched off and dis-
connected from all power supplies.

Instrument damage caused by cleaning agents
Cleaning agents contain substances that may damage the instrument, e.g. cleaning
agents that contain a solvent may damage the front panel labeling or plastic parts.
Never use cleaning agents such as solvents (thinners, acetone, etc), acids, bases, or
other substances.
The outside of the instrument can be cleaned sufficiently using a soft, lint-free dust cloth.

Risk of instrument damage due to obstructed fans
If the instrument is operated in dusty areas, the fans may become obstructed by dust or
other particles in the process of time. Make sure to check and, if necessary, clean the
fans regularly to ensure they operate properly at all times. If the instrument is run with
obstructed fans for a longer period, it may become overheated which may cause damage.

 

 

Cleaning



MaintenanceR&S®SGS100A

144User Manual 1173.9105.02 ─ 05

8.2 Storing and Packing

The storage temperature range of the instrument is given in the data sheet. If the instru-
ment is to be stored for a longer period of time, it must be protected against dust.

Repack the instrument as it was originally packed when transporting or shipping. The two
protective foam plastic parts prevent the control elements and connectors from being
damaged. The antistatic packing foil avoids any undesired electrostatic charging to occur.

If you do not use the original packaging, use a sturdy cardboard box of suitable size and
provide for sufficient padding to prevent the instrument from slipping inside the package.
Wrap antistatic packing foil around the instrument to protect it from electrostatic charging.
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9 Error Messages and Troubleshooting
This chapter describes the error messages of the R&S SGS. The error messages are
output in the "Info" line on the screen and entered in the error/event queue of the status
reporting system.

A great variety of different messages such as status messages, error messages, warn-
ings or information are displayed in the header field of the screen. Some error messages
require that the error must be eliminated before correct instrument operation can be
ensured. The "Info" window with a list of current messages and a detailed description of
each message can be opened with the "Info" button (see also ​chapter 3.2.1, "Info Dia-
log", on page 32).

9.1 Status Information

The status messages are displayed in the Info line of the R&S SGMA-GUI main panel.
The status information gives the user an overview of the main operating states and set-
tings of the instrument. The states are indicated for information only and do not neces-
sitate any action by the user.

Status Information displayed in the Info line

AttFixed
Attenuator fixed mode is active.

The uninterrupted level settings are made in a fixed range without attenuator switching.
The variation range is set automatically when this mode is activated. The range is dis-
played with the parameter "SGMA-GUI > Instrument Name > Level > Attenuator Fixed
Range".

9.2 Error Messages

Messages indicate errors in the instrument. They are displayed in the info line in different
colors depending on their importance and display duration. Errors (e.g. no calibration
data) are displayed in red, information (e.g. file not found) and warnings in black. Warn-
ings indicate less significant errors (e.g. the instrument operates outside specified data).

See also ​chapter 3.2.1, "Info Dialog", on page 32 and ​chapter 3.2.2, "Understanding the
Messages in the Info Bar", on page 33.

9.2.1 Volatile messages

Volatile messages report automatic settings in the instrument (e.g. switching off of incom-
patible types of modulation) or on illegal entries that are not accepted by the instrument
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(e.g. range violations). They are displayed in the info line on a yellow background. They
are displayed on top of status information or permanent messages.

Volatile messages do not normally demand user actions and disappear automatically
after a brief period of time. They are stored in the history, however.

SCPI command: ​SYSTem: ​ERRor: ​ALL ​ and ​SYSTem: ​ERRor[: ​NEXT] ​.

9.2.2 Permanent messages

Permanent messages are displayed if an error occurs that impairs further instrument
operation, e.g. a hardware fault. The error signaled by a permanent message must be
eliminated before correct instrument operation can be ensured.

The message is displayed until the error is eliminated. It covers the status display in the
info line. After error elimination, the message automatically disappears and is also recor-
ded in the history.

SCPI command: ​SYSTem: ​SERRor ​

9.3 SCPI-Error Messages

The SCPI error messages are the same in all SCPI instruments. Detailed information and
an overview of all error messages as defined in SCPI standard can be found in the cor-
responding documentation.

The errors are assigned negative numbers. The error text being entered into the error/
event queue or being displayed is printed in bold face on the left together with the error
code. Below the error text, there is an explanation as to the respective error.

9.4 Device-Specific Error Messages

The following table contains all error messages specific for the instrument in alphabetical
order, as well as an explanation of the error situation. The positive error codes mark the
errors specific of the instrument.

The device-specific error messages set bit 3 in the ESR register.

The index provides a list of the error messages sorted according to their error codes.
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Error
Code

Error Description Remedy

180 Adjustment failed Adjustment could not be executed The adjustment data have to be
generated first by an internal or
external adjustment or to be loa-
ded into the device.

182 Adjustment data miss-
ing

Adjustment data are missing. The adjustment data have to be
generated first by an internal or
external adjustment or to be loa-
ded into the instrument.

183 Adjustment data invalid Adjustment data are invalid and must
be restored.

The adjustment data have to be
generated again by an internal or
external adjustment or to be loa-
ded into the instrument.

200 Cannot access hard-
ware

The data transmission to a module was
unsuccessful.

The module is not installed, not
properly installed or missing.

201 Hardware revision out
of date

A later version of certain parts of the
instrument is necessary to execute the
function selected.

The driver does not support the
installed version of a module.

202 Cannot access the
EEPROM

A error occurs when writing or reading
a EEPROM.

The EEPROM might be defect
and has to be replaced.

203 Invalid EEPROM data   

204 Driver initialization
failed

Initialization of a driver fails when boot-
ing the instrument firmware.

The driver is not compatible with
the hardware or software configu-
ration of the instrument.

241 No current list There is no list selected. To execute the required opera-
tion, a list has to be selected in the
related dialog. If no list is availa-
ble, a new list must be created.

242 Unknown list type
specified

The list type selected is not valid for the
required operation.

For instance, the file extension for
mapping files is *.map. It is not possi-
ble to enter another file extension when
selecting a list.

Check the selected list type.

460 Cannot open file The selected file can not be opened. Check the path and file name.

461 Cannot write file The file can not be written. Check if the file is read-only.

462 Cannot read file The file can not be read. Check if the file contents are com-
patible with the file type.

463 Filename missing The required operation cannot be exe-
cuted because the file name is not
specified.

A file name has to be entered
when creating a new list.

464 Invalid filename exten-
sion

The file extension is not valid for the
required operation.

Check the file extension.

For instance, the file extension for
the mapping files is *.map. It is
not possible to enter another file
extension when storing a list.
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Error
Code

Error Description Remedy

465 File contains invalid
data

The selected file contains data that is
not valid for the file type.

Check the file extension.

The file extension determines the
data that is valid for this file type.
If the file extension is changed the
lists are no longer recognized and
the data are therefore invalid.

468 Cannot find directory Required folder cannot be found. Check drive and path.

469 No files found Folder is empty  

Device-Specific Error Messages
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A Remote Control Basics
This chapter provides basic information on operating an instrument via remote control.

A.1 Messages

The messages transferred on the data lines are divided into the following categories:

● Interface messages
Interface messages are transmitted to the instrument on the data lines, with the
attention line being active (LOW). They are used to communicate between the con-
troller and the instrument. Interface messages can only be sent by instruments that
have GPIB bus functionality. For details see the sections for the required interface.

● Instrument messages
Instrument messages are employed in the same way for all interfaces, if not indicated
otherwise in the description. Structure and syntax of the instrument messages are
described in ​chapter A.3, "SCPI Command Structure", on page 150. A detailed
description of all messages available for the instrument is provided in the chapter
"Remote Control Commands".
There are different types of instrument messages, depending on the direction they
are sent:
– Commands
– Instrument responses

Commands

Commands (program messages) are messages the controller sends to the instrument.
They operate the instrument functions and request information. The commands are sub-
divided according to two criteria:
● According to the effect they have on the instrument:

– Setting commands cause instrument settings such as a reset of the instrument
or setting the frequency.

– Queries cause data to be provided for remote control, e.g. for identification of the
instrument or polling a parameter value. Queries are formed by directly appending
a question mark to the command header.

● According to their definition in standards:
– Common commands: their function and syntax are precisely defined in standard

IEEE 488.2. They are employed identically on all instruments (if implemented).
They refer to functions such as management of the standardized status registers,
reset and self test.

– Instrument control commands refer to functions depending on the features of
the instrument such as frequency settings. Many of these commands have also
been standardized by the SCPI committee. These commands are marked as
"SCPI compliant" in the command reference chapters. Commands without this
SCPI label are device-specific, however, their syntax follows SCPI rules as per-
mitted by the standard.
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Instrument responses

Instrument responses (response messages and service requests) are messages the
instrument sends to the controller after a query. They can contain measurement results,
instrument settings and information on the instrument status.

A.2 LAN Interface Messages

In the LAN connection, the interface messages are called low–level control messages.
These messages can be used to emulate interface messages of the GPIB bus.

Command Long term Effect on the instrument

&ABO Abort Aborts processing of the commands just received.

&DCL Device Clear Aborts processing of the commands just received and sets
the command processing software to a defined initial state.
Does not change the instrument setting.

&GTL Go to Local Transition to the "local" state (manual control).

&GTR Go to Remote Transition to the "remote" state (remote control).

&GET Group Execute Trigger Triggers a previously active instrument function (e.g. a
sweep). The effect of the command is the same as with that
of a pulse at the external trigger signal input.

&LLO Local Lockout Disables switchover from remote control to manual control
by means of the front panel keys.

&NREN Not Remote Enable Enables switchover from remote control to manual opera-
tion by means of the front panel keys

&POL Serial Poll Starts a serial poll.

A.3 SCPI Command Structure

SCPI commands consist of a so-called header and, in most cases, one or more param-
eters. The header and the parameters are separated by a "white space" (ASCII code 0
to 9, 11 to 32 decimal, e.g. blank). The headers may consist of several mnemonics (key-
words). Queries are formed by appending a question mark directly to the header.

The commands can be either device-specific or device-independent (common com-
mands). Common and device-specific commands differ in their syntax.

A.3.1 Syntax for Common Commands

Common (=device-independent) commands consist of a header preceded by an asterisk
(*) and possibly one or more parameters.

Examples:

 

 

 

LAN Interface Messages



Remote Control BasicsR&S®SGS100A

151User Manual 1173.9105.02 ─ 05

*RST RESET Resets the instrument.

*ESE EVENT STATUS ENABLE Sets the bits of the event status enable
registers.

*ESR? EVENT STATUS QUERY Queries the contents of the event status
register.

*IDN? IDENTIFICATION QUERY Queries the instrument identification
string.

A.3.2 Syntax for Device-Specific Commands

Not all commands used in the following examples are necessarily implemented in the
instrument.
For demonstration purposes only, assume the existence of the following commands for
this section:
● DISPlay[:WINDow<1...4>]:MAXimize <Boolean>
● FORMat:READings:DATA <type>[,<length>]
● HCOPy:DEVice:COLor <Boolean>
● HCOPy:DEVice:CMAP:COLor:RGB <red>,<green>,<blue>
● HCOPy[:IMMediate]
● HCOPy:ITEM:ALL
● HCOPy:ITEM:LABel <string>
● HCOPy:PAGE:DIMensions:QUADrant[<N>]
● HCOPy:PAGE:ORIentation LANDscape | PORTrait
● HCOPy:PAGE:SCALe <numeric value>
● MMEMory:COPY <file_source>,<file_destination>
● SENSE:BANDwidth|BWIDth[:RESolution] <numeric_value>
● SENSe:FREQuency:STOP <numeric value>
● SENSe:LIST:FREQuency <numeric_value>{,<numeric_value>}

Long and short form

The mnemonics feature a long form and a short form. The short form is marked by upper
case letters, the long form corresponds to the complete word. Either the short form or the
long form can be entered; other abbreviations are not permitted.

Example: 
HCOPy:DEVice:COLor ON is equivalent to HCOP:DEV:COL ON.

Case-insensitivity
Upper case and lower case notation only serves to distinguish the two forms in the man-
ual, the instrument itself is case-insensitive.
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Numeric suffixes

If a command can be applied to multiple instances of an object, e.g. specific channels or
sources, the required instances can be specified by a suffix added to the command.
Numeric suffixes are indicated by angular brackets (<1...4>, <n>, <i>) and are replaced
by a single value in the command. Entries without a suffix are interpreted as having the
suffix 1.

Example: 
Definition: HCOPy:PAGE:DIMensions:QUADrant[<N>]
Command: HCOP:PAGE:DIM:QUAD2
This command refers to the quadrant 2.

Different numbering in remote control
For remote control, the suffix may differ from the number of the corresponding selection
used in manual operation. SCPI prescribes that suffix counting starts with 1. Suffix 1 is
the default state and used when no specific suffix is specified.
Some standards define a fixed numbering, starting with 0. If the numbering differs in
manual operation and remote control, it is indicated for the corresponding command.

Optional mnemonics

Some command systems permit certain mnemonics to be inserted into the header or
omitted. These mnemonics are marked by square brackets in the description. The instru-
ment must recognize the long command to comply with the SCPI standard. Some com-
mands are considerably shortened by these optional mnemonics.

Example: 
Definition: HCOPy[:IMMediate]
Command: HCOP:IMM is equivalent to HCOP

Optional mnemonics with numeric suffixes
Do not omit an optional mnemonic if it includes a numeric suffix that is relevant for the
effect of the command.
Example:
Definition:DISPlay[:WINDow<1...4>]:MAXimize <Boolean>
Command: DISP:MAX ON refers to window 1.

In order to refer to a window other than 1, you must include the optional WINDow param-
eter with the suffix for the required window.
DISP:WIND2:MAX ON refers to window 2.

SCPI Command Structure
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Parameters

Parameters must be separated from the header by a "white space". If several parameters
are specified in a command, they are separated by a comma (,). For a description of the
parameter types, refer to ​chapter A.3.3, "SCPI Parameters", on page 153.

Example: 
Definition:HCOPy:DEVice:CMAP:COLor:RGB <red>,<green>,<blue>
Command:HCOP:DEV:CMAP:COL:RGB 3,32,44

Special characters

| Parameters

A vertical stroke in parameter definitions indicates alternative possibilities in the sense of "or". The effect
of the command differs, depending on which parameter is used.

Example:

Definition:HCOPy:PAGE:ORIentation LANDscape | PORTrait
Command HCOP:PAGE:ORI LAND specifies landscape orientation

Command HCOP:PAGE:ORI PORT specifies portrait orientation

Mnemonics

A selection of mnemonics with an identical effect exists for several commands. These mnemonics are
indicated in the same line; they are separated by a vertical stroke. Only one of these mnemonics needs
to be included in the header of the command. The effect of the command is independent of which of the
mnemonics is used.

Example:

DefinitionSENSE:BANDwidth|BWIDth[:RESolution] <numeric_value>
The two following commands with identical meaning can be created:

SENS:BAND:RES 1
SENS:BWID:RES 1

[ ] Mnemonics in square brackets are optional and may be inserted into the header or omitted.

Example: HCOPy[:IMMediate]
HCOP:IMM is equivalent to HCOP

{ } Parameters in curly brackets are optional and can be inserted once or several times, or omitted.

Example: SENSe:LIST:FREQuency <numeric_value>{,<numeric_value>}
The following are valid commands:

SENS:LIST:FREQ 10
SENS:LIST:FREQ 10,20
SENS:LIST:FREQ 10,20,30,40

A.3.3 SCPI Parameters

Many commands are supplemented by a parameter or a list of parameters. The param-
eters must be separated from the header by a "white space" (ASCII code 0 to 9, 11 to 32
decimal, e.g. blank). Allowed parameters are:

● Numeric values
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● Special numeric values
● Boolean parameters
● Text
● Character strings
● Block data

The parameters required for each command and the allowed range of values are speci-
fied in the command description.

Numeric values

Numeric values can be entered in any form, i.e. with sign, decimal point and exponent.
Values exceeding the resolution of the instrument are rounded up or down. The mantissa
may comprise up to 255 characters, the exponent must lie inside the value range -32000
to 32000. The exponent is introduced by an "E" or "e". Entry of the exponent alone is not
allowed. In the case of physical quantities, the unit can be entered. Allowed unit prefixes
are G (giga), MA (mega), MOHM and MHZ are also allowed), K (kilo), M (milli), U (micro)
and N (nano). If the unit is missing, the basic unit is used.

Example: SENS:FREQ:STOP 1.5GHz = SENS:FREQ:STOP 1.5E9

Units

For physical quantities, the unit can be entered. Allowed unit prefixes are:

● G (giga)
● MA (mega), MOHM, MHZ
● K (kilo)
● M (milli)
● U (micro)
● N (nano)

If the unit is missing, the basic unit is used.

Example: 
SENSe:FREQ:STOP 1.5GHz = SENSe:FREQ:STOP 1.5E9

Some settings allow relative values to be stated in percent. According to SCPI, this unit
is represented by the PCT string.

Example: 
HCOP:PAGE:SCAL 90PCT

Special numeric values

The texts listed below are interpreted as special numeric values. In the case of a query,
the numeric value is provided.

● MIN/MAX
MINimum and MAXimum denote the minimum and maximum value.

SCPI Command Structure
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● DEF
DEFault denotes a preset value which has been stored in the EPROM. This value
conforms to the default setting, as it is called by the *RST command.

● UP/DOWN
UP, DOWN increases or reduces the numeric value by one step. The step width can
be specified via an allocated step command for each parameter which can be set via
UP, DOWN.

● INF/NINF
INFinity, Negative INFinity (NINF) represent the numeric values 9.9E37 or -9.9E37,
respectively. INF and NINF are only sent as instrument responses.

● NAN
Not A Number (NAN) represents the value 9.91E37. NAN is only sent as a instrument
response. This value is not defined. Possible causes are the division of zero by zero,
the subtraction of infinite from infinite and the representation of missing values.

Example: 
Setting command: SENSe:LIST:FREQ MAXimum
Query: SENS:LIST:FREQ?, Response: 3.5E9

Queries for special numeric values
The numeric values associated to MAXimum/MINimum/DEFault can be queried by
adding the corresponding mnemonics to the command. They must be entered following
the quotation mark.
Example: SENSe:LIST:FREQ? MAXimum
Returns the maximum numeric value as a result.

Boolean Parameters

Boolean parameters represent two states. The "ON" state (logically true) is represented
by "ON" or a numeric value 1. The "OFF" state (logically untrue) is represented by
"OFF" or the numeric value 0. The numeric values are provided as the response for a
query.

Example: 
Setting command: HCOPy:DEV:COL ON
Query: HCOPy:DEV:COL?
Response: 1

Text parameters

Text parameters observe the syntactic rules for mnemonics, i.e. they can be entered
using a short or long form. Like any parameter, they have to be separated from the header
by a white space. In the case of a query, the short form of the text is provided.

SCPI Command Structure



Remote Control BasicsR&S®SGS100A

156User Manual 1173.9105.02 ─ 05

Example: 
Setting command: HCOPy:PAGE:ORIentation LANDscape
Query: HCOP:PAGE:ORI?
Response: LAND

Character strings

Strings must always be entered in quotation marks (' or ").

Example: 
HCOP:ITEM:LABel "Test1" or HCOP:ITEM:LABel 'Test1'

Block data

Block data is a format which is suitable for the transmission of large amounts of data. A
command using a block data parameter has the following structure:

Example: 
FORMat:READings:DATA  #45168xxxxxxxx
The ASCII character # introduces the data block. The next number indicates how many
of the following digits describe the length of the data block. In the example the 4 following
digits indicate the length to be 5168 bytes. The data bytes follow. During the transmission
of these data bytes all end or other control signs are ignored until all bytes are transmitted.
#0 specifies a data block of indefinite length. The use of the indefinite format requires a
NL^END message to terminate the data block. This format is useful when the length of
the transmission is not known or if speed or other considerations prevent segmentation
of the data into blocks of definite length.

A.3.4 Overview of Syntax Elements

The following table provides an overview of the syntax elements:

: The colon separates the mnemonics of a command. In a command line the separating semicolon
marks the uppermost command level.

; The semicolon separates two commands of a command line. It does not alter the path.

, The comma separates several parameters of a command.

? The question mark forms a query.

* The asterisk marks a common command.

' '

"

Quotation marks introduce a string and terminate it (both single and double quotation marks are
possible).
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# The hash symbol introduces binary, octal, hexadecimal and block data.
● Binary: #B10110
● Octal: #O7612
● Hexa: #HF3A7
● Block: #21312

A "white space" (ASCII-Code 0 to 9, 11 to 32 decimal, e.g. blank) separates the header from the
parameters.

A.3.5 Structure of a command line

A command line may consist of one or several commands. It is terminated by one of the
following:

● a <New Line>
● a <New Line> with EOI
● an EOI together with the last data byte

Several commands in a command line must be separated by a semicolon ";". If the next
command belongs to a different command system, the semicolon is followed by a colon.

Example: 
MMEM:COPY "Test1","MeasurementXY";:HCOP:ITEM ALL
This command line contains two commands. The first command belongs to the MMEM
system, the second command belongs to the HCOP system.

If the successive commands belong to the same system, having one or several levels in
common, the command line can be abbreviated. To this end, the second command after
the semicolon starts with the level that lies below the common levels. The colon following
the semicolon must be omitted in this case.

Example: 
HCOP:ITEM ALL;:HCOP:IMM
This command line contains two commands. Both commands are part of the HCOP com-
mand system, i.e. they have one level in common.
When abbreviating the command line, the second command begins with the level below
HCOP. The colon after the semicolon is omitted. The abbreviated form of the command
line reads as follows:
HCOP:ITEM ALL;IMM

A new command line always begins with the complete path.

Example: 
HCOP:ITEM ALL
HCOP:IMM
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A.3.6 Responses to Queries

A query is defined for each setting command unless explicitly specified otherwise. It is
formed by adding a question mark to the associated setting command. According to
SCPI, the responses to queries are partly subject to stricter rules than in standard IEEE
488.2.

● The requested parameter is transmitted without a header.
Example: HCOP:PAGE:ORI?, Response: LAND

● Maximum values, minimum values and all other quantities that are requested via a
special text parameter are returned as numeric values.
Example: SENSe:FREQuency:STOP? MAX, Response: 3.5E9

● Numeric values are output without a unit. Physical quantities are referred to the basic
units or to the units set using the Unit command. The response 3.5E9 in the pre-
vious example stands for 3.5 GHz.

● Truth values (Boolean values) are returned as 0 (for OFF) and 1 (for ON).
Example:
Setting command: HCOPy:DEV:COL ON
Query: HCOPy:DEV:COL?
Response: 1

● Text (character data) is returned in a short form.
Example:
Setting command: HCOPy:PAGE:ORIentation LANDscape
Query: HCOP:PAGE:ORI?
Response: LAND

A.4 Command Sequence and Synchronization

IEEE 488.2 defines a distinction between overlapped and sequential commands:

● A sequential command is one which finishes executing before the next command
starts executing. Commands that are processed quickly are usually implemented as
sequential commands. Sequential commands are not implemented in the instrument,
however the execution time of most commands is so short that they act as sequential
commands when sent in different command lines.

● An overlapping command is one which does not automatically finish executing before
the next command starts executing. Usually, overlapping commands take longer to
process and allow the program to do other tasks while being executed. If overlapping
commands do have to be executed in a defined order, e.g. in order to avoid wrong
measurement results, they must be serviced sequentially. This is called synchroni-
zation between the controller and the instrument.

Setting commands within one command line, even though they may be implemented as
sequential commands, are not necessarily serviced in the order in which they have been
received. In order to make sure that commands are actually carried out in a certain order,
each command must be sent in a separate command line.
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As a general rule, send commands and queries in different program messages.

A.4.1 Preventing Overlapping Execution

To prevent an overlapping execution of commands, one of the commands *OPC, *OPC?
or *WAI can be used. All three commands cause a certain action only to be carried out
after the hardware has been set. By suitable programming, the controller can be forced
to wait for the corresponding action to occur.

Table 1-1: Synchronization using *OPC, *OPC? and *WAI

Com-
mand

Action Programming the controller

*OPC Sets the Operation Complete bit in the ESR
after all previous commands have been execu-
ted.

● Setting bit 0 in the ESE
● Setting bit 5 in the SRE
● Waiting for service request (SRQ)

*OPC? Stops command processing until 1 is returned.
This is only the case after the Operation Com-
plete bit has been set in the ESR. This bit indi-
cates that the previous setting has been com-
pleted.

Sending *OPC? directly after the command
whose processing should be terminated before
other commands can be executed.

*WAI Stops further command processing until all
commands sent before *WAI have been exe-
cuted.

Sending *WAI directly after the command
whose processing should be terminated before
other commands are executed.

Command synchronization using *WAI or *OPC? appended to an overlapped command
is a good choice if the overlapped command takes only little time to process. The two
synchronization techniques simply block overlapped execution of the command.

For time consuming overlapped commands it is usually desirable to allow the controller
or the instrument to do other useful work while waiting for command execution. Use one
of the following methods:

*OPC with a service request

1. Set the OPC mask bit (bit no. 0) in the ESE: *ESE 1

2. Set bit no. 5 in the SRE: *SRE 32 to enable ESB service request.

3. Send the overlapped command with *OPC

4. Wait for a service request

The service request indicates that the overlapped command has finished.

*OPC? with a service request

1. Set bit no. 4 in the SRE: *SRE 16 to enable MAV service request.

2. Send the overlapped command with *OPC?
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3. Wait for a service request

The service request indicates that the overlapped command has finished.

Event Status Register (ESE)

1. Set the OPC mask bit (bit no. 0) in the ESE: *ESE 1

2. Send the overlapped command without *OPC, *OPC? or *WAI

3. Poll the operation complete state periodically (by means of a timer) using the
sequence: *OPC; *ESR?

A return value (LSB) of 1 indicates that the overlapped command has finished.

*OPC? with short timeout

1. Send the overlapped command without *OPC, *OPC? or *WAI

2. Poll the operation complete state periodically (by means of a timer) using the
sequence: <short timeout>; *OPC?

3. A return value (LSB) of 1 indicates that the overlapped command has finished. In
case of a timeout, the operation is ongoing.

4. Reset timeout to former value

5. Clear the error queue with SYStem:ERRor? to remove the "-410, Query interrupted"
entries.

Using several threads in the controller application

As an alternative, provided the programming environment of the controller application
supports threads, separate threads can be used for the application GUI and for controlling
the instrument(s) via SCPI.

A thread waiting for a *OPC? thus will not block the GUI or the communication with other
instruments.

A.5 Status Reporting System

The status reporting system stores all information on the current operating state of the
instrument, and on errors which have occurred. This information is stored in the status
registers and in the error queue. Both can be queried with the commands STATus....

A.5.1 Hierarchy of status registers

As shown in the following figure, the status information is of hierarchical structure.
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Fig. 1-1: Graphical overview of the status registers hierarchy

● STB, SRE
The STatus Byte (STB) register and its associated mask register Service Request
Enable (SRE) form the highest level of the status reporting system. The STB provides
a rough overview of the instrument status, collecting the information of the lower-level
registers.

● ESR, SCPI registers
The STB receives its information from the following registers:
– The Event Status Register (ESR) with the associated mask register standard

Event Status Enable (ESE).

– The STATus:OPERation and STATus:QUEStionable registers which are
defined by SCPI and contain detailed information on the instrument.

● IST, PPE
The IST flag ("Individual STatus"), like the SRQ, combines the entire instrument status
in a single bit. The PPE fulfills the same function for the IST flag as the SRE for the
service request.

● Output buffer
The output buffer contains the messages the instrument returns to the controller. It
is not part of the status reporting system but determines the value of the MAV bit in
the STB and thus is represented in the overview.

Status Reporting System
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All status registers have the same internal structure.

SRE, ESE
The service request enable register SRE can be used as ENABle part of the STB if the
STB is structured according to SCPI. By analogy, the ESE can be used as the ENABle
part of the ESR.

A.5.2 Structure of a SCPI Status Register

Each standard SCPI register consists of 5 parts. Each part has a width of 16 bits and has
different functions. The individual bits are independent of each other, i.e. each hardware
status is assigned a bit number which is valid for all five parts. Bit 15 (the most significant
bit) is set to zero for all parts. Thus the contents of the register parts can be processed
by the controller as positive integers.

Fig. 1-2: The status-register model

Description of the five status register parts

The five parts of a SCPI register have different properties and functions:

● CONDition
The CONDition part is written into directly by the hardware or the sum bit of the next
lower register. Its contents reflect the current instrument status. This register part can
only be read, but not written into or cleared. Its contents are not affected by reading.

● PTRansition
The two transition register parts define which state transition of the CONDition part
(none, 0 to 1, 1 to 0 or both) is stored in the EVENt part.
The Positive-TRansition part acts as a transition filter. When a bit of the
CONDition part is changed from 0 to 1, the associated PTR bit decides whether the
EVENt bit is set to 1.
– PTR bit =1: the EVENt bit is set.

– PTR bit =0: the EVENt bit is not set.
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This part can be written into and read as required. Its contents are not affected by
reading.

● NTRansition
The Negative-TRansition part also acts as a transition filter. When a bit of the
CONDition part is changed from 1 to 0, the associated NTR bit decides whether the
EVENt bit is set to 1.
– NTR bit =1: the EVENt bit is set.

– NTR bit =0: the EVENt bit is not set.

This part can be written into and read as required. Its contents are not affected by
reading.

● EVENt
The EVENt part indicates whether an event has occurred since the last reading, it is
the "memory" of the condition part. It only indicates events passed on by the transition
filters. It is permanently updated by the instrument. This part can only be read by the
user. Reading the register clears it. This part is often equated with the entire register.

● ENABle
The ENABle part determines whether the associated EVENt bit contributes to the
sum bit (see below). Each bit of the EVENt part is "ANDed" with the associated
ENABle bit (symbol '&'). The results of all logical operations of this part are passed
on to the sum bit via an "OR" function (symbol '+').
ENABle bit = 0: the associated EVENt bit does not contribute to the sum bit
ENABle bit = 1: if the associated EVENt bit is "1", the sum bit is set to "1" as well.
This part can be written into and read by the user as required. Its contents are not
affected by reading.

Sum bit

The sum bit is obtained from the EVENt and ENABle part for each register. The result is
then entered into a bit of the CONDition part of the higher-order register.

The instrument automatically generates the sum bit for each register. Thus an event can
lead to a service request throughout all levels of the hierarchy.

A.5.3 Contents of the Status Registers

In the following sections, the contents of the status registers are described in more detail.

A.5.3.1 Status Byte (STB) and Service Request Enable Register (SRE)

The STatus Byte (STB) is already defined in IEEE 488.2. It provides a rough overview
of the instrument status by collecting the pieces of information of the lower registers. A
special feature is that bit 6 acts as the sum bit of the remaining bits of the status byte.

The STB is read using the command ​*STB ​ or a serial poll.

The STatus Byte (STB) is linked to the Service Request Enable (SRE) register.
Each bit of the STB is assigned a bit in the SRE. Bit 6 of the SRE is ignored. If a bit is set
in the SRE and the associated bit in the STB changes from 0 to 1, a service request
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(SRQ) is generated. The SRE can be set using the command ​*SRE ​ and read using the
command *SRE?.

Table 1-2: Meaning of the bits used in the status byte

Bit No. Meaning

0...1 Not used

2 Error Queue not empty

The bit is set when an entry is made in the error queue. If this bit is enabled by the SRE, each
entry of the error queue generates a service request. Thus an error can be recognized and speci-
fied in greater detail by polling the error queue. The poll provides an informative error message.
This procedure is to be recommended since it considerably reduces the problems involved with
remote control.

3 Not used.

4 MAV bit (message available)

The bit is set if a message is available in the output buffer which can be read. This bit can be used
to enable data to be automatically read from the instrument to the controller.

5 ESB bit

Sum bit of the event status register. It is set if one of the bits in the event status register is set and
enabled in the event status enable register. Setting of this bit indicates a serious error which can
be specified in greater detail by polling the event status register.

6 MSS bit (master status summary bit)

The bit is set if the instrument triggers a service request. This is the case if one of the other bits of
this registers is set together with its mask bit in the service request enable register SRE.

7 Not used.

A.5.3.2 IST Flag and Parallel Poll Enable Register (PPE)

As with the SRQ, the IST flag combines the entire status information in a single bit. It can
be read by means of a parallel poll (see ​chapter A.5.5.3, "Parallel Poll", on page 166) or
using the command ​*IST ​.

The parallel poll enable register (PPE) determines which bits of the STB contribute to the
IST flag. The bits of the STB are "ANDed" with the corresponding bits of the PPE, with
bit 6 being used as well in contrast to the SRE. The IST flag results from the "ORing" of
all results. The PPE can be set using commands ​*PRE ​ and read using command *PRE?.

A.5.4 Event Status Register (ESR) and Event Status Enable Register (ESE)

The ESR is defined in IEEE 488.2. The event status register can be read out using com-
mand ​*ESR ​ on page 96. The ESE is the associated enable part. It can be set using the
command ​*ESE ​ on page 96 and read using the command *ESE?.
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Table 1-3: Meaning of the bits used in the event status register

Bit No. Meaning

0 Operation Complete

This bit is set on receipt of the command *OPC exactly when all previous commands have been
executed.

1 not used

2 Query Error

This bit is set if either the controller wants to read data from the instrument without having sent a
query, or if it does not fetch requested data and sends new instructions to the instrument instead.
The cause is often a query which is faulty and hence cannot be executed.

3 Device-dependent Error

This bit is set if a device dependent error occurs. An error message with a number between 300
and 399 or a positive error number, which denotes the error in greater detail, is entered into the
error queue.

4 Execution Error

This bit is set if a received command is syntactically correct but cannot be performed for other
reasons. An error message with a number between 200 and 300, which denotes the error in greater
detail, is entered into the error queue.

5 Command Error

This bit is set if a command which is undefined or syntactically incorrect is received. An error
message with a number between 100 and 200, which denotes the error in greater detail, is entered
into the error queue.

6 User Request

This bit is set on pressing the LOCAL key, i.e. when the instrument is switched over to manual
operation.

7 Power On (supply voltage on)

This bit is set on switching on the instrument.

A.5.5 Application of the Status Reporting System

The purpose of the status reporting system is to monitor the status of one or several
devices in a measuring system. To do this and react appropriately, the controller must
receive and evaluate the information of all devices. The following standard methods are
used:

● Service request (SRQ) initiated by the instrument
● Serial poll of all devices in the bus system, initiated by the controller in order to find

out who sent a SRQ and why
● Parallel poll of all devices
● Query of a specific instrument status by means of commands
● Query of the error queue
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A.5.5.1 Service Request

Under certain circumstances, the instrument can send a service request (SRQ) to the
controller. Usually this service request initiates an interrupt at the controller, to which the
control program can react appropriately. An SRQ is always initiated if one or several of
bits 2, 4 or 5 of the status byte are set and enabled in the SRE. Each of these bits com-
bines the information of the error queue or the output buffer. In order to use the possi-
bilities of the service request effectively, all bits should be set to "1" in the enable registers
SRE and ESE.

Example: 
Use command *OPC to generate an SRQ .

*ESE 1 - set bit 0 of ESE (Operation Complete)

*SRE 32 - set bit 5 of SRE (ESB).

After its settings have been completed, the instrument generates an SRQ.

The SRQ is the only possibility for the instrument to become active on its own. Each
controller program should set the instrument such that a service request is initiated in the
case of malfunction. The program should react appropriately to the service request.

A.5.5.2 Serial Poll

In a serial poll, just as with command *STB, the status byte of an instrument is queried.
However, the query is realized via interface messages and is thus clearly faster.

The serial poll method is defined in IEEE 488.1 and used to be the only standard possi-
bility for different instruments to poll the status byte. The method also works for instru-
ments which do not adhere to SCPI or IEEE 488.2.

The serial poll is mainly used to obtain a fast overview of the state of several instruments
connected to the controller.

A.5.5.3 Parallel Poll

In a parallel poll, up to eight instruments are simultaneously requested by the controller
using a single command to transmit 1 bit of information each on the data lines, i.e., to set
the data line allocated to each instrument to a logical "0" or "1".

In addition to the SRE register, which determines the conditions under which an SRQ is
generated, there is a Parallel Poll Enable register (PPE) which is ANDed with the STB
bit by bit, considering bit 6 as well. This register is ANDed with the STB bit by bit, con-
sidering bit 6 as well. The results are ORed, the result is possibly inverted and then sent
as a response to the parallel poll of the controller. The result can also be queried without
parallel poll using the command ​*IST ​.

The instrument first has to be set for the parallel poll using the command PPC. This com-
mand allocates a data line to the instrument and determines whether the response is to
be inverted. The parallel poll itself is executed using PPE.
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The parallel poll method is mainly used to find out quickly which one of the instruments
connected to the controller has sent a service request. To this effect, SRE and PPE must
be set to the same value.

A.5.5.4 Query of an instrument status

Each part of any status register can be read using queries. There are two types of com-
mands:

● The common commands *ESR?, *IDN?, *IST?, *STB? query the higher-level reg-
isters.

● The commands of the STATus system query the SCPI registers
(STATus:QUEStionable...)

The returned value is always a decimal number that represents the bit pattern of the
queried register. This number is evaluated by the controller program.

Queries are usually used after an SRQ in order to obtain more detailed information on
the cause of the SRQ.

A.5.5.5 Error Queue

Each error state in the instrument leads to an entry in the error queue. The entries of the
error queue are detailed plain text error messages that can be looked up in the Error Log
or queried via remote control using SYSTem:ERRor[:NEXT]? or
SYSTem:ERRor:ALL?. Each call of SYSTem:ERRor[:NEXT]? provides one entry from
the error queue. If no error messages are stored there any more, the instrument responds
with 0, "No error".

The error queue should be queried after every SRQ in the controller program as the
entries describe the cause of an error more precisely than the status registers. Especially
in the test phase of a controller program the error queue should be queried regularly since
faulty commands from the controller to the instrument are recorded there as well.

A.5.6 Reset Values of the Status Reporting System

The following table contains the different commands and events causing the status
reporting system to be reset. None of the commands, except *RST and
SYSTem:PRESet, influence the functional instrument settings. In particular, DCL does
not change the instrument settings.
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Table 1-4: Resetting the status reporting system

Event Switching on supply
voltage

Power-On-Status-
Clear

DCL, SDC

(Device
Clear,
Selected
Device
Clear)

*RST or
SYS-
Tem:PRE-
Set

STA-
Tus:PRE-
Set

*CLS

Effect 0 1

Clear STB, ESR - yes - - - yes

Clear SRE, ESE - yes - - - -

Clear PPE - yes - - - -

Clear error queue yes yes - - - yes

Clear output buffer yes yes yes 1) 1) 1)

Clear command processing and
input buffer

yes yes yes - - -

1) The first command in a command line that immediately follows a <PROGRAM MESSAGE TERMINATOR>
clears the output buffer.

A.6 General Programming Recommendations

Initial instrument status before changing settings

Manual operation is designed for maximum possible operating convenience. In contrast,
the priority of remote control is the "predictability" of the instrument status. Thus, when a
command attempts to define incompatible settings, the command is ignored and the
instrument status remains unchanged, i.e. other settings are not automatically adapted.
Therefore, control programs should always define an initial instrument status (e.g. using
the *RST command) and then implement the required settings.

Command sequence

As a general rule, send commands and queries in different program messages. Other-
wise, the result of the query may vary depending on which operation is performed first
(see also Preventing Overlapping Execution).

Reacting to malfunctions

The service request is the only possibility for the instrument to become active on its own.
Each controller program should instruct the instrument to initiate a service request in case
of malfunction. The program should react appropriately to the service request.

Error queues

The error queue should be queried after every service request in the controller program
as the entries describe the cause of an error more precisely than the status registers.
Especially in the test phase of a controller program the error queue should be queried
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regularly since faulty commands from the controller to the instrument are recorded there
as well.

General Programming Recommendations
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B Telnet program examples
The following program example shows a simple TcpClient class that is intended to
explain on how to get started with programming of sockets.

The example sets up a socket communication to R&S SGS and opens a simple user
interface, very similar to the telnet, which allows input of commands. To enable real
automation, further development of the program is required.

TcpClient.h

#include <string>
//defines structs for socket handling
#include <netinet/in.h>
using namespace std;
typedef struct sockaddr_in SockAddrStruct;
typedef struct hostent     HostInfoStruct;
class TcpClient
{
  public:
    TcpClient();
    ~TcpClient();
    void connectToServer( string &hostname, int port );
    void disconnect( );
    void transmit( string &txString );
    void receive( string &rxString );
    string getCurrentHostName( ) const;
    int    getCurrentPort( ) const;
  private:
    string           currentHostName;
    int              currentPort;
    int              currentSocketDescr;
    SockAddrStruct   serverAddress;
    HostInfoStruct * currentHostInfo;
    bool             clientIsConnected;
    int              receiveBufferSize;
};

TcpClient.cpp

#include <string>
//defines structs for socket handling
#include <netinet/in.h>
using namespace std;
typedef struct sockaddr_in SockAddrStruct;
typedef struct hostent     HostInfoStruct;
class TcpClient
{
  public:
    TcpClient();
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    ~TcpClient();
    void connectToServer( string &hostname, int port );
    void disconnect( );
    void transmit( string &txString );
    void receive( string &rxString );
    string getCurrentHostName( ) const;
    int    getCurrentPort( ) const;
  private:
    string           currentHostName;
    int              currentPort;
    int              currentSocketDescr;
    SockAddrStruct   serverAddress;
    HostInfoStruct * currentHostInfo;
    bool             clientIsConnected;
    int              receiveBufferSize;
};

#include <netdb.h>
#include <netinet/in.h>
#include <unistd.h>
#include "TcpClient.h"
TcpClient::TcpClient()
: currentHostName( "" )
, currentPort( 0 )
, currentSocketDescr( 0 )
, serverAddress ( )
, currentHostInfo( NULL )
, clientIsConnected( false )
, receiveBufferSize( 1024 )
{
}
TcpClient::~TcpClient()
{
  currentHostInfo = NULL;
}

void TcpClient::connectToServer( string &hostname, int port )
{
  currentHostInfo = gethostbyname( hostname.c_str( ) );
  if( currentHostInfo == NULL )
  {
    currentHostName   = "";
    currentPort       = 0;
    currentHostInfo   = NULL;
    clientIsConnected = false;
    printf("error connecting host\n" );
  }
  currentHostName = hostname;
  currentPort     = port;
  currentSocketDescr = socket(AF_INET, SOCK_STREAM, 0);
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  if( currentSocketDescr == 0 )
  {
    currentHostName   = "";
    currentPort       = 0;
    currentHostInfo   = NULL;
    clientIsConnected = false;
    printf("can't create socket\n" );
  }
  serverAddress.sin_family = currentHostInfo->h_addrtype;
  serverAddress.sin_port   = htons( currentPort );
  memcpy( (char *) &serverAddress.sin_addr.s_addr, 
  currentHostInfo->h_addr_list[0], currentHostInfo->h_length );
  if( connect( currentSocketDescr, ( struct sockaddr *) &serverAddress, 
  sizeof( serverAddress ) ) < 0 )
  {
   throw string("can't connect server\n" );
  }
  clientIsConnected = true;
}
void TcpClient::disconnect( )
{
  if( clientIsConnected )
  {
    close( currentSocketDescr );
  }
  currentSocketDescr = 0;
  currentHostName    = "";
  currentPort        = 0;
  currentHostInfo    = NULL;
  clientIsConnected  = false;
}
void TcpClient::transmit( string &txString )
{
  if( !clientIsConnected )
  {
  throw string("connection must be established before any data can be sent\n");
  }
  char * transmitBuffer = new char[txString.length() +1];
  memcpy( transmitBuffer, txString.c_str(), txString.length() );
  transmitBuffer[txString.length()] = '\n'; //newline is needed!
  if( send( currentSocketDescr, transmitBuffer, txString.length() + 1, 0 ) < 0 )
  {
    throw string("can't transmit data\n");
  }
  delete [] transmitBuffer;
}
void TcpClient::receive( string &rxString )
{
  if( !clientIsConnected )
  {
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  throw string("connection must be established before any data can be received\n");
  }
  char * receiveBuffer = new char[receiveBufferSize];
  memset( receiveBuffer, 0, receiveBufferSize );
  bool receiving = true;
  while( receiving )
  {
    int receivedByteCount = recv( currentSocketDescr, 
    receiveBuffer, receiveBufferSize, 0 );
    if( receivedByteCount < 0 )
    {
      throw string("error while receiving data\n");
    }
    rxString += string( receiveBuffer );
    receiving = ( receivedByteCount == receiveBufferSize );
  }
  delete [] receiveBuffer;
}
string TcpClient::getCurrentHostName( ) const
{
  return currentHostName;
}
int TcpClient::getCurrentPort( ) const
{
  return currentPort;
}

TelnetClient.cpp

#include <iostream>
#include "TcpClient.h"
void printUsage()
{
  cout<<"usage: EthernetRawCommand <server-ip> [scpi-command]"<<endl;
}
int main( int argc, char *argv[] )
{
  int errorCode         = 0; //no error
  bool useSingleCommand = false;
  string singleCommand  = "";
  string hostname       = "";
  int    port           = 5025;
  string input          = "";
  TcpClient client;
  switch( argc )
  {
    case 3:
      useSingleCommand = true;
      singleCommand    = argv[2];
    case 2:
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      hostname         = argv[1];
      break;
    default:
        printUsage();
        return(-1);
  }
  try
  {
    client.connectToServer( hostname, port );
    bool terminate = false;
    while( !terminate )
    {
      char buffer[1024];
      if( useSingleCommand )
      {
        input =  singleCommand; //send string
      }
      else
      {
        cin.getline( buffer, 1024 );
        input = buffer;
        if( input == "end" )
        {
          terminate = true;
        }
      }
      if( !terminate)
      {
        client.transmit( input ); //send string
        int qPos = input.find( "?", 0 );
        //receive string only when needed
        if( qPos > 0 )
        {
          string rcStr = "";
          client.receive( rcStr );
          cout << rcStr << endl;
        }
      }
      if( useSingleCommand )
      {
        terminate = true;
      }
    }
  }catch( const string errorString )
  {
    cout<<errorString<<endl;
  }
  client.disconnect( );
  return errorCode;
}
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